## Appendix 4 • Data Mart Table Reference

About SAS Environment Manager Data Mart Tables ........................................... 148
ACM Tables ........................................................................................................... 148
APM Tables ........................................................................................................... 153
Solution Kits Table ............................................................................................... 158

## Appendix 5 • Service Architecture Alerts .............................................................. 161

## Appendix 6 • Disabling the ACM and APM ETL Processes ................................. 173
Disabling the ACM ETL Process ........................................................................... 173
Disabling the APM ETL Process ........................................................................... 174
Disabling Both the ACM and APM ETL Processes .............................................. 176

**Recommended Reading** .................................................................................... 179

**Index** .................................................................................................................. 181
Contents
What’s New in SAS Environment Manager 2.5

Overview

SAS Environment Manager has the following new features and enhancements:

- Log collection and discovery has been improved.
- Support has been added for collecting metric data from a SAS grid.
- Support has been added in SAS Environment Manager Administration for management of SAS users, servers, and libraries.
- The SAS Environment Management Data Mart now supports a federated data mart.
- Changes in tables in SAS Environment Manager Data Mart: ACM.IOMSERVERS table has been replaced by ACM.SASAPPSERVERS and ACM.SASLOGICALSERVERS tables.
- The stored process reports in the Report Center have been changed from stored process report objects to stored process objects.

Log Collection and Discovery

The method of discovering and collecting data from SAS logs has been improved. Rather than relying on log locations that are stored in metadata, the ETL processes look through the directory structure of a SAS deployment to find log files. Logs are gathered locally on each machine, and then centralized nightly for processing.

SAS Grid Support

Support has been added for collecting metric data from a SAS grid and from the servers that make up the grid. Grid resources are discovered automatically.
SAS Management Console Administration
Functions

Functions have been added to the Administration section of SAS Environment Manager to enable you to manage metadata definitions for SAS servers, libraries, and users. Information about using the Administration functions has been moved to SAS Environment Manager Administration: User’s Guide.

Federated Data Mart

Support for a federated data mart has been added. A federated data mart is separate from the SAS Environment Manager data mart, and enables you to collect metric data in data marts for several SAS deployments, copy that data to a single collector deployment, and view the collected metric data in one place.

Report Center

The reports in the Report Center (part of the service architecture) have been changed from stored process report objects to stored process objects, which makes the reports more dynamic. The reports are now re-generated at every request, rather than being cached after the first time they are generated. Each stored process is generated using prompts that enable you to alter the contents and appearance of the report.
Part 1

Understanding SAS Environment Manager

Chapter 1
Introduction to SAS Environment Manager ........................................ 3

Chapter 2
Finding Your Way Around ................................................................. 11

Chapter 3
Viewing Information at a Glance: Using the Dashboard ..................... 21

Chapter 4
Finding Resources in Your System ..................................................... 37

Chapter 5
Monitoring and Controlling Resources ............................................. 41

Chapter 6
Working with Events and Alerts ....................................................... 49

Chapter 7
Controlling Access to SAS Environment Manager .............................. 61
Chapter 1
Introduction to SAS Environment Manager

Starting SAS Environment Manager

To access SAS Environment Manager, use your web browser to go to http://<hostname>:7080, where localhost is the machine on which the SAS Environment Manager server is installed. The SAS Login Manager prompts you for your credentials and the application starts. After you specify your credentials in the SAS Login Manager, the main SAS Environment Manager application appears.

What is SAS Environment Manager?

SAS Environment Manager is a web-based administration solution for a SAS environment. The application enables you to perform these tasks:

- administer, monitor, and manage SAS resources, including administering the SAS Web Application Server and monitoring SAS foundation servers
- collect and chart data on metrics for monitored SAS resources, which creates a comprehensive view of resource health and operation
- monitor log events and reporting alerts
- incorporate the monitoring and managing of IT and SAS resources into a service management strategy by using the detailed metric information stored in the SAS Environment Manager Data Mart and the reports provided in the Report Center

SAS Environment Manager agents run on all SAS platforms except for z/OS.
Note: Using SAS Environment Manager to monitor Hadoop nodes is not recommended.
In order to monitor Hadoop nodes, the SAS Environment Manager agent must run
with root access, which introduces security risks.

Running SAS Environment Manager behind the SAS Web Server or any other reverse
proxy server is not supported.

The basic architecture of SAS Environment Manager consists of an agent process
running on each platform in a SAS deployment that communicates to a central
management server. Agents monitor detected resources and periodically report resource
metrics back to the server. The server provides an interface for interacting with those
agents, managing the data collected by the agents, distributing plugins, creating alerts
and escalation procedures based on collected metrics, and graphing the metrics provided
through the installed plugins.

There are five main components to SAS Environment Manager:

agent
An agent is a software process that runs on each platform (middle-tier and server-tier
machine) in a SAS deployment. The agent is responsible for tasks such as
discovering software components on its platform, gathering metric and availability
data for the platform and components, and performing resource control actions. The
agents communicate with the management server. Plugins are used to provide the
agents with the information needed to discover SAS resources installed on a
platform.

management server
The management server is responsible for communicating with the agents. It collects
information about items such as discovered resources, metrics, and availability, and
issues control actions received from the SAS Environment Manager application.
Collected data is stored in the SAS Environment Manager database.

SAS Environment Manager database
The database is a repository for all of the information that is known about all of the
resources known to SAS Environment Manager. It uses PostgreSQL, and uses the
SAS Web Infrastructure Platform Data Server when that server is configured to use PostgreSQL. After resources are discovered and added to your inventory, the database stores data collected from the agents about the resources.

SAS Environment Manager application

The application is the web-based interface to the SAS Environment Manager system. Resources discovered by the agents and added to the inventory are displayed and monitored. Metric and availability data collected by the agents and stored in the database is displayed and charted. Events and metric data are used to generate alerts. Control actions are sent back through the management server to the agents to control resources on the platforms. The application also includes a framework to add functions specific to SAS, such as server, library, and user administration.

plugins

Plugins enable agents to discover and monitor resources in a SAS environment. Each plugin is associated with a specific resource, and provides the agents with the instructions needed to recognize the resource during auto-discovery and to monitor and collect metrics for the resource.

Although open-source plugins are available for VMware Hyperic, these plugins are not supported by SAS Environment Manager. You should use only plugins provided by SAS.

Beginning with SAS Environment Manager 2.4, SAS Environment Manager Service Architecture is also included. Extract, transform, and load (ETL) processes obtain metric information from the SAS Environment Manager agent and from SAS logs, standardize the data, and store the data in the SAS Environment Manager Data Mart. From there, the data is used to produce predefined reports from stored processes in the Report Center.

The basic framework for SAS Environment Manager Service Architecture is provided by SAS Environment Manager Extended Monitoring. In addition to providing the infrastructure for the data mart and the Report Center, the extended monitoring package includes predefined alerts, groups, and logging configurations. Initializing extended monitoring automates the task of setting up SAS Environment Manager, and enables you to start using the application right away.

SAS Environment Manager is based on VMware’s Hyperic product, with customizations and plugins to optimize the product specifically for a SAS environment. Some terms and concepts used in SAS Environment Manager are different than in other parts of SAS, but these are noted in this document.

SAS Environment Manager is licensed for and restricted to the monitoring and management of SAS Technologies, solutions, and the necessary associated supporting infrastructures. SAS Environment Manager agents can be installed on any machines that host software or data on which your SAS environment depends. However, agents installed on machines that do not host SAS software are restricted to monitoring basic hardware and operating system resource metrics. Although SAS Environment Manager is based on VMware’s Hyperic product, only plugins and customizations specifically delivered with and deployed by SAS software may be installed in SAS Environment Manager. See the SAS Environment Manager Plugins page on support.sas.com for a complete listing of supported plugins. Other SAS Environment Manager uses are restricted in accordance with your SAS Master License Agreement.

SAS Environment Manager, its reports, and supporting data are provided to assist in the troubleshooting and performance tuning of SAS environments. Although audit, access, and connectivity data and reports are provided, SAS does not provide a guarantee as to their completeness. If you require more extensive and comprehensive audit, access, and connectivity data, please contact SAS Professional Services for assistance.
Note: SAS Environment Manager and the SAS Environment Manager Service Architecture use a collection of data sets to store collected metric data and information that is used to create reports. If you notice that a data set that is associated with SAS Environment Manager is not being updated, this is not necessarily an indication of an error. A data set might not be updated because it is no longer being used, or because the event that it is collecting data for has not occurred.

Resource Inventory Model

Overview

The SAS Environment resource inventory model contains three levels:

platform
A container such as an operating system or a SAS server tier that holds servers and services

server
Software product or process, such as a SAS Metadata Server, that runs on a platform

service
A task-specific software component, such as a SAS logical server, that runs on a server or platform

Platforms

Platforms are the highest level of resource type in SAS Environment Manager. They are containers that host other software and services. There are three major categories of platforms:

• operating system platforms
• SAS Application Server Tier
• virtual and network platforms

An operating system platform consists of a computer (physical or virtual) and the operating system that runs on it. SAS Environment Manager uses the system plugin to teach the agent how to auto-discover the operating system platform. You cannot manually add an operating system platform to inventory. SAS Environment Manager supports most of the operating systems on which SAS is supported.

The SAS Application Server Tier platform is an instantiation of a SAS deployment and a collective store of deployment-wide information such as clustering. Resources in the SAS Application Server Tier platform include SAS Metadata Server and SAS Application Server and their logical servers (such as SAS Workspace Servers, SAS OLAP Servers, and SAS Stored Process Servers). The agent automatically discovers and creates the SAS Application Server through direct communication with the SAS metadata server as a platform resource.

Virtual and network platforms include a variety of platform types that do not map to an individual physical machine running a traditional operating system and are managed by an agent proxy. These include the following:

• resources that an agent monitors remotely over the network, such as network hosts and devices
virtual resources such as VMware vSphere hosts and virtual machines
- distributed sets of resources, such as GemFire Distributed Systems

The agent does not automatically discover platforms other than the host operating system and the SAS Application Server Tier. You must manually create other platforms or supply resource properties data that enable the agent to manage them. Below are the virtual and network platform types that SAS Environment Manager supports:
- Cisco IOS
- GemFire Distributed System
- Network Device
- Network Host
- VMware vSphere Host
- VMware vSphere VM

**Servers**

In SAS Environment Manager, a server is commonly a software product or process that runs on a platform. Servers provide a communication interface and perform specific tasks upon request. The Monitoring Defaults page on the Manage tab lists all of the server types (along with platform and service types) that SAS Environment Manager supports.

Most server types are auto-discovered by a server type-specific SAS Environment Manager plugin. If the plugin that manages a server does not support auto-discovery, or if auto-discovery of a server fails, you might need to manually create a server. See “Manually Adding a Server” on page 39.

Examples of server types include the following:
- SAS Metadata Server
- SAS Object Spawner
- Postgres server
- SAS Home Directory Service

**Services**

In SAS Environment Manager, a service is a software component dedicated to a particular task that runs on a server or platform. A service that runs on a server is a service, and a service that runs on a platform is a platform service.

The resource plugin that discovers a platform or server also discovers key services, such as CPUs, network interfaces, and file systems that are running on the platform.

You can also configure a platform service that serves as a proxy for a resource that the SAS Environment Manager agent can monitor over the network. Examples include
- DNS service
- POP3 service
- Fileserver mount
- Windows service
Deciding Which Components to Initialize

After you have used the SAS Deployment Wizard to install SAS Environment Manager, you must perform additional steps to configure resources (either automatically or manually), create the dashboard, and enable SAS Environment Manager Service Architecture. The following steps outline the process.

1. After the installation process has completed, sign on to SAS Environment Manager. The application autodiscovers the resources in your environment.

2. Decide whether you want to enable SAS Environment Manager Extended Monitoring. If you enable extended monitoring, SAS Environment Manager is automatically set up by using tuned resource configurations, alert definitions, and metrics. The SAS Environment Manager Data Mart infrastructure is also configured, so if you plan to use the data mart, you must enable extended monitoring. If you choose not to enable extended monitoring, you must configure resources and define alerts manually.

3. If you choose to use extended monitoring, run the command to enable extended monitoring. See “Initializing SAS Environment Manager Extended Monitoring” on page 83 for more information.

4. If you choose not to use extended monitoring, you must manually configure the resources in SAS Environment Manager and manually define alerts. See Appendix 3, “Manual Setup Examples,” on page 135 for examples.

5. Set up your dashboard. See “Using the Dashboard” on page 21.

6. If you decided to use SAS Environment Manager Service Architecture, you must decide what type of data you want to populate the data mart with. APM ETL provides forensic data from SAS logs, ACM ETL provides real-time data from the computing resources in your environment, and solution kits ETL provide data specific to individual SAS solutions. If you initialize and enable extended monitoring and all three ETL components, you will obtain the most complete and comprehensive view of your system. However, initializing all of these components does consume more resources and impact performance.

7. If you are populating the data mart with forensic data from SAS logs, initialize and enable APM ETL. See “Enabling and Initializing the APM ETL” on page 84. You can perform this step at any time, not just during the initial setup.
8. If you are populating the data mart with current data from the computing resources in your SAS environment, enable ACM ETL. See “Enabling ACM ETL” on page 88. You can perform this step at any time, not just during the initial setup.
Chapter 2
Finding Your Way Around

The SAS Environment Manager interface is organized around five main areas, as illustrated in this figure:

The following table describes the main functional areas of SAS Environment Manager:

<table>
<thead>
<tr>
<th>Main Page</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>Configurable collections of portlets; this is the initial view when starting SAS Environment Manager.</td>
</tr>
<tr>
<td>Resources</td>
<td>Resource-level monitoring and management.</td>
</tr>
<tr>
<td>Analyze</td>
<td>Deployment-wide views of events and alerts.</td>
</tr>
</tbody>
</table>
Viewing Important Information at a Glance: the Dashboard

The Dashboard is the starting point when you sign in to SAS Environment Manager. The page consists of a collection of views (called portlets) of resources, metrics, and events that are the most important to your environment. The Dashboard is customizable, so you can specify how many portlets are displayed, which metrics and functions they present, and which resources they cover. For example, your Dashboard could contain a portlet to display recently auto-discovered resources, a portlet to display recent alerts, or a portlet to display the availability of a group of selected servers. Selecting an entry (such as a resource or an alert) in a portlet takes you to detailed information about the entry.

Each user can access their own personal Dashboard as well as a Dashboard for each of the native roles of which the user is a member. Each Dashboard can be customized to meet the needs of the user or role. For more information about roles, see “About Native Roles and Users” on page 61.

An example Dashboard page is displayed in this figure.
Monitoring Platforms, Servers, and Services: the Resources Pages

Use the **Resources** pages to monitor, configure, and manage inventory resources. The main Resources page lists the inventory of resources, organized by type:

- Platforms
- Servers
- Services
- Compatible Groups/Clusters
- Mixed Groups
- Applications

Other selections under Resources enable you to view only resources that are currently down or to select from recently viewed resources. This figure shows a server resource list.

**Figure 2.2  Resource List**

The icons on the left of the resource name 🔴عزيComments icon enable you to quickly jump to the Monitor, Inventory, or Alerts page for the resource. Selecting the resource name displays the Monitor page for the resource. A lock icon indicates that, because of your permissions, a particular feature is not available for a particular resource.

Use these strategies to locate resources on the **Resources** page:

- Only one inventory type is displayed at a time. To access resources of a different inventory type, click a link in the table header.
• To further limit the display, you can specify criteria in the Search row and then click (at the end of the Search row). Not all criteria are supported for all inventory types.

• To include only resources that you own, select the Owned by check box.

• There might be multiple pages of resources in the list. Use the controls below the list to navigate.

• You can use Resources ⇒ Recently Viewed ⇒ the page name to quickly return to a page that you recently viewed.

• As an alternative to browsing and filtering on the Resources page, you can use the search field (on the right side of the application banner) to quickly locate a resource by its name.

• To view a list of resources that are not currently available, select Resources ⇒ Currently Down.

• You can initiate resource management tasks from the Resources page.

Note: 64–bit Windows servers are listed on the Resources page as Win32 servers.

---

Monitoring Resources: the Analyze Pages

### Overview

The Analyze pages contain the Alert Center, the Event Center, the Operations Center and the Environment Snapshot. If you have enabled SAS Environment Manager Service Architecture, the Report Center is also included. These pages enable you to quickly view and work with alerts, events, system status, and performance and usage reporting throughout your system.

An event is any sort of activity in a resource that you are monitoring. Alerts are a user-defined type of event that acknowledges a critical condition in a selected resource. You can configure SAS Environment Manager to also log events for log messages and resource configuration changes.

### Alert Center

The Alert Center page provides a deployment-wide view of alerts and alert definitions.

The default view of the Alert Center is the Alerts tab, which displays a table with information about currently active alerts. You can use the filter controls to filter by criteria such as status, type, and priority. Clicking on an entry in the Alert Definition column in the table displays detailed information about the alert.

To access the Alert Center, select Analyze ⇒ Alert Center.
You can select the check box next to an alert and click **Fixed** to identify the problem as having been corrected. A window appears that enables you to enter information about how the alert was resolved.

You can also click an entry in the **Alert Definition** column in the table to display the Detail page for the alert. From the Detail page, you can mark the alert as fixed and specify information about the resolution of the alert.

The **Definition** tab in the Alert Center contains a table listing all of the defined alerts. Clicking on an alert takes you to the definition page for the alert, where you can view more detailed information or edit the alert.
**Event Center**

The Event Center page provides a deployment-wide view of all events that have been logged for resources. Alerts are automatically logged as events. You can configure SAS Environment Manager to also log events for log messages, resource configuration changes, and resource metric triggers.

To access the Event Center, select **Analyze ➔ Event Center**.

**Operations Center**

The Operations Center lists resources that are down or have active alerts. You can use filters to find resources and problem types of interest. This concise view displays the current number of unavailable resources and active alerts, and a one-line problem summary for each resource.

To access the Operations Center, select **Analyze ➔ Operations Center**.
**Environment Snapshot**

Environment Snapshot contains a comprehensive listing of the system information in the SAS Environment Manager database. Although Environment Snapshot was originally designed to provide SAS Technical Support with a method for quickly diagnosing system issues, it also provides you with valuable information about your system. Environment Snapshot collects and displays the most current performance measures and configuration parameters from the SAS Environment Manager database, and also executes and gathers real-time usage information.

In addition, you can take a snapshot of the information, which saves all of the data in a text file. This file is useful when working with SAS Technical Support, because it provides an easy way to communicate the status and configuration of your system.

To access the Environment Snapshot, select **Analyze ➤ Environment Snapshot**.

---

**Report Center**

The Report Center is a collection of SAS Stored Processes that use data in the SAS Environment Manager Data Mart. These reports are created to provide a comprehensive view of the performance and status of your SAS environment and its resources.

The reports in the Report Center are created when you initialize SAS Environment Manager Extended Monitoring. However, the reports operate only on data stored in the data mart by APM or ACM ETL processes. Unless you initialize and enable one of those packages, no reports will be produced. Solution kits, which provide monitoring and reporting for specific applications or SAS solutions, can also add solution-specific reports to the Report Center.

*Note:* The reports in the Report Center are provided as a best efforts resource to assist in the troubleshooting and performance tuning of your SAS deployment. However, many other factors might influence your user experience, some of which are beyond the monitoring capabilities of SAS Environment Manager. For additional assistance in performance tuning and hardware configuration references, please contact the SAS Professional Services Division.
Performing SAS Tasks: the Administration Page

The Administration page enables you to manage resource definitions in SAS metadata. The page contains a set of modules, each of which enable you to manage a type of metadata definition:

- **Folders**: view and update metadata folders and objects
- **Servers**: view definitions for servers in SAS metadata, create and modify definitions for SAS LASR Analytic Servers
- **Libraries**: view definitions for libraries in SAS metadata, create and modify definitions for Base and SAS LASR libraries
- **Users**: View and modify metadata definitions for SAS users, metadata roles, and role capabilities
- **Authorization**: View and modify metadata access controls on metadata object definitions

In addition, other SAS applications can add their own modules (such as SAS Grid Manager) to the Administration page.
Configuring SAS Environment Manager: the Manage Page

Overview

Use the pages under Manage to control how the SAS Environment Manager application operates.

Authentication/Authorization

The Authentication/Authorization area enables you to manage SAS Environment Manager users and user roles. These users and roles are not the same as the users and roles in SAS metadata that control access to SAS metadata objects, although SAS Environment Manager users are synchronized with users that are defined in metadata and added to specific groups.

In order to distinguish between the SAS Environment Manager access features and those in SAS metadata, this document and the SAS Environment Manager online Help refers...
to features internal to SAS Environment Manager as native features (such as native users or native roles). However, the SAS Environment Manager interface does not use the native terminology.

**Server Settings**

The **Server Settings** area enables you to change the settings for the SAS Environment Manager server, the defaults for monitoring, the configuration of escalation schemes, and the SAS Environment Manager plugins.

**Server Settings**

contains settings for the SAS Environment Manager server, including global alert properties, email configuration, and notification properties

**Monitoring Defaults**

contains default monitoring and alerting definitions for all types of platforms, platform services, and servers supported by SAS Environment Manager.

**Escalation Schemes Configuration**

enables you to define notification or logging actions that are taken for alerts.

**Plugin Manager**

lists all currently loaded plugins and enables you to delete and update existing plugins, and load new ones. Deleting or updating a plugin cannot be reversed. Always save a copy before deleting or updating a plugin. You can find additional plugins for SAS Environment Manager at the Enterprise Management Integration area of SAS Customer Support on the web (support.sas.com/rnd/emi).

**Plugins**

The **Plugins** area contains functions that are added to the functionality of SAS Environment Manager to perform a specific action. Plugins include the following:

- Network and Host Dependency Manager
- Groovy Console
- HQ Health
- HQ Web Services API
- tc Server Command-line Interface
Chapter 3

Viewing Information at a Glance: Using the Dashboard

Using the Dashboard .......................................................... 21
Customizing Your Dashboard .............................................. 23
Summary Portlet Examples .................................................. 24
  Adding Summary Portlets .................................................. 24
  Example: Adding a Summary Portlet for SAS Servers That Can Be Spawned ... 25
  Example: Adding a Platform Availability Summary Portlet .................. 27
Metric Viewer Portlet Examples .......................................... 27
  Adding Metric Viewer Portlets ........................................... 27
  Example: Adding a SASWork Disk Space Metric Viewer .................... 29
  Example: Adding a WebApp Login Response Time Metric Viewer .......... 29
  Example: Adding a PostgreSQL Data Volume Metric Viewer ............... 30
  Example: Adding a tc Runtime Manager Active Sessions Metric Viewer .... 31
Metric Chart Examples ....................................................... 32
  Creating a Free Memory Chart ............................................ 32
  Creating a Number of Spawned Servers Chart .......................... 33
  Creating a Metadata Users Chart ........................................ 34
  Adding a Saved Charts Portlet ............................................ 35

Using the Dashboard

The Dashboard is your first view when you start SAS Environment Manager. It is an at-a-glance view of the things that are most important to you when administering your environment, such as favorite resources, recent alerts, and resources that are currently experiencing problems.

The page contains a collection of portlets that provide information at a glance about the SAS environment. You can select which portlets appear on the Dashboard, so the Dashboard shows you the information that you want to see. Selecting an entry in a portlet takes you to more detailed information about the entry. For example, selecting an entry in the Recent Alerts portlet takes you to the Alert Detail page for that alert. The following figure illustrates a sample Dashboard portlet.
The Dashboard is divided into two columns, and the portlets that can appear differ between the left column and the right column. Some portlets can appear only once on a Dashboard, whereas other portlets can appear more than once. The portlets that can appear more than once are ones that display information about a selected group of resources. Each instance of the portlet displays information about different resources. The portlets that can appear only once display information for the entire environment.

This table lists the portlets that you can choose to appear on a Dashboard, as well as where they can appear and how many instances are allowed.

Table 3.1 Portlets

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Location</th>
<th>Instances</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Discovery</td>
<td>Lists new and changed resources and enables you to add them to the inventory. Check this portlet after you install a plug-in to accept the newly discovered resources into the inventory.</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Availability Summary</td>
<td>Indicates the availability of selected resources, grouped by resource type. This portlet refreshes every minute.</td>
<td>Left</td>
<td>Multiple</td>
</tr>
<tr>
<td>Control Actions</td>
<td>Lists recently performed actions on managed resources and upcoming scheduled actions. Also indicates which quick control actions are most frequently performed.</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Favorite Resources</td>
<td>Lists selected resources.</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Saved Charts</td>
<td>Displays selected charts as a slide show.</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td>Recent Alerts</td>
<td>Lists the most recently triggered alerts for selected resources. This portlet refreshes every minute.</td>
<td>Right</td>
<td>Multiple</td>
</tr>
<tr>
<td>Recently Added</td>
<td>Lists platforms that have been recently added to inventory.</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Location</td>
<td>Instances</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>Search Resources</td>
<td>Enables you to search for resources. The search supports case-insensitive,</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td></td>
<td>partial-term queries for a specified inventory type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summary Counts</td>
<td>Displays a count of managed resources by inventory type. Only those</td>
<td>Left</td>
<td>One</td>
</tr>
<tr>
<td></td>
<td>resources that you are allowed to access are displayed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Alerts</td>
<td>Displays traffic light indicators for resource alerts and group alerts for</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td>Summary</td>
<td>selected groups. To view a list of alerts that have fired for a group,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>click that group’s traffic light. To view a group page, click that group’s</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>name.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metric Viewer</td>
<td>Displays selected metrics for selected resources. This portlet refreshes</td>
<td>Right</td>
<td>Multiple</td>
</tr>
<tr>
<td></td>
<td>every minute.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Resources</td>
<td>Lists all resources that have problem metrics and provides details,</td>
<td>Right</td>
<td>One</td>
</tr>
<tr>
<td></td>
<td>including availability status, number of alerts per resource, number of</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>times the metric has been out of bounds, and the most recent time that the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>out-of-bounds metric was collected.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Because the Dashboard page can be customized, each user has access to multiple Dashboards, and each Dashboard can be modified according to different needs. Each user has access to a personal Dashboard, which contains portlets selected by the user. In addition, each user can also access a Dashboard for each of the native roles of which the user is a member. Each of those Dashboards is customized with the portlets that are most useful for that role. To choose a different Dashboard, select the one that you want to use from the Select a Dashboard field.

A new Dashboard type is automatically created whenever you create a new native role. For more information about roles, see “About Native Roles and Users” on page 61.

**Customizing Your Dashboard**

You can customize any Dashboard to which you have access by selecting portlets to appear on your Dashboard and by selecting the information that is displayed in each portlet.

To add a portlet to your Dashboard, use the Add content to this column menu to select from the available portlets and then click the Add icon +, which is beside the field. The portlets displayed in the list depend on whether you are adding a portlet to the right or left column and which portlets have already been added to the Dashboard.
After the portlet is placed on your Dashboard, you can click and drag the portlet header to move it to a different location. However, you cannot move a portlet from one column to another.

To change the information that a portlet displays, click the configuration icon in the portlet’s header. Use the Portlet Configuration page to select options that narrow the focus of the information displayed in the portlet. The options available are unique to each portlet. Examples include the following:

- how many of the most recent control actions are displayed (Control Actions portlet)
- the number and priority of alerts displayed for selected resources (Recent Alerts portlet)
- specified resources (Availability Summary portlet)

You can use groups (compatible groups, mixed groups, and application groups) to make your Dashboard portlets more useful. Groups enable you to organize resources by type or function within your organization. You can then configure portlets to display information about resources in particular groups, so your Dashboard contains information about the resources that are most vital to you.

To remove a portlet from the Dashboard, click on the delete icon for the portlet.

Summary Portlet Examples

Adding Summary Portlets

Here are the basic steps for adding a summary portlet to your Dashboard page.

1. On the left side of the Dashboard page, select Availability Summary in the Add Content to this column field and click the Add icon. A blank Availability Summary portlet is added to your Dashboard.

2. Click the Configuration icon to display the Dashboard Settings page for the portlet.
3. Specify a name for the portlet in the Description field. This name will appear in the header for the portlet, after the portlet type.

4. In the Selected Resources area, click Add to List to display the Add/Remove Resources page.

5. To display the resources that you want to use for the summary, specify values in the View and Filter By Name fields. If you specify a value in the Filter By Name field, click to filter the table contents.

6. In the Resources table, select the check boxes for the resources that you want to use in the summary. Click to move the resources to the Add Resources list.

7. After you select the resources that you want to use in the Add/Remove Resources window, click OK to return to the Availability Summary window. Click OK to create the portlet and add it to your Dashboard page.

**Example: Adding a Summary Portlet for SAS Servers That Can Be Spawned**

This example explains how to add a portlet to your Dashboard page that monitors the availability of SAS Workspace Servers that are running under a SAS Object Spawner.

1. Follow the basic procedure for creating an availability summary portlet in “Adding Summary Portlets” on page 24. Follow the basic procedure for creating an availability
2. On the Add/Remove Resources window, in the View field, select Services. Logical SAS servers are listed as services in SAS Environment Manager.

3. In the Filter By Name field, enter spawner and click [ ]. The Resources list displays the services running under the SAS Object Spawner.

4. Select the resources Workspace Server and Pooled Workspace Server and move them to the Add Resources table.

5. Finish the procedure for creating the portlet. The portlet displays the availability information for the servers that can be spawned.
Example: Adding a Platform Availability Summary Portlet

To add a portlet to monitor the availability of all of the platforms in the environment, follow these steps:

1. Follow the basic procedure for creating an availability summary portlet in “Adding Summary Portlets” on page 24.

2. In the Add/Remove Resources page, select Platforms in the View field and select the check box beside the Name column in the Resources table. This selects all of the listed platforms.

3. Complete portlet creation process to add the portlet to your dashboard.

Metric Viewer Portlet Examples

Adding Metric Viewer Portlets

Here are the basic steps for adding a metric viewer portlet to your Dashboard page.
1. On the right side of the Dashboard page, select **Metric Viewer** in the **Add Content to this column** field and click the Add icon  

A blank **Metric Viewer** portlet is added to your Dashboard.

2. Click the Configuration icon to display the Dashboard Settings page for the portlet.

3. On the Dashboard Settings page, specify a name for the portlet in the **Description** field. Select the type of resource that you want to monitor in the **Resource Type** field and the information that you want to display in the **Metric** field. The values available in the **Metric** field change depending on what you select in the **Resource Type** field.

4. In the **Selected Resources** area, click **Add to List** to display the Add/Remove Resources page.

5. To display the resources that you want to use for the metric, specify values in the **View** and **Filter By Name** fields. If you specify a value in the **Filter By Name** field, click to filter the table contents.
6. In the **Resources** table, select the check boxes for the resources that you want to use in the metric. Click ![Add Resource](image) to move the resources to the **Add Resources** list.

7. After you select the resources that you want to use in the Add/Remove Resources window, click **OK** to return to the Dashboard Settings page. Click **OK** to create the portlet and add it to your Dashboard page.

**Example: Adding a SASWork Disk Space Metric Viewer**

To add a portlet for viewing the usage of the SASWork directory, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 27.

2. On the Dashboard Settings page, specify the following information:
   
   **Description**
   specify a name for the portlet

   **Resource Type**
   select **SAS Home Directory 9.4 SAS Directory**

   **Metric**
   select **Use Percent**

   ![Dashboard Settings Metric Viewer](image)

3. In the **Selected Resources** area, click **Add to List** to display the Metric Viewer Add/Remove Resources window.

4. In the Metric Viewer Add/Remove Resources window, select all resources in the Resources table, click the **Add** icon to move them to the **Add Resources** table, and click **OK**.

5. Complete the procedure to add the portlet to your **Dashboard** page.

**Example: Adding a WebApp Login Response Time Metric Viewer**

To add a portlet for viewing the response time for all web applications, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 27.

2. On the Dashboard Settings page, specify the following information:
   
   **Description**
   specify a name for the portlet

   **Resource Type**
   select **HTTP**
3. In the Add Resources window, select all resources in the Resources table, click the Add icon to move them to the Add Resources table, and click OK.

4. Complete the procedure to add the portlet to your Dashboard page.

Example: Adding a PostgreSQL Data Volume Metric Viewer

To add a portlet for viewing the volume of data in all PostgreSQL databases, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 27.

2. On the Dashboard Settings page, specify the following information:
   - **Description**: specify a name for the portlet
   - **Resource Type**: select PostgreSQL 9.x Database
   - **Metric**: select Data Space Used

3. In the Add Resources window, select all resources in the Resources table, click the Add icon to move them to the Add Resources table, and click OK.

4. Complete the procedure to add the portlet to your Dashboard page.
Example: Adding a tc Runtime Manager Active Sessions Metric Viewer

To add a portlet for viewing the number of active sessions for all web applications, follow these steps.

1. Follow the basic procedure for creating a metric viewer portlet at “Adding Metric Viewer Portlets” on page 27.

2. On the Dashboard Settings page, specify the following information:
   
   **Description**
   specify a name for the portlet

   **Resource Type**
   select **SpringSource tc Runtime 7.0 Manager**

   **Metric**
   select **Active Sessions**

   
<table>
<thead>
<tr>
<th>Display Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description:</strong></td>
</tr>
<tr>
<td><strong>Display Range:</strong></td>
</tr>
<tr>
<td><strong>Resource Type:</strong></td>
</tr>
<tr>
<td><strong>Metric:</strong></td>
</tr>
<tr>
<td><strong>Sort Order:</strong></td>
</tr>
</tbody>
</table>

3. On the Add/Remove Resources page, in the View field, select **Servers**. In the Resources table, select these servers:
   
   - `<server_name>` tc Runtime SASServer1_1/SASWebReportStudio localhost Manager
   - `<server_name>` tc Runtime SASServer1_1/SASAdmin localhost Manager
   - `<server_name>` tc Runtime SASServer1_1/SASContentServer localhost Manager
   - `<server_name>` tc Runtime SASServer1_1/SASBIDashboard localhost Manager
   - `<server_name>` tc Runtime SASServer1_1/SASWebDoc localhost Manager
   - `<server_name>` tc Runtime SASServer1_1/SASPortal localhost Manager
   - `<server_name>` tc Runtime SASServer1_1/SASLogon localhost Manager
   - `<server_name>` tc Runtime SASServer1_1/SASStoredProcess localhost Manager

   Some of these servers might be on the second page of the list (click the page number at the bottom of the list to navigate between pages). Click the **Add** icon to move the selected servers on one page before moving to another page.

4. Complete the procedure to add the portlet to your **Dashboard** page.
Metric Chart Examples

Creating a Free Memory Chart

To create a chart of the free memory on a server and save the chart to be displayed by the Saved Chart portlet on your dashboard, follow these steps.

1. On the SAS Environment Manager menu bar, select Resources ➔ Browse.
2. On the Resources page, select Platforms.
3. In the table of resources, click on the name of your server to display the resource detail page.
4. On the resource detail page, one of the displayed metric charts is Free Memory. Click on the name of the chart to display the Metric Chart page.
5. On the Metric Chart page, select Save Chart to Dashboards.
6. The Save Chart to Dashboards dialog box appears. Select the dashboards on which the saved chart should appear. Click Add to save the chart.

**Note:** The chart will not appear on your dashboard until you create a Saved Chart portlet. See “Adding a Saved Charts Portlet” on page 35 for instructions on creating the portlet.

**Creating a Number of Spawned Servers Chart**

To create a chart of the current number of spawned servers and save the chart to be displayed by the Saved Chart portlet on your dashboard, follow these steps.
1. On the SAS Environment Manager menu bar, select Resources ➔ Browse ➔ Servers.

2. On the Resources page, in the All Server Types field, select SAS Object Spawner 9.4 and then click on the arrow at the right of the filter fields.

3. In the table of resources, click on the name of the object spawner to display the resource detail page.

4. On the resource detail page, one of the displayed metric charts is Current Servers. Click on the name of the chart to display the Metric Chart page.

5. On the Metric Chart page, select Save Chart to Dashboards.

6. The Save Chart to Dashboards dialog box appears. Select the dashboards on which the saved chart should appear. Click Add to save the chart.

   Note: The chart will not appear on your dashboard until you create a Saved Chart portlet. See “Adding a Saved Charts Portlet” on page 35 for instructions on creating the portlet.

---

Creating a Metadata Users Chart

To create a chart of the current number of users per minute of the SAS Metadata Server and save the chart to be displayed by the Saved Chart portlet on your dashboard, follow these steps.

1. On the SAS Environment Manager menu bar, select Resources ➔ Browse ➔ Servers.

2. On the Resources page, in the All Server Types field, select SAS Metadata Server 9.4 and then click on the arrow at the right of the filter fields.

3. In the table of resources, click on the name of the metadata server to display the resource detail page.

4. On the left side of the resource detail page, select All Metrics from the menu.
5. In the table of metrics, find **Total Clients per Minute** and position your mouse pointer over the information icon 🔄. The metric information tooltip appears.

6. On the tooltip, select **View Full Chart**. The Metric Chart page appears.

7. On the Metric Chart page, select **Save Chart to Dashboards**.

8. The Save Chart to Dashboards dialog box appears. Select the dashboards on which the saved chart should appear. Click **Add** to save the chart.

   **Note:** The chart will not appear on your dashboard until you create a Saved Chart portlet. See “Adding a Saved Charts Portlet” on page 35 for instructions on creating the portlet.

---

**Adding a Saved Charts Portlet**

The Saved Charts portlet displays a rotation of all of the resource metric charts that you have saved. You can create this portlet before or after you save charts. If you create the portlet before saving charts, the saved charts will automatically appear in the portlet as
you save them. If you create the portlet after saving charts, the saved charts will not appear on your dashboard until you create the portlet.

Follow these steps to add a Save Charts portlet.

1. Click **Dashboard** on the menu bar.

2. On the left side of the Dashboard page, select **Saved Charts** in the **Add Content to this column** field and click the Add icon.

   A **Saved Charts** portlet is added to your Dashboard and automatically displays a slideshow of the charts that you previously saved.

3. To change how long each chart is displayed or the time period displayed on the chart, click the Configuration icon.

   ![Configuration dialog box](image)
Chapter 4
Finding Resources in Your System

Automatically Discovering and Adding SAS Resources .......................... 37
Using the Auto-Discovery Portlet ............................................................... 37
Performing an Auto-Discovery Scan ......................................................... 38
Rediscovering Resources ........................................................................... 38
Manually Adding a Server ........................................................................... 39
Manually Configuring a Service ................................................................. 39
Manually Specifying Hostnames and IP Addresses ................................. 40

Automatically Discovering and Adding SAS Resources

When the SAS Deployment Wizard installs SAS applications, it creates a file called auto-approved.properties. This file is located in the \agenthome\conf directory. This file lists all of the resource types that are automatically monitored after they have been discovered. When you run SAS Environment Manager for the first time, the application auto-discovers and auto-accepts the resources listed in the auto-approved.properties file. All of the resources in your initial SAS installation are automatically in your inventory when you start using SAS Environment Manager. Resource types that are not listed in this file must be accepted for monitoring after they have been discovered.

Using the Auto-Discovery Portlet

The Auto-Discovery portlet displays a list of servers and platform services that are auto-discovered but not auto-accepted. All SAS resources should be auto-discovered and auto-accepted, so they will not appear in this portlet. Resources that are listed on the portlet are known but are not yet being monitored. After the resources from the initial SAS installation have been discovered and added to the inventory, the Auto-Discovery portlet lists new resources from custom plug-ins that have been added to the monitored platforms.

To discover and add resources, follow these steps:
1. On the Dashboard, check the Auto-Discovery portlet to see whether new resources are listed.

2. Select the check box beside the resources that you want to monitor and select Add to Inventory.

3. Go to the Resources page. The resources you just added are listed in the appropriate table, together with any resources that are already being monitored. However, an Unknown icon ( ) is displayed in the Availability column for the new resources, because SAS Environment Manager has not begun to collect monitoring data. SAS Environment Manager collects data at intervals rather than continuously, so you must wait for the next data-collection cycle.

4. After approximately five minutes, data should be collected for the new resources and the Availability column reflects the status of the resources.

If the status of a new resource is displayed as Unknown even after a period of waiting, then the resource might not be completely configured for data collection. To configure the resource, follow these steps:

1. In the Resource page, locate the resource whose status is unknown and click on the entry in the Resources table. The Monitor page for the selected resource is displayed.

2. A message is displayed if the resource needs to be configured. If you need to perform additional configuration steps, select Inventory to display configuration details for the resource.

3. Scroll to the Configuration Properties area of the page and verify that the properties are correct. Click Edit to make changes to the properties.

---

Performing an Auto-Discovery Scan

If you know that resources have been added on a platform that you are monitoring, you can run an auto-discovery scan on the platform to locate the resources. Once the resources have been discovered, you can add them to your inventory for monitoring.

To perform an auto-discovery scan of a platform, follow these steps.

1. Using the Resources tab, go to the Detail page for the platform that you want to scan.

2. Select Tools Menu ➔ New Auto-Discovery

3. If you want to scan for all servers and system processes on the platform, click OK.

4. If you want to scan for specific server types, select the check boxes for the server types that you want to scan for. You can also select attributes such as directories to include or exclude from the scan and the depth at which to scan. When you have specified the scanning criteria, click OK to start the scan.

---

Rediscovering Resources

After resources have been auto-discovered, there might be some resources that cannot be added to the inventory for some reason. If this happens, you can clear the contents of the
auto-discovery queue and try discovering them again. After the resources are removed from the queue, and you restart the agent, the agent will rediscover the resources.

To clear the auto-discovery queue follow these steps:

1. Select Manage ⇒ HQ Health to display the HQ Health page.
2. On the HQ Health page, select the Database tab.
3. In the Action field, select Purge AIQ Data and click .

You can also manually delete any server resources from the Resources page. The servers are then rediscovered when you run an auto-discovery scan.

---

**Manually Adding a Server**

There might be some instances where you need to monitor a server that is not auto-discovered by the SAS Environment Manager agent. To manually add a server, follow these steps:

1. Navigate to the Resource Detail page for the platform on which the server runs.
2. Select Tools Menu ⇒ New Server to display the New Server page.
3. On the New Server page, specify the server name.
4. Use the Server Type menu to select the type of server. If the server type that you want to add is not listed, it is not supported by SAS Environment Manager and cannot be added.
5. In the Install Path field, specify the full pathname to the server software.
6. Click OK to complete the server definition.

*Note:* Because the agent does not update data continuously, it might take several minutes before metric data begins appearing for the new server.

---

**Manually Configuring a Service**

There might be some instances where you need to monitor a service that is not auto-discovered by the SAS Environment Manager agent. To manually add a service, follow these steps:

1. In the Resources view, select the platform that contains the service that you want to monitor.
2. In the Detail view for the selected platform, select Tools Menu ⇒ New Platform Service.
3. Specify a name for the service and select the service type. Common selections include HTTP, Fileserver File, and TCP.
4. Click OK to create the service and display the service details. Select the Configuration Properties link on the page.
5. Use the instructions on the Configuration Properties page to specify the options needed to monitor the service.
Manually Specifying Hostnames and IP Addresses

The SAS Environment Manager agent automatically detects and monitors the IP address of your deployment’s local host as the primary host NIC. However, the SAS Environment Manager agent can also detect other custom local IP addresses and additional server processes that are bound to the primary host IP. In order to locate these addresses and processes, you can manually identify the custom local IP addresses as resources in SAS Environment Manager by specifying the `custom.local.ips` property in the `agent.properties` file.

Follow these steps:

1. Locate and open the `agent.properties` file in the SAS Environment Manager Agent directory. The file is located in the directory `<config_dir>/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/conf/`.

2. In the agent.properties file, add a line for the `custom.local.ips` property, and specify a single IP address or a comma-separated list of multiple IP addresses. You must specify only IP addresses, not hostnames. No IP address listed in this file should be specified in any other agent.properties file, and should not be the IP address of any other agent. An IP address cannot be considered as a local address for more than one agent. These are examples of valid entries:

   Single address
   ```
   custom.local.ips=134.54.62.203
   ```

   Multiple addresses
   ```
   custom.local.ips=134.54.62.203,134.54.117.59
   ```

3. Restart the SAS Environment Manager agent. Issue the command `<config_dir>/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/bin/hq-agent (.bat|.sh) start`.

4. Restart the SAS Environment Manager server. Issue the command `<config_dir>/Lev1/Web/SASEnvironmentManager/server-5.8.0-EE/bin/hq-server (.bat|.sh) restart`.

5. Wait five to ten minutes for resources to be rediscovered.

6. In SAS Environment Manager select Resources ⇒ Browse to verify that the server resources have been discovered.
Chapter 5

Monitoring and Controlling Resources

Monitoring Resources

A central capability of SAS Environment Manager is the ability to monitor resources. Monitoring enables you to track a resource’s availability and overall health. A variety of metric data is displayed, both in numeric and graphic format, to enable you to examine detailed information about the resource’s operation.

To view the monitoring information for a resource, select a resource from the table on the Resources page.
The fastest way to check the status of the selected resource is to use the availability bar, which is above the indicator charts. The availability bar displays a color-coded dot that represents the availability during a time slice. The length of each time slice depends on the display range that you select (for example, if you display the past eight hours of data, each dot corresponds to approximately eight minutes). The percentage of time that the resource was available is displayed at the end of the availability bar.

The dots are color-coded using the following format:

- **Green**
  - 100% availability

- **Yellow**
  - Partial availability; between 0% and 100%

- **Red**
  - 0% availability

An availability bar such as the one in the following figure shows that the resource fluctuated between being available, partially available, and unavailable over the most recent time slices.

To help determine the cause of availability problems, click on the dot for a particular time slice. The selected time slice is highlighted on the indicator charts below the availability bar. This function helps you quickly check the charts for data that might correspond to the availability problem.
To change the metrics that are displayed in the metric charts, use the menu on the left side of the page to select either All Metrics or Problem Metrics, and then click View Metrics to display a list of available metrics. Click the arrow beside a metric to add the chart to those displayed on the page.

The events bar is displayed below the indicator charts. It is similar to the availability bar, with dots representing time slices. The bar displays only a purple dot if an event occurs during a time slice. If no event occurs, the bar remains black.

---

### Managing SAS Resources

**SAS Server Names**

Because SAS Environment Manager is based on VMware’s Hyperic, some server names in SAS Environment Manager do not match the names that are used in a SAS deployment. Use this table to determine the name of the server that you are interested in.

<table>
<thead>
<tr>
<th>SAS Server Name</th>
<th>Server Name Displayed in SAS Environment Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Environment Manager</td>
<td>Apache Tomcat 5.5, 6.0, 7.0</td>
</tr>
<tr>
<td>SAS Environment Manager Agent</td>
<td>HQ Agent</td>
</tr>
<tr>
<td>SAS Web Server</td>
<td>Pivotal Web Server 5.1, 5.2</td>
</tr>
</tbody>
</table>
### Using the Map Control

The Map control provides a visual representation of resources and the next level of parent and child resources. You can click on any of the resources listed on the map to go to the Monitor page for that resource. The Map control is available on the Monitor page for a resource.

The map for a platform displays the servers under the platform, and the map for a server displays the services under the server. You can use the map to better understand how a SAS environment is presented in SAS Environment Manager.

In SAS Environment Manager, the SAS Application Server Tier is a platform. The map for the platform illustrates the SAS servers that are part of the server tier.

Logical SAS servers, such as logical workspace servers or logical stored process servers, are SAS Environment Manager services, so they are displayed as children under the SASApp server.

For a SAS Object Spawner, the services listed in the map are the servers that are spawned by the spawner.
Making Resources Easier to Locate

Organizing Resources into Groups

In SAS Environment Manager, resources are organized into groups to make them easier to locate and manage. There are six different types of groups:

- platform resource groups
- server resource groups
- service resource groups
- compatible groups
- mixed groups
- applications

resource groups

These groups are automatically created. When resources are discovered and then added to the inventory of monitored resources, they are added to the appropriate resource group. The three resource groups that are automatically created in SAS Environment Manager are platforms, servers, and services. It is important to note how SAS resources map to the resource hierarchy. For example, logical SAS servers are added to the services group.

compatible groups

These groups contain selected instances of a single type of resource (for example, SAS Object Spawners). Creating a compatible group enables you to view aggregate metrics for a resource type. Compatible groups also make it easier for you to locate resources that you need to monitor. For example, you can create a group containing several servers of critical importance, which prevents you from having to search for those servers among the large numbers that might be on your site. After you create a
compatible group, you can add resources to the group if they match the selected
group type.

mixed groups
These groups are user-created groups that can contain multiple types of resources.
Mixed groups can contain other groups, platforms, servers, and services, or
applications. Availability is the only metric that is available for a mixed group. This
type of group is useful for functions such as checking the availability of a SAS
Object Spawner and all of the spawned services or for viewing the collective
availability of a group of resources.

application
These groups are a set of selected services, usually running in different servers on
multiple platforms, that together fulfill a single business purpose. Creating
application groups enables you to manage your infrastructure from an application
perspective, as opposed to a hardware perspective.

If you initialize SAS Environment Manager Extended Monitoring, a set of default
compatible and mixed groups is created. These groups provide commonly used
collections of resources in a SAS environment. They are automatically updated as you
add and remove resources. See “Initializing SAS Environment Manager Extended
Monitoring” on page 83 for initialization instructions.

Create a Group

To create and populate a group:
2. On the New Group page, specify a name for the group.
3. Use the Contains Resources menu to select the type of group that you want to
   create.
4. Use the Select Resource Type menu to select the type of resource that the group will
   contain.
5. Click OK to create the group.
6. On the Resources page, click on a resource that you want to add to the group.
7. On the Details page for the selected resource, select Tools Menu ⇒ Add To Group.
8. On the Group Manager page, select the group to which you want to add the resource.
   If the group that you want to add the resource to is not listed, then the selected
   resource type is not the same as the resource types that are specified for the group.

Create an Application

To create and populate an application:
2. On the New Application page, specify a name for the application. Click OK to create
   the application. The Configuration page for the application appears.
3. In the Services area, click Add to List to select resources for the application.
4. In the Services List, select the services in the Services list that you want to add to
   the application and use the arrow button to move them to the Add Services list.
Click **OK** when you finish selecting services, and then click **OK** again to create the application.

---

**Controlling Resources Using Control Actions**

**What is a Control Action?**

Control actions enable you to control certain types of servers and services from SAS Environment Manager. You can create control actions to perform operations such as starting, stopping, restarting, pausing, and resuming a server or starting, stopping, and sending messages through a service. The specific actions available depend on the server or service type selected. You can define resource actions to run immediately, to run on a schedule, or to run in response to an alert.

You can use control actions to control these types of servers:

- PostgreSQL SAS Web Infrastructure Platform Data Server (PostgreSQL 9.x)
- SAS Object Spawner
- SAS OLAP Server
- SAS Metadata Server
- SAS Web Application Server (SpringSource tc Runtime)

**Performing Immediate Resource Control Actions**

To use a control action to perform an immediate action on a resource, follow these steps:

1. In the Resource Details page for the selected server or service, click **Control**. If this menu item is not present, the resource does not support control actions. The Control Action page is displayed.

2. In the **Quick Control** area, select the type of action that you want to perform in the **Control Action** field.

3. Specify any arguments for the action in the **Control Arguments** field.

4. Click **Perform** to perform the action.

**Scheduling Resource Control Actions**

To create a scheduled resource control action, follow these steps:
1. In the Resource Details page for the selected resource, click Control. If this menu item is not present, the resource does not support control actions. The Control Action page is displayed.

2. In the Control Action Schedule area, click New. The Scheduled Control Action page is displayed.

3. Select the action that you want to perform in the Control Action field.

4. In the Schedule area, select the radio button next to the date and specify the date and time that the scheduled action should take place.

5. Specify how often the action should recur and when the scheduled recurrence should end.

6. Click OK to save the scheduled control action.

To view the list of scheduled control actions for the resource, click Control in the Resource Details page for the selected resource. All scheduled control actions are listed in the Control Action Schedule area.

**Performing Control Actions in Response to an Alert**

To define a control action to occur in response to an alert, follow these steps:

1. Create or edit an alert definition. See “Defining an Alert” on page 55 for more information. On the Alert Definition page, click Control, the click Edit. The Add Control Action page is displayed.

2. Use the Resource Type field to select the type of server or service for which you want to create the control action.

3. After you select the resource type, the Resource Name field is populated with all instances of the selected resource type. Select the instance for which you want to create the control action.

4. Select the type of action to be performed in the Control Type field. The field contains only actions that are supported on the selected resource type.

5. Click OK to define the control action. The defined action now takes place whenever the associated alert occurs.
Chapter 6

Working with Events and Alerts

Creating Resource Events

Overview of Events
Creating Events Based on SAS Server Logs

Importing and Exporting Events
Overview
Import Events
Exporting Events

Working with Resource Alerts
Overview of Alerts
Defining an Alert
Defining an Escalation Scheme
Notifying Users of an Alert
Specifying Email System Parameters
Running a Script in Response to an Alert

Creating Resource Events

Overview of Events

SAS Environment Manager provides the capability to monitor metrics, scan log files, manage configuration changes, and monitor availability. When there is a change in a resource’s threshold value for one of these items, an event is recorded in SAS Environment Manager’s event message system. Events are also automatically created for certain types of entries in SAS server logs, and you can specify other criteria that will create events based on SAS server logs. All events throughout the entire deployment are displayed in the Event Center. To access the Event Center, select Analyze ⇒ Event Center.
The table shows information about recently recorded events, including the status, the resource involved, and information about what caused the event to be triggered. You can subset the table to locate events more quickly. For example, you can show only the events that have at least Error status, or only the ones that affect resources in a specified group.

Clicking on the name of the resource in the event table takes you to the resource’s Detail page.

Creating Events Based on SAS Server Logs

SAS Environment Manager monitors the log files for SAS servers and automatically creates events for error messages recorded in those logs. These logs use the standard logging facilities of SAS. For more information, see *SAS Logging: Configuration and Programming Reference*. The events are added to the rest of the events recorded by SAS Environment Manager.

The types of SAS servers whose logs are used to create events are as follows:

- SAS Metadata Server
- OLAP server
- Object spawner
- Stored process server
- CONNECT spawner
- Workspace server
- Pooled workspace server

You can also change the configuration to look for specific types of SAS server log entries in addition to errors. The file *sev_logtracker_plugin.properties* contains entries for each type of SAS server log entry that SAS Environment Manager looks for. You can add to this file to create events for criteria of your choosing. Each SAS server has its own properties file, so logging events can be created for specific server types.

For example, all *sev_logtracker_plugin.properties* files contain these entries by default:

```plaintext
# All fatal
level.fatal.1=.*
```
The entries in this file use the format

`level.[level_of_message].[sequential_number]=[regular_expression]`

`level.fatal.1=.*` specifies that an event is created whenever a message appears in the SAS log with a level of Fatal. The message can contain any text. The second entry produces the same result for Error messages.

`level.warn.1=.*Access to this account.*is locked out.*` specifies that an event is created whenever a message with a level of Warn appears that also contains the text `Access to this account.*is locked out`.

To add your own entries to the properties file in order to create events for specific messages, follow these steps:

1. Edit the file `<server_config_directory>/sev_logtracker_plugin.properties` (for example, `/opt/SAS/Level1/SASApp/OLAPServer/sev_logtracker_plugin.properties`)
2. Add a line for the message that you want to track. The format is

   `level.[level_of_message].[sequential_number]=[regular_expression]`

   For example, this entry looks for an INFO message containing the phrase “AUTOEXEC processing beginning”:

   `level.info.1=.*AUTOEXEC processing beginning.*`

3. If you add multiple entries to look for messages at the same log level, increment the number, for example:

   `level.info.2=.*Message text here.*`

4. Save the file. SAS Environment Manager automatically uses the revised file.

---

**Importing and Exporting Events**

**Overview**

SAS Environment Manager provides services that enable you to import and export event data. Event importing provides a specified location and format for external applications or SAS code to write events to. When data is written to the specified location, SAS Environment Manager creates an event, which can then be handled just like any other event in the application. Event exporting operates in a similar manner. Every time an event occurs in SAS Environment Manager, the application creates an entry in a specified location, using a specified format. You can then configure third-party monitoring tools to monitor the location for new entries and handle the exported events.
Import Events

To import events, you must first create an event importer service.

1. Select Resources ➔ Browse ➔ Platforms, and then select the platform on which you want to create the service.

2. On the detail page for the selected platform, select Tools Menu ➔ New Platform Service.

3. On the New Service page, specify a name for the service and select SAS Event Importer in the Service Type field. Click OK to define the service.

4. Select Resources ➔ Browse ➔ Services, and then select the SAS Event Importer service that you just defined.

5. The detail page for the service displays a message indicating that the service has not been configured. Click the Configuration Properties link.

6. On the Configuration Properties page, select the importer.enable check box to turn on event importing. Also select the service.log_track.enable check box to enable log tracking. Specify the log file that you want to track in the service.log_track.files field. The file that you specify in this field is the log file that external SAS applications or programs write to. Specify a single log file in this field, and do not use wildcards in the filename. Click OK to save the configuration.

If you want a SAS program to create an event, add the EVEVENT macro. This macro creates an event in the proper format and stores it in a specified directory.

The format of an event that can be imported is as follows:

date|time|offset|msglevel|source|message

The date is specified as yyyy-MM-dd.

The time is specified as HH:mm:ss.

The msglevel must be one of these values: ERROR, WARN, INFO, DEBUG.

Note: In order to use the EVEVENT macro, you must access the code for the macro. Use %INCLUDE statements to include the code for the %EVEVENT and %EVERRMSG macros in your program. The source code for the macros is located in the /emi-framework/SASMacro directory.

The syntax for the macro is as follows:

%macro evevent(src=source_message_string,msglevel=message_level,msgtext=message_string);

src=

specifies the originator of the event. You can also use this parameter to specify the format of the text in the msgtext= parameter. The value that you specify for the format is specified by the parser. Use a colon (:) to separate the originator and the format information.

msglevel=

specifies the level of the event. Valid values are DEBUG, INFO, WARN, and ERROR.

msgtext=

specifies the text of the event message.
Exporting Events

To export events, you must create an event exporter service.

1. Ensure that you have defined a SAS Environment Manager user ID that can query events. The user ID must meet these requirements:
   - must be a member of the Super User Role in SAS Environment Manager
   - must be defined in SAS metadata
   - cannot be sasadm@saspw, sasevs@saspw, sasadm, or any other user that is defined during the SAS configuration process
   - cannot be a SAS internal user account
   - cannot contain the @ character

   The best practice is to use SAS Management Console to define a user in the form domain\newuserID (Windows) or newuserID (UNIX), add that user to the user group SAS Environment Manager Super Users, and then synchronize the users in SAS Environment Manager. You can then specify the user ID newuserID in the event exporter service.

2. Select Resources ⇒ Browse ⇒ Platforms, and then select the platform on which you want to create the service.


4. On the New Service page, specify a name for the service and select SAS Event Exporter in the Service Type field. Click OK to define the service.

5. Select Resources ⇒ Browse ⇒ Services, and then select the SAS Event Exporter service that you just defined.

6. The detail page for the service displays a message indicating that the service has not been configured. Click the Configuration Properties link.

7. On the Configuration Properties page, select the exporter.enable check box to turn on event exporting. Click OK to save the configuration.

8. Specify the user ID and password of the SAS Environment Manager user that is used to query events. This is the user ID defined in Step 1 of this procedure.

   If you specify a user ID that does not meet the requirements in Step 1, event exporting will fail.

9. In the exporter.filename field, specify the filename and location where event records are to be written. You need to point your third-party monitoring application to this location in order to read events as they are recorded. Click OK to save the configuration.

The format of an exported event is as follows:

date\time\offset|msglevel|source\message

The date is specified as yyyy-MM-dd.

The time is specified as HH:mm:ss.

The msglevel must be one of these values: ERROR, WARN, INFO, DEBUG.

Here is an example of an exported event:
Working with Resource Alerts

Overview of Alerts

If you want to identify a type of event for notification or further action, you can create an alert. Alerts are a user-defined type of event that indicates a critical condition in a selected resource. When an alert occurs, it must be fixed or acknowledged, and alerts are listed until they are marked as being fixed. You can define escalation schemes to identify the actions that happen if an alert is not fixed within a specified time. You can also create SNMP notifications for critical alerts. See “Example: Defining an SNMP Alert Notification” on page 137 for information.

Alerts are logged by the agents and all events throughout the entire deployment are displayed in the Alert Center. To access the Alert Center, select Analyze → Event Center.

You can filter the alerts, for example, so that only the most recent ones or the ones of a specified type are displayed.

You can mark alerts as fixed or acknowledged. You can acknowledge an alert only if an escalation scheme has been defined for it. If an escalation scheme has not been defined for the alert, you can mark the alert only as fixed. Select the check box next to an alert, and then click Fixed or Acknowledge. You can also click on the entry in the Alert Definition column to display the Alert Details page, where you can view details about the alert and mark the alert as fixed and add comments.
If you initialize SAS Environment Manager Extended Monitoring, a set of alerts is automatically created for you. These alerts identify the most common problems in a SAS environment. Using the alerts in extended monitoring enables you to start working with SAS Environment Manager quickly, without having to manually define alerts. See “Initializing SAS Environment Manager Extended Monitoring” on page 83 for initialization instructions.

**Defining an Alert**

To define an alert, follow these steps:

1. Select **Resources ⇒ Browse** or use a dashboard portlet to locate the resource for which you want to create an alert.
2. There are three icons on the left of the entry for the resource in the table. Click on the alert icon, which is on the right of the group. The Alerts page for the resource appears.

If you initialize SAS Environment Manager Extended Monitoring, a set of alerts is automatically created for you. These alerts identify the most common problems in a SAS environment. Using the alerts in extended monitoring enables you to start working with SAS Environment Manager quickly, without having to manually define alerts. See “Initializing SAS Environment Manager Extended Monitoring” on page 83 for initialization instructions.
3. Click **New** to display the New Alert page.

4. In the **Alert Properties** area, specify the name and priority for the alert and whether it is active.

5. In the **Condition Set** area, specify the conditions that must be met in order for the alert to be triggered. You can specify up to three conditions for each alert. Use these fields to specify the condition that triggers the alert

   **Metric**
   - specifies that the alert is triggered based on the value of a metric that is monitored for the resource. You can specify that the condition is based on comparison to a fixed value, a percentage of a value, or a change in value. If you want to create an alert for a metric that is not listed, you must first enable collection of that metric.

   Update the metric collection settings for the resource type (choose **Monitoring Defaults** from the Manage page) or for the specific resource (click **Metrics** on the resource’s Monitor page).

   **Inventory Property**
   - specifies that the alert is triggered based on a change in the value of a resource property (such as version number). This condition is available only for certain types of resources (such as platforms and SAS Metadata Servers).

   **Control Action**
   - specifies that the alert is triggered when an action meets a specified condition (such as the action of stopping a failed server). This condition is available only for servers that can be controlled through control actions. See “Controlling Resources Using Control Actions” on page 47 for more information.

   **Events/Logs Level**
   - specifies that the alert is triggered when a selected type of log entry (such as Error) and an optional accompanying text string appears in the log.

   If you are defining an alert based on events from SAS server logs, the available values in this field do not match the logging levels available in SAS server logs. The four SAS Environment Manager levels must match the six levels in SAS server logs. Selecting Error in this field matches both the Fatal and Error levels in SAS server logs. Selecting Debug in this field matches both the Trace and Debug levels in SAS server logs.

   **Config changed**
   - specifies that the alert is triggered when a configuration file changes (you can choose to specify the name of the configuration file).
6. In the **Enable Action** field, specify whether the alert is triggered only once, or periodically as long as the alert condition persists.

7. Click **OK** to define the alert and display the Alert Configuration page.

8. On the Alert Configuration page, you can specify an escalation scheme and identify the users and roles that should be notified when the alert occurs. To create an escalation scheme, see “Defining an Escalation Scheme” on page 57.

9. Click **Return to Alert Definitions** when you are finished.

### Defining an Escalation Scheme

An escalation scheme is a series of actions that take place when an alert is not acknowledged or fixed within a certain period of time. An escalation scheme can be applied to multiple alerts. You can define an escalation scheme to perform any of these actions:

- send an email or SMS text message
- make an entry in a system log
- issue an SNMP notification

To define an escalation scheme, select **Manage ➔ Escalation Schemes Configuration** (in the **Server Settings** area).

For information about the information required when defining an escalation scheme, refer to the Help for the page.
Notifying Users of an Alert

There might be some types of alerts that you want members of your organization to be informed of if they occur. For users that are defined in SAS Environment Manager, you can notify specific users or roles. For users that are not defined in SAS Environment Manager, you can notify these users by email.

To notify users of alerts, follow these steps:

1. Select Analyze ⇒ Alert Center ⇒ Definition to display the table of alert definitions.
2. Click on the entry in the Alert Center table for the alert for which you want to send notifications.
3. At the bottom of the Alert Definition window, select one of the following:
   - **Notify Roles**
     whenever the alert occurs, notify all SAS Environment Manager users who are members of a specified role. Select Add to List to select the roles that should be notified.
   - **Notify Users**
     whenever the alert occurs, notify specific SAS Environment Manager users. Select Add to List to select the users that should be notified. You can select only users that have been defined in metadata and synchronized with SAS Environment Manager. See “SAS Environment Manager and SAS Metadata Users” on page 62 for more information.
   - **Notify Other Recipients**
     whenever the alert occurs, notify users by email. Select Add to List and specify the email addresses that should be notified.

Specifying Email System Parameters

The SMTP email server that SAS Environment Manager uses is specified by the SAS Deployment Wizard during installation and configuration of your SAS system. However, if your email server is restricted or uses a port other than the default, you must modify the configuration file where these parameters are stored.

To change the email server parameters, modify the file \[SAS\_config]/Lev\_Web/SASEnvironmentManager/server-5.8.0-EE/conf/hq-server.conf. Specify these parameters:

```
server.mail.host=mailhost
```

specifies the email (SMTP) server. The default value is the host name that was specified in the SAS Deployment Wizard during installation.

```
mail.user=SMTPuser
```

specifies the user ID required to log on to a restricted email server.

```
mail.password=SMTPpassword
```

specifies the password required to log on SMTPuser into the email server.

```
mail.smtp.port=port
```

specifies the port used to connect to the email server. The default value for an unsecured server is 25, and the default value for a secured server is 587.
mail.smtp.auth=<true><false>
specifies whether authentication is enabled. The default is false (authentication is not enabled). This parameter is needed when using a restricted server.

**Running a Script in Response to an Alert**

You can specify a script file to run when a specified alert is triggered. For example, a script file could contain commands to resolve the cause of the alert. Specify the name and path of the script file on the Alert Definition page.

This example illustrates how to run the Cleanwork utility whenever the SASWORK directory reaches 95% of capacity. Follow these steps.

1. Select Analyze ⇒ Alert Center
2. In the Alert Center window, click the Definition tab.
3. Locate the alert named SASWork Disk Use % > 95. Click on the alert name in the table.
4. In the Alert Definition page, click Script. In the Full path to script field, specify
   
   `<SASHome>/SASFoundation/9.4/utilities/bin/cleanwork -v /<WORK directory location> -log <log_dir>/cleanwork_alert.log`

   `<log_dir>` is a directory of your choosing that will contain the log for the utility.
5. Click Save Changes to add the script to the alert.

*Note:* This script will not clean data from SASWORK for users that are currently running jobs.
Chapter 7
Controlling Access to SAS Environment Manager

Controlling Access to SAS Environment Manager

About Native Roles and Users

SAS Environment Manager controls access and permissions within the application with its own registry of users and its own system of roles and permissions. In order to distinguish between the SAS Environment Manager access features and those in SAS metadata, this document and the SAS Environment Manager online Help refers to features internal to SAS Environment Manager as native features (such as native users or native roles). However, the SAS Environment Manager interface does not use the native terminology.

Although native user definitions are internal to SAS Environment Manager, they are mapped to user definitions created in SAS metadata. Native users are created by first creating the user definition in metadata and then synchronizing the user information with SAS Environment Manager. You cannot create or edit native user definitions in SAS Environment Manager directly.

Native roles enable you to grant capabilities and permissions for actions in SAS Environment Manager to selected users. For example, an administrator role could be granted full permissions for all resource types and the ability to acknowledge and fix alerts, whereas a guest role could be denied the ability to fix or acknowledge alerts and have only Read permission for resources. Assigning a native role to a native user determines the actions that the user can perform in SAS Environment Manager.

Each native role also has its own unique Dashboard page. Each user has access to their own personal Dashboard page and the Dashboard pages of all native roles of which they are a member.
SAS Environment Manager and SAS Metadata Users

Users in SAS Environment Manager are mapped to users created in SAS metadata. During installation, three user groups are created in SAS metadata to contain SAS Environment Manager users. Users and subgroups that are members of these groups are mapped to user definitions in SAS Environment Manager with corresponding roles. The user groups and their corresponding roles are as follows:

<table>
<thead>
<tr>
<th>Group name in SAS metadata</th>
<th>Role in SAS Environment Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS_EV_Super_User</td>
<td>Super User role</td>
</tr>
<tr>
<td>SAS_EV_Guest</td>
<td>Guest role</td>
</tr>
<tr>
<td>SAS_EV_AppServer_Tier</td>
<td>SAS App Tier role</td>
</tr>
</tbody>
</table>

For example, users that are members of the group SAS_EV_Guest in metadata are created as users in SAS Environment Manager and are assigned to the Guest role when the users are synchronized.

When you install SAS Environment Manager, all existing SAS Environment Manager user definitions are automatically added to the SAS_EV_Guest group in metadata. After the existing users have been added to the SAS_EV_Guest group, use SAS Management Console to modify the user definitions or assign users to other SAS_EV groups in metadata.

After you have defined new users in SAS metadata, sign on to SAS Environment Manager, and select **Manage ➤ Synchronize Users**. User definitions are created for all users that are defined in the three SAS_EV groups in metadata. Any SAS Environment Manager users that are not associated with user definitions in metadata are deleted. When synchronizing, user definitions are not treated as case-sensitive (for example, Sasuser@domain and SASUSER@domain are treated as the same user). Synchronization will fail for any users whose display name in metadata is longer than 100 characters.

Only users who are assigned to the Super User role can perform the Synchronize Users action.

After you assign a user to a group in SAS metadata and synchronize with SAS Environment Manager to assign that user to a SAS Environment Manager role, the role assignment can be changed only in SAS Environment Manager. You cannot change the group assignment in metadata and resynchronize in order to change the role in SAS Environment Manager. For example, if you assign a user to the SAS_EV_Super_User group in metadata, when you synchronize, that user is assigned to the Super User role in SAS Environment Manager. If you change the user assignment to the SAS_EV_Guest group and then synchronize again, the user remains assigned to the Super User role. You can change role assignments for existing users only in SAS Environment Manager.

If you sign on to SAS Environment Manager using a user ID that is defined in metadata, is a member of one of the SAS_EV groups, but is not defined in SAS Environment Manager, then a user definition is automatically created in SAS Environment Manager and assigned to the correct group.

The mapping between user information in metadata and in a SAS Environment Manager user definition is as follows:
To create a new SAS Environment Manager user, select **Administration** \(\rightarrow\) **Users** in SAS Environment Manager to define the user in metadata and assign it to the appropriate SAS_EV user group, and then select **Manage** \(\rightarrow\) **Synchronize Users** to create the native user and assign the user to the proper role.

The users in the SAS App Tier role are automatically granted access to the resources in these resource groups:

- SAS App Tier group
- SAS App Tier Server group
- SAS App Tier Services group

An internal account, sasevs (sasevs@saspw), is also created during installation. This account is assigned to the SAS Environment Manager roles SAS App Tier Role and Guest Role (which map to the SAS_EV_AppServer_Tier and SAS_EV_Guest groups in SAS metadata). The account is used for communications between the SAS Environment Manager agent and server and enables plugins to access the SAS Metadata Server. The internal account sasadm@saspw is the default account for signing on to SAS Environment Manager.

**CAUTION:**

All accounts in the SAS Environment Manager Super User group have access to the gconsole plugin, which allows Groovy code to be submitted. A side effect of this capability is that Groovy code can be executed as the server process owner, which is typically the SAS installer account. If your security policy does not permit this account to have this capability, you can move or delete the gconsole plugin. Move or delete the directory `<levelroot>/Web/SASEnvironmentManager/server-5.8.0-EE/hq-engine/hq-server/webapps/ROOT/hqu/gconsole`.

The SAS Logon Manager is used to control the process of logging on to SAS Environment Manager. The application uses the same authentication process and authentication provider as the other SAS web applications. User credentials are case-sensitive only on Linux platforms. SAS internal accounts are not case-sensitive, even on Linux platforms.

In SAS 9.4M3, the method of storing SAS Environment Manager user accounts in the database changed. In previous releases, when a user logged on to SAS Environment Manager, the account name that they used to log on was also used to identify them in the SAS Environment Manager session. In SAS 9.4M3, a user logs on using the same

<table>
<thead>
<tr>
<th>Metadata field</th>
<th>SAS Environment Manager field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Display Name</td>
</tr>
<tr>
<td>Name</td>
<td>Display Name if the Display Name is not specified in metadata</td>
</tr>
<tr>
<td>Metadata user</td>
<td>Username</td>
</tr>
<tr>
<td>Email (only the first email address specified is mapped)</td>
<td>Email</td>
</tr>
<tr>
<td>Phone (only the first phone number specified is mapped)</td>
<td>Phone</td>
</tr>
</tbody>
</table>

| **To create a new SAS Environment Manager user, select **Administration** \(\rightarrow\) **Users** in SAS Environment Manager to define the user in metadata and assign it to the appropriate SAS_EV user group, and then select **Manage** \(\rightarrow\) **Synchronize Users** to create the native user and assign the user to the proper role.**

The users in the SAS App Tier role are automatically granted access to the resources in these resource groups:

- SAS App Tier group
- SAS App Tier Server group
- SAS App Tier Services group

An internal account, sasevs (sasevs@saspw), is also created during installation. This account is assigned to the SAS Environment Manager roles SAS App Tier Role and Guest Role (which map to the SAS_EV_AppServer_Tier and SAS_EV_Guest groups in SAS metadata). The account is used for communications between the SAS Environment Manager agent and server and enables plugins to access the SAS Metadata Server. The internal account sasadm@saspw is the default account for signing on to SAS Environment Manager.

**CAUTION:**

All accounts in the SAS Environment Manager Super User group have access to the gconsole plugin, which allows Groovy code to be submitted. A side effect of this capability is that Groovy code can be executed as the server process owner, which is typically the SAS installer account. If your security policy does not permit this account to have this capability, you can move or delete the gconsole plugin. Move or delete the directory `<levelroot>/Web/SASEnvironmentManager/server-5.8.0-EE/hq-engine/hq-server/webapps/ROOT/hqu/gconsole`.

The SAS Logon Manager is used to control the process of logging on to SAS Environment Manager. The application uses the same authentication process and authentication provider as the other SAS web applications. User credentials are case-sensitive only on Linux platforms. SAS internal accounts are not case-sensitive, even on Linux platforms.

In SAS 9.4M3, the method of storing SAS Environment Manager user accounts in the database changed. In previous releases, when a user logged on to SAS Environment Manager, the account name that they used to log on was also used to identify them in the SAS Environment Manager session. In SAS 9.4M3, a user logs on using the same
account name, but SAS Environment Manager uses their SAS identity to identify the user. This change does not affect how users log on to SAS Environment Manager. Users will continue to use the same accounts and credentials. However, the SAS Environment Manager database contains only the SAS user name for each user account, rather than multiple account names for each user.

**Updating Passwords for SAS Environment Manager Metadata Identities**

To update the password for the sasevs@saspw account, follow these steps:

1. Stop SAS Environment Manager and all SAS Environment Manager agents on the system.
2. On the middle-tier machine, use the SAS Deployment Manager to change the password for the sasevs account.
3. Use the SAS Deployment Manager to update the sasevs password on the machines in the other tiers in the system.
4. Restart SAS Environment Manager and the SAS Environment Manager agents.

**Creating a Native Role**

To create a native role, follow these steps:

1. On the Manage page, select New Role.
2. On the New Role page, specify a name for the role and select the native permissions and capabilities for each resource type. If you grant the Read Only permission for a resource type, you can also select the native capabilities for the resource type. For all other permissions, the capabilities are automatically selected or disabled and cannot be changed.
3. Use these guidelines to determine the native permissions to set:
   - Adding a resource to the inventory and creating alert definitions
     Select Full or Read / Write permissions. Users can also respond to alerts and control resources.
   - Monitoring resources, responding to alerts, controlling resources
     Select the Read Only permission and grant the capability to acknowledge and fix alerts and to control resources. Users can respond to alerts and control resources but cannot create or modify alerts or resources.
   - Monitoring resources
     Select the Read Only permission, but do not grant capabilities for alerts resource control. Users can view and monitor only resources.
4. When you click OK, the role and associated Dashboard page are created, and the Role Properties page is displayed. Use this page to select native users and resource groups that should be associated with the role and to create an alert calendar.
5. To create an alert calendar, select the days and times during which the roles’ users will be notified of alerts. Make sure that at least one role is available during every time period.
Administrators for SAS middle-tier servers must be defined in SAS metadata as well as in SAS Environment Manager. To create a middle-tier administrator user ID, follow these steps:

1. From the Administration tab in SAS Environment Manager, use the User Manager to create a user definition for a middle-tier administrator.

2. Assign the user to the SAS_EV_AppServer_Tier user group. This group is created during the installation and configuration process.

3. Sign in to SAS Environment Manager using the sasevs@saspw credentials, which is the default administrative identity.

4. Click Manage ⇒ Synchronize Users to synchronize the SAS Environment Manager users with the SAS metadata users.

5. Click List Users to view the list of all users.

6. Locate the entry in the user table for the new user and click the user name entry to display the Properties page.

7. In the Roles Assigned To section, verify that the user is assigned to the SAS App Tier role.
Chapter 7 • Controlling Access to SAS Environment Manager
Part 2

Operations Integration, Audits, and Performance Analysis

Chapter 8
Understanding SAS Environment Manager Service Architecture . . 69

Chapter 9
Initializing and Enabling the Service Architecture .................. 81

Chapter 10
Using the Report Center ..................................................... 91

Chapter 11
Using Service Architecture to Perform Common Administration Tasks ......................................................... 99

Chapter 12
Working with Commands ....................................................... 105
Chapter 8
Understanding SAS Environment Manager Service Architecture

Understanding SAS Environment Manager Service Architecture

SAS Environment Manager Service Architecture provides functions and capabilities that enable SAS Environment Manager to fit into a service-oriented architecture (SOA). The package implements best practices for resource monitoring, automates and extends the application’s auditing and user monitoring capabilities, and follows industry standards to enable servers to use Application Response Measurement (ARM). These functions enable SAS Environment Manager to function as a key component in providing service-level management in a strategy that is based on the IT Infrastructure Library (ITIL).

SAS Environment Manager Service Architecture uses extract, transform, and load (ETL) processes to obtain metric data, convert it to a standard format, and load it into the SAS Environment Manager Data Mart. You can then leverage the data by using the supplied stored process reports and reporting tools or by using your own preferred reporting tools.

SAS Environment Service Architecture consists of the following components:

SAS Environment Manager Data Mart
The data mart is the key component of the Service Architecture and is created if you enable either one or both of the ETL processes in the service architecture. The data...
mart consists of a set of tables that hold the data collected by the ETL processes. The collected data is stored in a standard format, which makes it easy to run reports and perform analysis. The stored processes in the Report Center use the data in the data mart to produce pre-defined reports. Data is retained in the data mart for 60 days. The infrastructure for the data mart is provided in the SAS Environment Manager Extended Monitoring package.

Audit, Performance, and Measurement (APM) ETL
When this component is initialized, it collects information from various log files (including those generated by SAS servers and web application servers), standardizes it, and stores it in the data mart. A log discovery process runs approximately every 15 minutes to locate all of the logs that need to be included in the APM ETL. After the data is stored in the data mart, you can use it to produce reports in the Report Center or to perform custom reporting and analysis.

Agent-Collected Metrics (ACM) ETL
When this component is initialized, it uses information that was collected by the SAS Environment Manager agent from the computing resources and components in your deployment. The data is processed and loaded into the data mart. After the data is stored in the data mart, you can use it to produce reports in the Report Center or to perform custom reporting and analysis.

Report Center
The Report Center provides a convenient access point for the reports that are provided as part of the Service Architecture. Once one or more of the ETL components have been initialized and enabled, data is available in the data mart. This data is then used to feed the predefined reports in the Report Center. The Report Center is not available until either one or both of the ETL processes is enabled.

Solution kit framework
The solution kit framework can extend the capabilities of SAS Environment Manager to support specific solutions or applications. The framework includes support for collecting and storing operation information about the solution in the data mart and for using the associated reporting capabilities.

SAS Visual Analytics data feed
Data from the data mart can be easily loaded into SAS Visual Analytics. If the data feed option is enabled in SAS Environment Manager, selected data tables from the data mart are copied to a specified drop zone directory. SAS Visual Analytics can then automatically load the tables from the drop zone into the application.

Federated data mart
If you are using a data mart on multiple deployments in your organization, you can create a federated data mart to consolidate analysis and monitoring for all of the deployments. The federated data mart collects into one location the ACM data from the data marts of each deployment. Each deployment still retains its own data mart, but the federated data mart enables you to easily compare the metric data across your organization.

Note: The alerts and reports in the Service Architecture are provided as a best efforts resource to assist in the troubleshooting and performance tuning of your SAS deployment. However, many other factors might influence your user experience, some of which are beyond the monitoring capabilities of SAS Environment Manager. If you need additional assistance or reference information about performance tuning and hardware configuration, please contact the SAS Professional Services Division.

The following diagram illustrates how the components of the Service Architecture work together.
Working with SAS Environment Manager Extended Monitoring

Purpose and Components

Extended monitoring implements best practices for SAS Environment Manager and also provides the framework needed for SAS Environment Manager Service Architecture. Extended monitoring provides these two separate categories of components:
SAS Environment Manager setup
creates a predefined set of alerts, resource groups, and best-practice metric configurations. This step quickly optimizes your SAS Environment Manager configuration and implements best practices in how your environment is monitored.

Data mart infrastructure
provides empty data tables, stored processes, and reports that are populated by data that is provided by the APM or ACM ETL processes.

Extended monitoring components are not active until you initialize the service architecture.

Understanding the SAS Environment Manager Setup Components

Even if you are not using the extended monitoring and reporting capabilities of SAS Environment Manager Service Architecture, extended monitoring provides key components for your resource monitoring strategy. The SAS Environment Manager setup components configure extended monitoring to provide best practices in resource monitoring and alerting. These configurations and definitions enable you to begin using SAS Environment Manager right away, without having to perform manual configuration and definition processes. Extended monitoring includes these components:

resource configuration
You must configure resources such as platforms and servers that are added to your SAS Environment Manager inventory during installation so that they can begin collecting metric data. Initializing extended monitoring automates the process of configuring these resources, enabling you to start monitoring resources without having to go through a manual configuration process.

tuned alerts
Extended monitoring provides a set of optimized alerts, developed by SAS. These alerts notify you of operational issues that might be encountered in a SAS environment (such as storage issues, server status, and hardware issues). See “Service Architecture Alert Definitions” on page 161 for a list of the alerts created by Service Architecture extended monitoring.

defined resource groups
Resources that form a logical group (such as all platforms, servers, and services in the SAS App Tier) are automatically collected into predefined groups that are defined in extended monitoring. These groups are automatically updated as you add and delete resources, so they always stay current. A resource group for every reporting table in the data mart is automatically created and maintained.

event importing and exporting
You can export events that are generated by SAS Environment Manager to support third-party monitoring applications. In addition, you can import events from other SAS applications and from third-party applications into SAS Environment Manager for processing.

HTTP checks of web applications
Enabling extended monitoring defines a set of resources that monitor the availability and responsiveness of key SAS web applications such as SAS Stored Process Web Application.

adjustments to monitoring metrics
As part of the process of optimizing resource monitoring, some adjustments are made in the metrics collected for system resources. Collection is started for some metrics, and graphing intervals are changed for others in order to make them easier to follow.
**Data Mart Infrastructure**

If you are using the Service Architecture, extended monitoring provides the framework and key components that enable the ETL packages to operate. Extended monitoring provides these infrastructure components:

SAS Environment Manager Data Mart
- Extended monitoring creates the tables that comprise the data mart. However, extended monitoring does not provide a mechanism for loading data into the tables. Data is loaded into the tables by the ACM or APM ETL processes.

Report Center processes and reports
- Much like with the data mart, extended monitoring creates the stored processes that produce the reports in the Report Center. However, these processes and reports remain unusable until one or more of the ETL processes is enabled and loads data into the data mart.

---

**Working with the APM ETL**

**Overview**

The APM ETL process extracts performance metric information from various SAS server logs, HTTP access logs, SAS job logs, and SAS metadata audit data and loads that information into the data mart. Custom parsers can be added to enable the ETL to process information specific to a SAS solution or application. As with other information in the data mart, you can use this information to produce predefined reports or to conduct custom analysis and reporting.

*Note:* Enabling the APM ETL process causes a separate log to be created for each spawned SAS Workspace Server. You must plan for the large number of log files that this process could create. A best practice is to create a daily archive file of the day’s log files, and then to copy the file to archive storage.

**Log Collection Process**

APM data is processed and loaded into the data mart in these steps:

1. The logs in your SAS deployment are discovered. The log discovery process runs for the first time when the APM ETL is initialized. This process scans the components in your SAS system for log files and includes the logs that it finds that are supported by the APM ETL. By default, the log discovery process runs every 15 minutes throughout each day, so any new logs created by new components in your SAS environment are discovered and included in the log collection process. You can also choose to run the log discovery process manually through a control action, which enables you to start collecting log data sooner than if you waited for the scheduled process. This discovery process improves the accuracy of the collected log data, because it reflects the SAS applications that are actually installed. The discovery process runs when the APM ETL is initialized, and runs at regular intervals after initialization is complete. You can also run the log discovery process manually at any time.
See “Manually Discovering and Collecting Logs” on page 75 for information about manual processes.

Note: SAS logs are discovered and collected only if they are in default locations. If you customize the log location, SAS Environment Manager cannot discover or collect the log.

2. The discovered logs are collected locally on the machine where they are created. The logs are stored in the landing zone directory, which is \([\text{LevelRoot}]/\text{Web/}\text{SASEnviroentManager/emi-client/LandingZone}\). By default, the logs are collected nightly, but they can be collected manually as often as every 30 minutes in order to obtain an update view of the log information.

3. The locally collected logs are collected from the local landing zone directories to a central landing zone directory, which is located on the SAS Environment Manager Enablement Kit Server. This server is the machine containing the alphabetically first SAS Application Server context that contains a SAS Workspace Server. Beginning with SAS 9.4M3, you can use SAS Deployment Agent to automatically copy the log files from the local landing zone directories to the central landing zone directory. You can configure the SAS Deployment Agent in unsecured mode, or you can use unsecured mode or NFS mounts and shares and symbolic links. Beginning with SAS 9.4M4, you can use the SAS Deployment Agent in secure mode to copy the log files. You can also set up file mounts or NFS shares to the local landing zone directories so that the central landing zone directory has access to the log files whenever they are saved to the local landing zone directories. After the logs are collected in the central landing zone directory, they are deleted from the local landing zone directories.

4. The ETL process parses the logs in the central landing zone directory, puts the information into a standard format, and archives the original log files. The data is then put into the appropriate tables in the data mart.

5. APM data in the data mart is available for analysis and reporting.

The following figure illustrates the log collection process.

Note: SAS Web Server Access logs are not monitored when HTTPS/TLS is enabled.
Manually Discovering and Collecting Logs

Follow these steps to manually run the APM ETL process to discover and collect logs:

1. Select Resources \(\Rightarrow\) Browse \(\Rightarrow\) Services. Select the APM ETL Processing entry in the table.

2. On the page for the APM ETL Processing service, select Control.

3. In the Quick Control area, select Run in the Control Action field and then click the Run icon.

You can also start the log collection process from a command line by using the master_apm_etl script. You can automate this process by using a job scheduler to run the script. See “Running the APM ETL Processes By Using master_apm_etl” on page 107 for more information and syntax.

Generating Reports

Reports that are produced by APM display the following types of information:

- the most heavily used SAS procedures
- the top ten users of the SAS Workspace Server
- the number of times per day each user ID has accessed the SAS Metadata Server
- each instance of an authentication error or of an unauthorized login attempt
- the response time and run time for SAS stored processes

Working with ACM ETL

The ACM ETL process extracts and stores metric data that is collected by the SAS Environment Manager agents into the data mart. Storing the data in the data mart enables you to access the data for a longer period of time than if it was stored only in the SAS Environment Manager web application.

ACM data is processed and loaded into the data mart in these steps:

1. Metric data is collected from the SAS Environment Manager agents and sent to the SAS Environment Manager database.

2. At specified intervals, the ACM ETL process runs. The process copies data from the database, standardizes the data, and loads the data into the data mart.

3. ACM data in the data mart is available for analysis and reporting.

The Report Center contains reports that are produced by ACM that display the following types of information:

- response time for SAS HTTP web services
- workload, CPU usage, and memory usage for each platform in your environment
- usage and response information for file mounts
- total number of clients per minute on the SAS Metadata Server machine
Creating a Federated Data Mart

A federated data mart enables you to use the data mart capabilities to perform analysis and monitoring for multiple deployments in your organization. You can consolidate ACM data from the data marts of multiple systems into one location, which enables you to compare system performance and availability across your organization. Each deployment still retains its own data mart, but the federated data mart enables you to analyze data across deployments. For example, you could set up a federated data mart to contain data from DEV/TEST/PROD deployments, or from multiple departmental deployments. The federated data mart is available following SAS 9.4M3.

Note: APM metric data is not included in a federated data mart.

To create a federated data mart, follow these steps:

1. Verify that SAS Environment Manager is running on all of the deployments that you want to include in the federated data mart.

2. Configure SAS Environment Management Service Architecture on all of the systems, and ensure that the ACM ETL is enabled. This step ensures that each deployment includes a data mart containing ACM data. Before attempting to implement the federated data mart, you should allow the data mart to operate on each deployment for several weeks in order to verify that the data marts are operating as expected and to understand the data that is being collected.

3. Choose which deployment will host the federated data mart and which deployments will be contributors to the data mart. On the host deployment, run the fedInit script to create the directories and structure needed for the federated data mart. See “Initializing a Federated Data Mart By Using fedInit” on page 112. The script also creates a server resource on the host deployment named Federated Data Mart. You can monitor this server resource as you would any other resource in SAS Environment Manager. See “Monitoring Resources” on page 41.

4. To populate the federated data mart, perform a full export of all the data in the data marts of the contributor deployments. This ensures that you have a current view of all of the data in the data marts.

   To perform a full export, run the `bin/exportDataMart` script on each deployment. This script creates a .tar file in the `Datamart/Exports` directory. See “Exporting Data Mart Contents By Using exportDataMart” on page 112.

5. To enable the exported files to be imported by the host deployment, move all export files that you want to import to the `emi-framework/LandingZone/FedDataMart` directory on the host deployment.

6. When the exported data has been copied to the directory on the host deployment, import the data into the federated data mart. To import the data, run either the `bin/updateFedDataMart` script or run the Load Data control action.

   The import process extracts data from the .tar files and transform the data so that the data from all of the contributor deployments can be merged. Although the data is merged, the federated data mart retains information that identifies the contributor deployments and adjust identifiers so that they remain unique across the deployments. After the data is imported, the federated data mart contains merged data for each contributor system.
7. Whenever you want to export additional data into the Federated Data Mart, use the Export Data Mart control action or run the `bin/exportDataMart` script on a contributor deployment.

8. You can also set up an automatic export of data from a contributor deployment. To set up automatic export, modify the `sasev.properties` file (found in the Service Architecture root directory) and set the `datamart.export.withETL` property to `true`. When this property is set to `true`, the ACM ETL script automatically creates an export file with the latest data. This export file contains only the updates since the last time the ETL job was run. It is important to note the difference between this file and the export file that is generated by the manual export process. The manual export process creates an export file containing all of the data in the contributor deployment. The federated data mart's update processing automatically detects and handles either a full export or an incremental export.

Regardless of whether you use a manual, full export or the automatic, incremental export, you must move the export files to the proper location on the federated data mart host machine. The automatic export process handles only the export process, and does not handle the movement of the export file from the individual contributor deployments. It also does not automate the loading of the new data into the federated data mart.

Because the automatic export contains only incremental data, the export files that it creates are smaller than those generated by the manual export process. On the other hand, many more files are generated. In addition, the files are generated every time that the ACM ETL process runs (typically nightly), rather than only when you are ready to run the Import Data process on the federated data mart host machine.

---

**Working with the Solution Kits Infrastructure**

SAS solutions can provide solution kits, which include their own set of log parsers, resource definitions, tuned metrics, and reports. A solution kit, developed and delivered by SAS, enables you to easily add data to the data mart for SAS solutions as you add them to your environment. The ETL framework of the kits provides the infrastructure required for the solution kits to work seamlessly with SAS Environment Manager and the data mart. Solution kits ensure that the data collected by SAS Environment Manager for a specific SAS solution is available from the data mart.

---

**Feeding Data from the Data Mart into SAS Visual Analytics**

You can enable a nightly transfer of selected tables from the SAS Environment Manager data mart to the SAS Visual Analytics administrative reporting drop zone. If autoload is enabled for the associated LASR library, the copied tables are loaded to a SAS LASR Analytic Server. For more information see *SAS Visual Analytics: Administration Guide*

*Note:* Although data tables that are copied to the drop zone can be loaded into SAS Visual Analytics, predefined reports and analytic processing for the data might not be available in SAS Visual Analytics.
You should ensure that the SAS Visual Analytics drop zone location is accessible from the SAS Environment Manager Enablement Kit Server machine, which is the location where the ETL processes run. Follow these steps:

1. Log on to SAS Management Console.
2. Using the Data Library Manager plug-in, locate the entry for the Environment Manager Data Mart LASR library.
3. Right-click on the library, and select Properties.
4. In the Extended Attributes tab, note the value of the VA.AutoLoad.Location attribute. This is the default path that the SAS Environment Manager ETL processes will use when copying data from the data mart. Verify that this location is accessible from both the SAS Environment Manager Enablement Kit Server machine and from the SAS Visual Analytics server machine.

If you specify a new location for the VA.AutoLoad.Location attribute, ensure that the directory contains the subdirectories Append, Formats, Logs, and Unload.

To enable the data feed for SAS Visual Analytics, follow these steps:

1. On the machine on which SAS Environment Manager is installed, change to the `<Levelroot>/Web/SASEnvironmentManager/emi-framework/bin` (UNIX) or `<Levelroot>\Web\SASEnvironmentManager\emi-framework\bin` (Windows) directory.
2. From a command line, issue the command `emi_init.sh -vafeed ON` (UNIX) or `emi_init.bat -vafeed ON` (Windows).

If SAS Visual Analytics and SAS Environment Manager are not running on the same machine, you must modify the `SAS_Config/Lev1/Web/SASEnvironmentManager/emi-framework/sasev.properties` file to identify the target location for the data tables that are to be loaded into SAS Visual Analytics. Modify the `vafeed.destDir=` property to specify the location on the SAS Environment Manager machine where the data tables should be copied. The target directory that you specify must have a subdirectory named `/Formats`. You must then move the data tables from the SAS Environment Manager machine to the SAS Visual Analytics machine. You can use techniques such as FTP transfer or NFS mounts to move the data tables.

If the machines that run SAS Visual Analytics and SAS Environment Manager are also using different operating systems, you must use PROC CPORT to create a machine-independent export file of the data and then use PROC CIMPORT to load the data into the proper format for the SAS Visual Analytics machine. The basic procedure consists of these steps:

1. The nightly ETL processes copy the data from SAS Environment Manager to the location specified by the vafeed.destDir property.
2. Run SAS code containing PROC CPORT statements to create CPT files for the data sets and catalog that are to be loaded into SAS Visual Analytics.
3. Move the CPT files to the SAS Visual Analytics machine.
4. Run SAS code containing PROC CIMPORT statements to read the CPT files and create the data sets and catalog on the SAS Visual Analytics machine.
5. Move the data sets and catalog to the drop zone.

The tables copied from the data mart to the drop zone are suitable for analysis and reporting with SAS Visual Analytics. The specific set of tables and their structure might
change over time and in future releases. By default, the following are the tables that are copied:

**ACM.FILEMOUNTS**
metric data for the file mounts in your environment

**ACM.HOSTPLATFORMS**
metrics for the platform-level resource monitored by SAS Environment Manager that correspond to operating systems

**ACM.HTTPCHECKS**
metric data for the HTTP response-checking resources created by SAS Environment Manager Extended Monitoring

**ACM.SASAPPSERVERS**
metric data for the SAS application servers

**ACM.SASLOGICALSERVERS**
metric data for the SAS logical servers

**ACM.METADATASVRS**
metric data for the SAS Metadata Servers

**ACM.NETWORKINTERFACE**
metric data for the network interfaces

**ACM.TCSERVERMGRS**
metric data for individual SAS web applications

**ACM.WEBAPPSERVER**
metric data for SAS Web Application Server instances

**ACM.WIPDATADB**
metric data for the databases within the Web Infrastructure Platform Data Server

**KITS.EMI_INFO**
metrics on the performance of SAS Environment Manager ETL processes

For information about the contents of these tables, see Appendix 4, “Data Mart Table Reference,” on page 147.
Chapter 9
Initializing and Enabling the Service Architecture

Overview and Prerequisites

The process of initializing and configuring the service architecture consists of two main processes:

1. Validating the service architecture framework and initializing extended monitoring
2. Enabling the ACM, kit, and APM ETL framework, and initializing the APM ETL framework

Note: Depending on your environment, the ETL processes might collect large amounts of data and could fill up the disk where the data mart is located. As a best practice, you should configure email notifications for the SASConfig Disk Use % > 95 alert for the SAS Config Local Directory 9.4 server resource. See “Notifying Users of an Alert” on page 58 for information. You should also monitor the size of the data mart directory after ten days of use, and multiply that value by six. The resulting value is an approximation of the data mart size during the 60-day rollover period, and it can help you estimate if you have enough disk space for the potential growth of the data mart. You can also reduce the number of days worth of data that is retained by modifying the EnvMgr Enablement Kit 2.2 properties in SAS Management Console. The default is 60 days. See “Changing ETL Configuration Settings” on page 90.
In this chapter, `<levelroot>` refers to the fully qualified location of the LevN directory within your SAS configuration directory (for example, `/opt/SAS/Config/Lev1`).

Before you begin initializing and enabling the service architecture, ensure the following:

- Ensure that you know the ID and password of the SAS installer account. These are external host credentials.
- Ensure that you know the path to your SAS Environment Manager Solution Architecture framework directory. This directory is on the machine on which you deploy the service architecture framework, which is referred to as the SAS Environment Manager Enablement Kit Server. This machine is the machine containing the alphabetically first SAS Application Server context that contains a SAS Workspace Server.
- The framework is deployed in the `<levelroot>/Web/SASEnvironmentManager/emi-framework` directory.
- Ensure that your SAS deployment contains a functioning Stored Process server. The server must be defined on the SAS Environment Manager Enablement Kit Server, and it cannot be load balanced across multiple machines.
- Ensure that you know the name of your SAS Application Server contexts on all of the hosts in your deployment.
- Ensure that you know the SAS administration ID and password (for example, `sasadm@saspw`).
- If you are deploying on multiple machines, ensure that the APM ETL has remote access (through NFS mounts or Windows shares) to the `<levelroot>` directory on each of the remote machines.
- If you have configured your SAS deployment to use certificates, SSL, and the HTTPS protocol, rather than the HTTP protocol, confirm that you can use the HTTPS protocol to access SAS web applications.
- If you are using AIX, add the `sasevs@saspw` account to the SAS Environment Managers Super User Role. Follow these steps:
  1. Select Manage ⇒ List Roles.
  2. Select Super User Role.
  3. In the Assigned Users area, select Add to List.
  4. Select the check box for `sasevs@saspw` in the Users table, click the plus (+) arrow, and then click OK.
- If SAS Environment Manager is installed on Windows, ensure that performance counters are enabled. Follow these steps:
  1. Locate the registry key `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\PerfProc\Performance`.
  2. Locate the option Disable Performance Counters and ensure that it has a value of 0 (enabled). Change the value if it is not 0.
    
    **Note:** If the Disable Performance Counters option does not exist, then performance counters are enabled and no change is required.
  3. If you changed the value, restart the Windows server.
Overview of Extended Monitoring Initialization

When you initialize extended monitoring, two main categories of actions are performed:

- initialization of predefined alerts, groups, and configurations to enable you to start using SAS Environment Manager without having to go through a manual setup process
- initialization of the SAS Environment Manager Data Mart

The initialization process performs both sets of actions. If you are not planning to use the data mart, initializing its infrastructure does not impact performance of SAS Environment Manager.

The following setup tasks are performed during the initialization of SAS Environment Manager:

configuration of discovered resources
- Resources such as platforms and servers that were added to the SAS Environment Manager inventory during installation are configured so that they can begin collecting metric data.

creation of compatible groups and mixed groups
- A set of standard resource groups is created and then populated by resources that were discovered in your environment. After the groups are created, the groups are automatically updated as part of ETL processing.

adjustment of monitoring metrics
- The metrics provided by SAS Environment Manager are optimized for monitoring of a SAS environment. The optimization process includes turning data collection on or off for certain metrics and changing sampling intervals for others.

creation of HTTP checks of SAS web applications
- These HTTP checks are services that check SAS web applications such as the stored process server to make sure they are operational. The check also generates data such as the length of time the query took.

creation of alerts
- The process creates a collection of alerts that signal common operational problems in a SAS environment, such as hardware problems, server issues, and storage issues.

The following tasks are performed for the data mart:

preparation of the data mart
- The initialization process creates infrastructure data sets for the data mart.

loading of the Report Center
- The initialization process loads the stored processes for the Report Center reports. However, unless one or more of the ETL packages are enabled and initialized, the data required to produce the reports is not present and the Report Center is not available from SAS Environment Manager.

creation of associated metadata objects
- The initialization process imports SAS package files to the SAS Metadata Server that contain ACTs and user groups to support the data mart.
SAS Environment Manager Extended Monitoring Steps

To initialize extended monitoring, follow these steps:

1. If you are using Windows, open a command prompt in the Run as administrator mode.

2. On the Enablement Kit Server machine, change to the `<levelroot>/Web/SASEnvironmentManager/emi-framework/bin` directory.

   **Note:** Directory paths that are provided in this section are UNIX paths, which use a forward slash (/). In Windows environments, replace the forward slash with a backward slash (\).

3. Validate the framework by issuing the command `./validate.sh --level 2` (UNIX) or `validate.bat --level 2` (Windows).

4. If you are using UNIX, set the DISPLAY environment variable to an X11 server.

5. From a command line, issue the command `./emi_init.sh -i` (UNIX) or `emi_init.bat -i` (Windows). Review the log messages to ensure that the command executed without errors.

6. Restart the SAS Object Spawners by issuing the command `<levelroot>/ObjectSpawner/ObjectSpawner.sh restart` (UNIX) or `<levelroot>/ObjectSpawner/ObjectSpawner.bat restart` (Windows).

7. From a command line, issue the command `./validate.sh --level 3` (UNIX) or `validate.bat --level 3` (Windows). This command verifies that the framework was successfully initialized.

8. Review the messages produced by the validation script for errors. If you make any changes to your deployment in order to correct errors, issue the command `./emi_init.sh -i-f` (UNIX) or `emi_init.bat -i-f` (Windows) and rerun the `./validate.sh --level 3` or `validate.bat --level 3` command.

Detailed information about the initialization is contained in the log file `emi-framework/Logs/emiInit.<datetime>.log`

---

Enabling and Initializing the APM ETL

**Overview of the APM ETL Enablement and Initialization Process**

When you enable and initialize the APM ETL package, the following actions are performed:

- **Enablement of Application Response Measurement (ARM)**
  The SAS Application server environment is modified to enable ARM.

- **Activation of loggers and appenders**
  SAS logging facility loggers and log appenders are activated to support the ARM-enabled SASApp deployment.

One of the SAS resources for which logging is enabled is the SAS Workspace Server. Logging of this server causes a separate log file to be created in the `Lev1/SASApp/WorkspaceServer/PerfLogs` directory for each spawned SAS Workspace Server.

You must be aware of the potential for the large number of log files that can be created...
in this directory. This situation can occur if you have a large number of SAS Enterprise Guide or SAS Data Integration Studio users, because each session for those applications generates a separate log file. You can create a daily archive of the logs in a .zip or .tar file and then copy the daily archive to another storage location. This process enables you to manage the large number of log files while maintaining IT best practices for retaining usage logs.

SAS Workspace Servers are typically configured to run under the client’s user identity. In order for logging of SAS Workspace Servers to function correctly, you must ensure that the permissions are specified correctly on the log directories. All users of the SAS Workspace Server and all SAS Environment Manager users that run the APM ETL processes must have Read, Write, and Execute permissions for the `/SAS/Config/Lev1/SASApp/WorkspaceServer/Logs` and `/SAS/Config/Lev1/SASApp/WorkspaceServer/PerfLogs` directories.

**CAUTION:**
The APM log discovery and configuration process overwrite any values you specify for the REQUEST INIT or REQUEST TERM statements for SAS servers (such as SAS Stored Process Servers or SAS Workspace Servers). The initialization program is set to `SASEnvironment/SASMacro/apm_request_init.sas`, and the termination program is set to `SASEnvironment/SASMacro/apm_request_term.sas`. These programs are required so that ARM events can be logged and parsed by the APM ETL process. These values are checked and, if necessary, reset to the required values each time that the log discovery process runs.

After the APM ETL is enabled and initialized, the ETL process begins extracting data from SAS logs and loading that data into the data mart so that the applicable stored processes and stored process reports have data to work with. Data is extracted from the SAS logs only when the logs roll over (usually after 1 AM). You must wait until after 1 AM before data appears in Service Architecture metrics and reports.

### Using APM ETL with a Common Directory for Logging

The APM log discovery, collection, and ETL processing is designed to work with the standard log directory hierarchy, in which the log for each SAS component (such as the SAS Metadata Server and SAS Object Spawner) is stored in a separate directory. However, if you selected the **Create Common Directories** option when installing SAS, all logs are stored in a single common logging directory. If you use a common logging directory, you must create symbolic links for each of the component logging directories to the common logging directory before enabling and initializing APM ETL.

Follow these steps:

1. Log on to your system as the SAS install user.
2. Locate your common logging directory. The typical location is `<SAS_config>/Lev1/Logs`. For example, a typical location on UNIX is `/usr/local/sas/Config/Lev1/Logs`, and a typical location on Windows is `c:\SAS\Config\Lev1\Logs`.
3. Use the `ln` command (UNIX) or the `mklink` command (Windows) to create symbolic links from each of the component logging directories to the common logging directory. Use these commands:
   
   **UNIX**
   ```
   ln -s common_logging_directory component_logging_directory
   ```
   
   **Windows**
   ```
   mklink /d component_logging_directory common_logging_directory
   ```
Create a symbolic link for each of these component logging directories to the common logging directory. Note that some of these directories might not exist in your environment, depending on the products installed and the deployment options that were specified.

Main `<levelroot>` directory
- `<levelroot>/ConnectSpawner/Logs`
- `<levelroot>/ConnectSpawner/AuditLogs`
- `<levelroot>/ObjectSpawner/AuditLogs`
- `<levelroot>/Web/Logs`

MetadataServer context (default is SASMeta)
- `<levelroot>/SASMeta/MetadataServer/AuditLogs`

Each application context (default is SASApp)
- `<levelroot>/SASApp/BatchServer/PerfLogs`
- `<levelroot>/SASApp/ConnectServer/Logs`
- `<levelroot>/SASApp/ConnectServer/PerfLogs`
- `<levelroot>/SASApp/GridServer/Logs`
- `<levelroot>/SASApp/GridServer/PerfLogs`
- `<levelroot>/SASApp/OLAPServer/AuditLogs`
- `<levelroot>/SASApp/OLAPServer/Logs`
- `<levelroot>/SASApp/OLAPServer/PerfLogs`
- `<levelroot>/SASApp/PooledWorkspaceServer/Logs`
- `<levelroot>/SASApp/PooledWorkspaceServer/PerfLogs`
- `<levelroot>/SASApp/StoredProcessServer/Logs`
- `<levelroot>/SASApp/StoredProcessServer/PerfLogs`
- `<levelroot>/SASApp/WorkspaceServer/Logs`
- `<levelroot>/SASApp/WorkspaceServer/PerfLogs`

For example, these are the commands that you can use to create the symbolic links for the SAS Metadata Server audit logs:

**UNIX**
```
ln -s /opt/sas/config/Lev1/Logs
/opt/sas/config/Lev1/SASMeta/MetadataServer/AuditLogs
```

**Windows**
```
mklink /d c:\SAS\Config\Lev1\SASMeta\MetadataServer\AuditLogs
c:\SAS\Config\Lev1\Logs
```

**APM ETL Enablement and Initialization Steps**

To enable and initialize APM ETL:

1. Ensure that extended monitoring has been initialized.
2. Back up your configuration files and the SAS metadata repository.
3. On the Enablement Kit Server machine, change to the `<levelroot>/Web/SASEnvironmentManager/emi-framework/bin` directory.

4. Verify that the SAS Metadata Server is running, and then run the command `. / apm_init.sh` (UNIX) or `apm_init.bat` (Windows).

5. Check the logs under the `emi-framework/Logs` directory for errors.

6. The `apm_init` command issues a series of control actions so that each SAS Environment Manager agent runs the log discovery and configures APM processes on each agent’s local machine. If an error message from the `apm_init` command indicates that a control action failed, check the most recent log, which is in the SASEnvironmentManager/emi-client/Logs directory for errors. The logs are named `logDiscovery_[datetime].log`.

7. On each machine in your deployment, ensure that no other users are working in the SAS server environment, and then restart the SAS Metadata Server, SAS Object Spawner, SAS OLAP Server, and Connect Server. Because you should not restart the SAS Environment Manager Server, do not issue the `sas.servers restart` command.

   On UNIX, issue these commands for each SAS Application Server context:
   ```bash
   <levelroot>/SASMeta/MetadataServer/MetadataServer.sh restart
   <levelroot>/ObjectSpawner/ObjectSpawner.sh restart
   <levelroot>/ConnectSpawner/ConnectSpawner.sh restart
   <levelroot>/SASApp/OLAPServer/OLAPServer.sh restart
   ```

   On Windows, the servers are usually deployed as Windows services. Follow these steps to restart the servers:
   
a. Run Windows using an administrative user ID, and then select **Windows Start ➔ Control Panel ➔ Administrative Tools ➔ Services**. The Services window appears.

   b. Right-click **SAS [Config-Lev1] SASMeta – Metadata Server** and select **Restart** from the pop-up menu. A dialog box appears, warning you that other services will also be restarted. Select **Yes** in this dialog box, which automatically restarts the OLAP Server, the connect spawner, and the object spawner.

8. After the configuration commands have completed, sign on to SAS Management Console. Using the Server Manager plug-in, validate the SAS Metadata Server and the other Enterprise BI servers. The servers generate initial entries in the associated `/Logs` or `/PerfLogs` directories. Log off from SAS Management Console after you validate the servers.

9. On the service architecture framework machine, change to the `[levelroot]/Web/SASEnvironmentManager/emi-framework/bin` directory.

10. From a command line, issue the command `. /emi_init.sh –enable APM` (UNIX) or `emi_init.bat –enable APM` (Windows) to enable only the APM ETL. Issue the command `. /emi_init.sh –enable ALL` (UNIX) or `emi_init.bat –enable ALL` (Windows) if you want to enable the APM, ACM, and kits ETLs.

11. From a command line, issue the command `. /validate.sh --level 3` (UNIX) or `validate.bat --level 3` (Windows) to validate the initialization. Check the logs and messages for errors.
Enabling ACM ETL

When you enable the ACM ETL, the ETL processes begin extracting metric data from the SAS Environment Manager agent and loading the data into the SAS Environment Manager Data Mart.

To enable ACM ETL:

1. On the Enablement Kit Server machine, change to the `<levelroot>/Web/SASEnvironmentManager/emi-framework/bin` directory.
2. From a command line, issue the command `. /emi_init.sh --enable ACM` (UNIX) or `emi_init.bat --enable ACM` (Windows).
3. From a command line, issue the command `./validate.sh --level 3` (UNIX) or `validate.bat --level 3` (Windows) to validate the initialization. Check the logs and messages for errors.

Configure Data Collection for SAS Jobs Reports

The Report Center provides reports that can provide information about the SAS jobs that run on your Workspace Server. If you want to enable this feature, you must modify the logging configuration file for your SAS Workspace Server to store the log file in a specified directory. Follow these steps:

1. Ensure that all users of the SAS Workspace Server have Read, Write, and Execute permissions for the `SAS-configuration-directory\LevN\Web\SASEnvironmentManager\emi-client\KitLogs\SASJobs\` directory.
2. Back up the file `logconfig.apm.xml`, which is in your `WorkspaceServer` directory.
3. Add these lines to the `logconfig.apm.xml` file. Replace `SAS-configuration-directory` and `LevN` with appropriate values for your organization.

For Windows:

```xml
<appender class="RollingFileAppender" name="SASJobAppender">
    <param name="Append" value="false"/>
    <param name="Unique" value="true"/>
    <param name="ImmediateFlush" value="true"/>
    <rollingPolicy class="TimeBasedRollingPolicy">
        <param name="FileNamePattern" value="SAS-configuration-directory\LevN\Web\SASEnvironmentManager\emi-client\KitLogs\SASJobs\SASApp_WorkspaceServer_SASLog_%username%_%d_%hostname%_%pid%.log"/>
    </rollingPolicy>
    <layout>
        <param name="ConversionPattern" value="%m"/>
    </layout>
</appender>
```

For UNIX:

```xml
<appender class="RollingFileAppender" name="SASJobAppender">
    <param name="Append" value="false"/>
```
4. Add a logger definition to the *logconfig.apm.xml* file. Add these lines:

```xml
<logger name="App" immutability="true">
  <level value="Info"/>
  <appender-ref ref="SASJobAppender"/>
</logger>
```

5. Save and close the *logconfig.apm.xml* file.

6. The updated log configuration file will take effect the next time a Workspace Server starts.
Changing ETL Configuration Settings

After you have initialized and enabled the Service Architecture, you can change some of the default configuration settings for the ETL processes. To change the settings, follow these steps:

1. Log on to SAS Management Console.
2. On the Plug-ins tab, select Application Management ➔ Configuration Manager.
3. Right-click EnvMgr Enablement Kit 2.2 and select Properties.
4. In the EnvMgr Enablement Kit 2.2 Properties dialog box, click the Settings tab.
5. In the navigation area for the Settings tab, select Data Mart ETL Setting. You can change the following configuration properties:

   ACM Number of Days of Raw Records
   specifies the number of days that data collected by the ACM ETL is retained in the raw library. This library contains metric data that has been extracted from the SAS Environment Manager database and has undergone limited transformation. This data is used to provide a pool of historical data to create reporting data sets. The tables in this library are not available to users. They are used internally only by the service architecture as part of the ACM ETL process. The default value is 11 days.
   
   CAUTION:
   Do not change this value unless instructed to by SAS Technical Support.

   Number of Days of Resource Records in Data Mart
   specifies the number of days that metric data that is collected by the ETL processes is retained in the data mart libraries. The default value is 60 days.

   Number of Days of Audit Records to Retain in Data Mart
   specifies the number of days that audit data (from resource activity) that is collected by the ETL processes is retained in the data mart. Starting in SAS 9.4M5, the default value is 60 days. The default value is 365 days for other versions of SAS.

   Delay Threshold
   specifies the number of minutes that the ETL process should subtract from the current time to calculate the end of the data extraction time period. For example, if the ACM ETL process runs at 1:00 AM and the Delay Threshold is set to 7, the ETL process queries for all data between the last time it ran and 12:53 AM. This property accounts for data that might be lost because of communication delays between the SAS Environment Manager agent and server.
   
   CAUTION:
   Do not change this value unless instructed to by SAS Technical Support.

   Datamart Time Zone
   specifies the time zone in which the data was produced. The default value specifies to use the current setting for the SAS option.

6. Click OK to save your changes. The new settings are applied the next time the ETL process runs.
Chapter 10
Using the Report Center

What is the Report Center? ................................................. 91
Use the Report Center .................................................. 92
Change Report Parameters ........................................... 93
Finding the Reports You Need ....................................... 93
  Data Mart Reports .................................................... 93
  Metadata Inventory Reports ....................................... 94
  ACM Reports ........................................................ 94
  ARM Reports ......................................................... 94
  Metadata Audit Reports ............................................ 94
  SAS Environment Manager Service Architecture Framework
    ETL Process Reports ................................................ 95
    Event Reports ..................................................... 95
    Solution Kit Reports ............................................. 95
    Log File Job Reports ............................................. 95
    Sample Reports .................................................. 96

Adding Reports to the Report Center ............................... 96
  Creating a New Report ............................................. 96
  Copying and Modifying an Existing Report ..................... 97

Running Reports in Batch ............................................ 97

Deprecated Reports .................................................. 98

What is the Report Center?

The Report Center is a collection of stored processes that produce reports from data in the SAS Environment Manager Data Mart. These reports are created to provide a view of the performance and status of your SAS environment and its resources and are created to be representative samples of the types of reports that can be produced by the available metric data. You can also create your own reports to meet your individual requirements.

The stored processes in the Report Center are created when you initialize SAS Environment Manager Extended Monitoring. However, the stored processes operate only on data that was stored in the SAS Environment Manager Data Mart by the APM or ACM ETL processes. Unless you initialize and enable one of those packages, no reports are produced.
Note: The reports in the Report Center are provided as a best efforts resource to assist in the troubleshooting and performance tuning of your SAS deployment. However, many other factors might influence your user experience, some of which are beyond the monitoring capabilities of SAS Environment Manager. For additional assistance in performance tuning and hardware configuration references, please contact the SAS Professional Services Division.

To access the Report Center, select Analyze ⇒ Report Center. The Report Center is displayed in a separate window or tab in your browser. If your browser blocks pop-up windows, you must disable pop-up blocking for SAS Environment Manager. When the Report Center window appears, it is titled Stored Processes.

Use the Report Center

When you open the Report Center, you see three main folders:

**Products**
- contains most of the stored processes to generate reports based on APM or ACM ETL processes

**System**
- Contains stored processes for ad hoc reports

**User Folders**
- Contains any custom reports that you have created and saved in your user folder

To create a report, expand the folders until you find the stored process that you want to run, and then click on the stored process entry. The viewing pane of the Report Center window displays prompts for the information in the report. The Report Center uses the SAS Stored Process web application, so the window title is Stored Processes.

Use each prompt to select the information required to produce the report. Select the categories of inputs on the left side of the display area to fully customize the report.
The stored processes are based on standard procedures from Base SAS and ODS. Where applicable, the procedures used are indicated on the stored process prompts. Refer to the appropriate Base SAS or ODS documentation for information about specific prompts.

When you have specified all of the information required to produce the report, click **Run** to produce the report. An error message appears if the information that you specified cannot produce a valid report.

**Note:** Some reports might be blank, even though SAS Environment Manager is working properly. If data has not been generated that a report depends on, then the report will be blank. For example, a report that displays metadata activity will contain data only if there has been any activity on the SAS Metadata Server. If a report is blank, you can verify that the report is being generated properly by performing an activity that will generate data for the report. For example, to verify a metadata activity report, you could perform an action that would cause a metadata change, such as creating a user definition in metadata.

---

**Change Report Parameters**

You can change global settings (such as font, graph style, and legend options) for the reports in the Report Center.

**CAUTION:**
Be careful when changing these parameters. Specifying incorrect values might cause reports to fail. Make a note of any value that you change so that you can return to the original value in case of problems.

To change the report parameters:

1. Log on to SAS Management Console.
2. On the **Plug-ins** tab, select **Application Management** ⇒ **Configuration Manager**.
3. Right-click **EnvMgr Enablement Kit 2.1** and select **Properties**.
4. In the EnvMgr Enablement Kit 2.1 Properties dialog box, click the **Settings** tab.
5. Use the pages on the **Settings** tab to change the parameters for the Report Center reports. Some of the settings apply to the SAS Environment Manager Data Mart, rather than only to the reports. Any change that you make in the parameters are applied to all of the reports in the Report Center the next time they are run.
6. Click **OK** when you have finished making changes.

---

**Finding the Reports You Need**

**Data Mart Reports**

These stored processes generate reports that display information about the content of the SAS Environment Manager Data Mart tables, the resources that support the data mart, and the alerts that are defined in the data mart. Some example reports include:

- All Alert Definitions
- ACM Data Mart Server Resources
• Data Mart Proc Contents Full Listing

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Dynamic Reports ⇒ Datamart.

**Metadata Inventory Reports**

These stored processes generate reports that display information about the metadata that is stored on the SAS Metadata Server. Some example reports include:

- Groups Roles and Users
- Metadata Content
- Server Properties

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Dynamic Reports ⇒ Metadata Inventory.

**ACM Reports**

These stored processes generate reports that display and chart detailed metrics for the computing resources in your environment. They are generated by data from ACM ETL processes. Some example reports include:

- File Mounts Summary Report
- Metadata Server Total Clients per Minute
- Platform Workload 1 Min Average

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ ACM Reports.

**ARM Reports**

These stored processes generate reports that display and chart detailed metrics and information for SAS jobs and processes. They are generated by data from ARM ETL processes. Some example reports include:

- Proc Usage
- Server Usage By User
- Workspace Users By Session (Top 10)

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ ARM Performance Reports.

*Note:* In APM reports, time metrics are charted in seconds and memory and capacity metrics are charted in kilobytes.

**Metadata Audit Reports**

These stored processes generate reports that display events recorded in SAS logs. They are generated by data from APM ETL processes. Some example reports include:

- Access Activity Events
- Metadata Client Activity
• Group Changes

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ Audit Reports (Log Forensic).

**SAS Environment Manager Service Architecture Framework ETL Process Reports**

These stored processes generate reports that display information and metrics about the APM ETL processes. Some example reports include:

- ETL logfile analysis
- Logfile analysis overview report
- Proc Usage Summary

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ Service Architecture ETL Reports.

**Event Reports**

These stored processes generate reports that display information and metrics about the events that are generated and recorded in the data mart. They are generated by data from ACM ETL processes. Some example reports include:

- Event Summary Chart
- Event Summary Counts
- Log Event Triggers

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ Events and Alerts.

**Solution Kit Reports**

These stored processes generate reports that display information that was stored in the data mart by solution kits. Each kit contains its own set of stored processes and custom reports.

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Kits ⇒ solution kit name.

**Log File Job Reports**

These stored processes generate reports that display information about the jobs and processes used to analyze the SAS logs. They are generated by data from APM ETL processes. Some example reports include:

- Logfile Analysis Overview
- Logfile Summary by Logfile and Jobname
- Proc Usage Summary

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Kits ⇒ SASJobs.
**Sample Reports**

These stored processes generate samples of different types of report styles. They are generated by data from APM ETL processes. Some example reports include:

- Pie Chart CPU Usage Profile by Platform
- Daily Resource Usage Summary
- Top 5 Ranked on CPU Usage

The reports are located at Stored Processes ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ Sample Gallery.

---

**Adding Reports to the Report Center**

Although the Service Architecture provides a set of reports that cover many aspects of monitoring a SAS environment, you might want to add your own reports to the Report Center. Because the reports in the Report Center are produced by stored processes, adding a report involves creating a new stored process and registering it in metadata. You can also create your own reports by copying and modifying existing reports.

**Creating a New Report**

To create a new report in the Report Center, follow these steps:

1. Create a stored process to produce the report that you need. Refer to *SAS Stored Processes: Developer’s Guide* for information about creating a stored process.

2. Log on to SAS Management Console.

3. In the navigation area, click on the **Folders** tab.

4. In the Folders area, open the folder SAS Folders ⇒ Products ⇒ SAS Environment Manager ⇒ Custom.

5. Select **Actions** ⇒ **New** ⇒ **Stored Process** to open the **New Stored Process** wizard.

6. In the New Stored Process window, specify the name and description of the stored process. In the **Keywords** area, click **New** and specify **Environment Manager** as a new keyword in the **Keywords** dialog box. You must specify this keyword in order for the report to appear in the Report Center. Click **Next** when you are finished.

7. Select the application server that will run the stored process, select the source code repository, and specify the file that contains the stored process. Select both the **Stream** and **Package** check boxes in the **Result Capabilities** area.


9. Click **Finish** to close the wizard and register the stored process. After the stored process is registered, it is available in the Report Center.
Copying and Modifying an Existing Report

To modify a copy of an existing report, follow these steps:

1. Log on to SAS Management Console.
2. In the navigation area, click on the **Folders** tab.
3. In the Folders area, open the folder that contains the stored process for the report that you want to use. Stored processes for the Report Center reports are located in **SAS Folders ⇒ Products ⇒ SAS Environment Manager** and **SAS Folders ⇒ System ⇒ Applications ⇒ SAS Environment Manager ⇒ Ad Hoc Reporting**.
4. Select the stored process that you want to modify. Select **Edit ⇒ Copy** to copy the stored process. Open the folder **SAS Folders ⇒ Products ⇒ SAS Environment Manager ⇒ Custom** and select **Edit ⇒ Paste**.
5. Select **Actions ⇒ Rename** the copy of the stored process that you just created.
6. Select **File ⇒ Properties** to open the Properties window for the stored process. Use the fields in the window to modify the stored process and change the source code if needed.
7. When you are finished modifying the stored process, click **OK**. The new report produced by the stored process is available in the Report Center.

Running Reports in Batch

You can also run many of the Report Center reports using the `run_reports` command. Run the command `emi-framework/bin/run_reports.(bat | sh) --rptBundle report_type`. Specify one of these values for `report_type`:

- ALERT
  produces event and alert reports. See “Event Reports” on page 95 for information about these reports.

- AUDIT
  produces audit reports. See “Metadata Audit Reports” on page 94 for information about these reports.

- ARM
  produces ARM performance reports. See “ARM Reports” on page 94 for information about these reports.

- ACM
  produces ACM reports. See “ACM Reports” on page 94 for information about these reports.

- SAMPLE
  produces sample reports. See “Sample Reports” on page 96 for information about these reports.

- KITS
  produces reports for solution kits. You must have the solution kit and the corresponding SAS program installed in order to produce these reports. See “Solution Kit Reports” on page 95 for information about these reports.
ALL
  produces all reports

After the reports are generated, you can access them from the directory `emi-framework/Reports`.

These reports are provided as-is. Not all of the reports that are available in the Report Center can be produced using these commands.

---

**Deprecated Reports**

The following reports are deprecated, starting with SAS 9.4M3:

- IOM Server Call Activity
- IOM Server Client Activity
- IOM Server Summary Reports
- IOM Total Calls and Time in Calls
- IOM Total Calls vs. Time in Calls
- Metadata Client Logon

Because the data table used for these reports is also deprecated, these reports should not be used. If these reports are still present after upgrading to SAS 9.4M3, they should be deleted.
Chapter 11
Using Service Architecture to Perform Common Administration Tasks

Usage Tasks .................................................................................................................. 99
Monitoring User Activity ............................................................................................. 99
Finding User Login Errors ......................................................................................... 99
Evaluating SAS Work Directory Usage ..................................................................... 100
Evaluating Log Directory Usage .............................................................................. 100
Evaluating Memory Usage on a Host ......................................................................... 100
Evaluating Resource Usage for Hosts ....................................................................... 101
Evaluating Disk Usage on a UNIX Machine .............................................................. 101
Evaluating Disk Usage for the PostgreSQL Database ............................................. 102
Evaluating Disk Usage on a Windows Machine ......................................................... 102

Resource Health and Status Tasks ......................................................................... 102
Determining Whether a Server Has Been Down ....................................................... 102
Finding Long-Running Stored Processes ................................................................. 103

System Configuration Tasks .................................................................................... 103
Tracking Changes to Configuration Files ............................................................... 103
Identifying Inactive Users ....................................................................................... 104

Usage Tasks

Monitoring User Activity

To determine which users have accessed specific SAS Application Servers, go to Report Center ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ ARM Performance Reports ⇒ User - Server Activity By User.

To determine the number of system accesses per day, per user, go to Report Center ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ Audit Reports ⇒ Access Activity.

To determine which SAS procedures have been run and by which users, go to Report Center ⇒ Products ⇒ SAS Environment Manager ⇒ Nightly Reports ⇒ ARM Performance Reports ⇒ Resource - Procedure Usage.

Finding User Login Errors

To determine which users have been locked out or have had failed login attempts, and to see how many users are currently logged in, go to Report Center ⇒ Products ⇒ SAS
Environment Manager ⇄ Nightly Reports ⇄ Audit Reports ⇄ Authentication Errors and Logons Not Authorized.

**Evaluating SAS Work Directory Usage**

Go to Resources ⇄ Browse ⇄ Services and locate the resource *machine_name SAS Home Directory 9.4 SAS work directory*. You can also locate this resource as under the *machine_name SAS Home Directory* server resource.

The metrics for this resource are for the volume that contains the SAS work directory.

The SAS Work Directory field in the left corner of the window specifies the name of the SAS work directory on the volume being monitored.

In the charts or table of metric data, check Total kBytes Free and Use Percent for problems.

You can also use Environment Snapshot. Follow these steps:

1. Select Analyze ⇄ Environment Snapshot.
2. In the Summary Table field, select the machine name.
3. Select the Live System Queries tab, and then select the Df tab.
4. The Df Output table contains the size, amount used, amount available, and percentage used for all directories on the machine. Locate the entry for the directory used for the SAS work directory to determine the usage.

**Evaluating Log Directory Usage**

To monitor a directory containing log files, follow these steps:

1. Select Resources ⇄ Browse ⇄ Platforms and select the platform containing the log directory that you want to monitor.
2. On the page for the selected platform, select Tools Menu ⇄ New Platform Service.
3. On the New Service page, specify the name for the service and specify FileServer Directory in the Service Type field. Click OK.
4. The page for the new service automatically appears, with a warning message that the resource has not been configured. Click the Configuration Properties link in the warning message.
5. Specify the full path to the log directory in the path field. Click OK.
6. The new platform service appears in the Resource table under Services. After the service has had time to collect data, select the service to view its metrics. The Disk Usage and Regular Files metrics are useful for determining the usage of the directory.

**Evaluating Memory Usage on a Host**

To determine the memory usage (including total memory, free memory, and swap space usage) for a host in a deployment, select Resources ⇄ Browse ⇄ Platforms and select the platform whose memory you want to check.

On the page for the platform, the RAM field (in the upper right) specifies the total memory for the host.
Click on **Metric Data** to view the table of metrics for the host. Use these metrics to evaluate memory usage for the host:

- Total Memory (this value will match the value of the **RAM** field, although **RAM** is specified in MB and Total Memory in GB)
- Used Memory
- Used Memory (−buffers/cache)
- Percent Used Memory
- Percent Free Memory

*Note:* Buffer and cached memory is not included in evaluations of available free memory.

Use these metrics to evaluate swap space usage:

- Swap Free
- Percent Swap Free
- Percent Swap used

Click on **Indicators** to view these metrics in chart form. The charts are useful for evaluating changes in memory usage over time. If the chart for one or more of the metrics is not displayed, select the **Problem Metrics** field and change the selection to **All Metrics**.

### Evaluating Resource Usage for Hosts

To determine CPU and I/O usage for a host in a deployment, select **Resources ➔ Browse ➔ Platforms** and select the platform whose resources you want to check.

On the page for the platform, the **CPU Speed** field (in the upper left) specifies the number and speed of the processors on the machine.

Click on **Metric Data** to view the table of metrics for the host. Use these metrics to evaluate CPU usage for the host:

- CPU Usage
- CPU Wait
- User CPU
- CPU Idle
- CPU IRQ

Use the File System Read/Writes per Minute metric to evaluate I/O performance over time.

*Note:* I/O reporting is not available for GPFS on AIX systems.

Click on **Indicators** to view these metrics in chart form. The charts are useful for evaluating changes in memory usage over time. If the chart for one or more of the metrics is not displayed, select the **Problem Metrics** field and change the selection to **All Metrics**.

### Evaluating Disk Usage on a UNIX Machine

To determine usage for a file mount on a UNIX machine, follow these steps:

1. Select **Resources ➔ Browse ➔ Services**.
2. Select **FileServer Mount** in the **All Service Types** field and click the arrow at the end of the search bar.
3. Select the file mount that you want to view.
4. Use these metrics to evaluate usage for the file mount:
   - Capacity
   - Total Bytes Used
   - Use Percent

**Evaluating Disk Usage for thepostgresql Database**

You might want to check the amount of disk space used by the entire Postgres database or by individual databases. The ones that are of the most interest are SharedServices (which is the web interface platform database) and EVManager (which is the SAS Environment Manager database).

*Note:* PostgreSQL metrics cannot be collected unless you supply a user ID and password for the postgresQL resource.

To check the space used by a postgresQL database, select **Resources \ Browse \ Servers**. Select the server resource `machine_name PostgreSQL 9.x localhost:9432` in the table.

In the Services area, select the entry for the database that you want to view. Use the Data Space Used metric to evaluate the amount of space used by the database.

---

**Evaluating Disk Usage on a Windows Machine**

To determine usage on a Windows machine, follow these steps:

1. Select **Resources \ Browse \ Platforms**.
2. Select the Windows machine whose disk usage you want to view.
3. In the page for the selected machine, select a **File System (drive:) local/NTFS** entry in the **Platform Services Health** area.
4. Use these metrics to evaluate disk usage:
   - Capacity
   - Total Bytes Free
   - Use Percent

---

**Resource Health and Status Tasks**

**Determining Whether a Server Has Been Down**

To determine whether a server has been down, go to **Resources \ Browse \ Servers** and select the server whose availability you want to check.

On the page for the server, an availability bar is displayed above the metric charts. The availability bar displays a color-coded dot that represents the availability during a time
slice. The length of each time slice depends on the display range that you select (for example, if you display the past eight hours of data, each dot corresponds to approximately eight minutes). The percentage of time that the resource was available is displayed at the end of the availability bar.

The dots are color-coded using the following format:

- **Green**  
  100% availability

- **Yellow**  
  Partial availability; between 0% and 100%

- **Red**  
  0% availability

An availability bar such as the one in the following figure shows that the resource fluctuated between being available, partially available, and unavailable over the most recent time slices.

By default, the availability bar displays information for the past eight hours. To change the display range for the availability bar (as well as the metric charts), select new values in the **Metric Display Range** fields. You can select display ranges from four minutes to 120 days.

You can use this same process to check the availability of any resource.

### Finding Long-Running Stored Processes

To find stored processes that have been running for a long time, go to **Report Center** ➔ **Products** ➔ **SAS Environment Manager** ➔ **Nightly Reports** ➔ **ARM Performance Reports** ➔ **Stored Process Daily Job Runtimes**.

You can also use this report to evaluate the performance of stored processes.

### System Configuration Tasks

#### Tracking Changes to Configuration Files

You can use SAS Environment Manager to track changes to configuration files for a resource. However, configuration file tracking is not enabled by default. To turn on configuration file tracking for a resource, follow these steps:

1. Select **Resources** ➔ **Browse** ➔ **Platforms** or **Servers**.
2. Select the resource whose changes in configuration files you want to track.
3. On the page for the resource, select **Edit** in the **Configuration Properties** area.
4. On the Configuration Properties page, select the `resource_type.config_track.enable` check box. This option turns on configuration file tracking.
5. Specify the files that you want to track in the `resource_type.config_track.files` field. Separate entries with a comma. You can use regular expressions when specifying
Identifying Inactive Users

SAS Environment Manager identifies users as inactive if they have not logged on in at least 60 days. To identify these users, go to Report Center ➔ Products ➔ SAS Environment Manager ➔ Nightly Reports ➔ Audit Reports ➔ Metadata Client Activity. This report lists all user logon activity, and identifies inactive users.
Performing Functions By Using a Command Line

Overview

You can issue commands to call SAS Environment Manager script files, which enable you to perform actions such as running the ETLs, installing kits, or enabling new HTTP checks. The files (.sh files for UNIX and .bat files for Windows) are provided in the directory `[levelroot]/Web/SASEnvironmentManager/emi-framework/bin` (UNIX) or `[levelroot]\Web\SASEnvironmentManager\emi-framework\bin` (Windows). Some commands are for commonly used functions, and others are for utilities or functions that are used infrequently. The following commands are provided:

- **commonly used commands**
  - emi_init
  - master_acm_etl
  - master_apm_etl
  - validate

- **utility commands**
  - agentClone
  - apm_init
  - create_event
  - create_http_checks
  - ev_kit_installer
  - exportDataMart
  - fedInit
  - runSASJob
  - updateFedDataMart
Working with Commonly Used Commands

Initializing the EMI Framework Using emi_init

Use the emi_init command to initialize the EMI framework (provided as part of extended monitoring), or to enable the ACM ETL, APM ETL, or solution kits ETL. Issue this command as part of the process of initializing and enabling the components of the Service Architecture. See Chapter 9, “Initializing and Enabling the Service Architecture,” on page 81 for more information about using this command.

The syntax of the command is: `emi_init(.sh|.bat) [-dfhisv] [(--enable|--disable) <ACM,APM,ALL>] [--vafeed <ON|OFF>] [--resetDB --resetFlags]

Options are:
-d (--debug)
enables debug output
-f (--force)
re-initializes the framework and overwrites settings
-h (--help)
displays help for the command
-i (--initialize)
initializes the framework
-s (--status)
reports the operational status of the EMI framework
-v (--verbose)
enables verbose output
-enable <[APM,ACM,ALL]>
specifies the components to enable. ALL enables the APM, ACM, and solution kits ETL.
-disable <[APM,ACM,ALL]>
specifies the components to disable. ALL disables the APM, ACM, and solution kits ETL.
--vafeed <ON|OFF>
enables or disables the nightly feed of data mart tables to a drop zone directory, where they are autoloaded into SAS Visual Analytics
--resetDB
resets the data mart and purges all data; you cannot recover the data after issuing this command

Note: If you run the command emi_init -f --resetDB, you must restart your SAS Application servers. If you do not restart the servers, logs are collected without the original header information for the logs. In order for the ETL process
to be able to fully parse and characterize the contents of the log files, the header information must be present.

--resetFlags
resets the flags that identify the components that have been initialized and enabled

**Running the APM ETL Processes By Using master_apm_etl**
The APM ETL processes are specified to run at 1 AM by default (this time can be changed in SAS Environment Manager). Use the `master_apm_etl` command if you want to run the processes manually or at another time. The command runs the processes to extract the information from the SAS logs and load it into the data mart. You can use a scheduler to issue the command at a specified time to run the ETL processes at a time other than the default. You can also issue the command yourself to run the processes immediately. However, because the SAS logs roll over at 1 AM, whenever the ETL processes run after 1 AM, they always use the same data that was collected during the previous 24 hours.

Although you can run the ETL process at any time, the reports use data from the last time the ETL process was run.

The syntax of the command is: `master_apm_init(.sh|.bat) [-dhv --evdebug <0–3>]`

Options are:
- `-d (--debug)`
  enables debug output
- `-h (--help)`
  displays help for the command
- `-v (--verbose)`
  enables verbose output
- `--evdebug <0–3>`
  specifies the debug level for SAS sessions

**Running the ACM ETL Processes Using master_acm_etl**
The ACM ETL processes are specified to run at 1 AM by default (this time can be changed in SAS Environment Manager). Use the `master_acm_etl` command if you want to run the processes manually or at another time. The command runs the processes to extract the ACM data and load it into the data mart. You can use a scheduler to issue the command at a specified time to run the ETL processes at a time other than the default. You can also issue the command yourself to run the processes immediately.

Although you can run the ETL process at any time, the reports use data from the last time the ETL process was run.

The syntax of the command is: `master_acm_init(.sh|.bat) [-dhv --evdebug <0–3>]`

Options are:
- `-d (--debug)`
  enables debug output
- `-h (--help)`
  displays help for the command
- `-v (--verbose)`
  enables verbose output
Validating the SAS Environment Manager Framework By Using validate

Use the validate command to validate the structure of the SAS Environment Manager framework and to find any errors or changes. This command runs during the initialization process to verify that the framework is correct before anything new is added. The command has four levels:

1. verifies that the command-line interface is functioning properly
2. validates connections to the SAS execution environment and the SAS Environment Manager server
3. verifies that the framework is initialized and functioning properly and that all enabled ETL components are running successfully
4. checks all of the files associated with SAS Environment Manager that should not be changed and notes any changes to any of these files

The syntax of the command is: validate(.sh|.bat) [-qvdh] [-l <1|2|3|4>] [-p] --userPolicy <IGNORE|WARN|ERROR>

Options are:
- -q (--quiet)
  specifies that the command should run in quiet mode
- -v (--verbose)
  enables verbose output
- -d (--debug)
  enables debug output
- -h (--help)
  displays help for the command
- -l --level <1|2|3|4>
  specifies the level of validation to perform; default value is 1
- -p --userPolicy <IGNORE|WARN|ERROR>
  specifies the policy if the current user does not match the install user

Working with Utility Commands

Cloning an Agent By Using agentClone

Use the agentClone command to create a machine-neutral bundle (TAR.GZ or ZIP) file of the SAS Environment Manager agent. This script enables SAS Environment Manager to monitor machines in your environment that do not have SAS deployed on the machines (such as grid nodes, machines that contain databases used by SAS, or machines in a Hadoop cluster).

To use this script to monitor a machine in your environment, follow these steps:
1. Stop the SAS Environment Manager agent running on the source server.
2. Use the agentClone (.sh|.bat) script to create the TAR.GZ or ZIP bundle. The script is located in the $SAS_config\Lev\Web\SASEnvironmentManager\emi-framework\bin directory.

3. Copy the bundle file to a host (such as a SAS Grid node) that is not part of the standard SAS environment installed by the SAS Deployment Wizard. This machine is referred to as the target machine in this procedure.

4. Extract the file. Recommended practice is to extract the file to the directory $SAS_Config\Lev\Web\SASEnvironmentManager\agent-5.8.0-EE\. This location assumes that you are using a standard deployment from the SAS Deployment Wizard.

5. Compare the values for JAVA_HOME and JAVA_HQ_HOME on the target machine against the values on the SAS Environment Manager server. If the values are different on the target machine, use this list to determine where to change the values on the target machine so that they match the value on the SAS Environment Manager server.

   SAS 9.4M5 (Windows)
   set in bundles\agent-5.8.0\bin\hq-agent.bat script

   SAS 9.4M5 (UNIX)
   set in bundles\agent-5.8.0\bin\hq-agent.nowrapper.sh script

   SAS 9.4M3 and SAS 9.4M4
   set in bin\hq-agent.nowrapper.sh script

6. (Windows only) Install the agent as a service on the target machine.

7. On the target machine, open a command prompt and navigate to the directory where you extracted the agent bundle (typically $SAS_Config\Lev\Web\SASEnvironmentManager\agent-5.8.0-EE\bin). Run the command hq-agent(.sh|.bat) install.

8. Start the agent on the target machine. You can start the agent either by issuing the command hq-agent(.sh|.bat) start or by starting the service from Windows services window. When you start the agent, it automatically registers with the SAS Environment Manager server.

9. Optionally, verify the value of the agent.setup.agentIP property in the agent.properties file in the directory where you extracted the agent bundle (typically $SAS_Config\Lev\Web\SASEnvironmentManager\agent-5.8.0-EE\conf). This value is usually "*default*" If the value is a host name, it must be host where the SAS Environment Manager agent clone runs.

The syntax of the command is: agentClone(.sh|.bat) [-vdh] [--javahome <javahome>] [--sasconfig <sasconfig>] [--sashome <sashome>] [-t <Minimal|Select>] [-w <workingDir>] [bundlefile]

Options are:
-v (verbose)
enables verbose output
-d (debug)
enables debug output
-h (help)
displays help for the command
-t (--type) <Minimal|Select>
specifies whether certain plug-ins are included (Select) or omitted (Minimal) to minimize the size of the clone file and the memory required

-w (--workdir) <workingDir>
specifies the directory to use when constructing the TAR or ZIP file

bundlefile
specifies the name of the TAR or ZIP file that contains the clone of the SAS Environment Manager agent

**Initializing the APM Processes By Using apm_init**
Use the `apm_init` command to initialize the APM ETL processes. Manual steps are also required after you run this command. See “Enabling and Initializing the APM ETL” on page 84 for complete information about the initialization process.

The syntax of the command is: `apm_init(.sh|.bat) [-fvdh --hostAlias]`

Options are:
- `d` (--debug)
enables debug output
- `f` (--force)
forces configuration to occur, even if a previous version of APM is found, or if APM has already been initialized
- `h` (--help)
displays help for the command
- `--hostAlias`
specifies the host alias for the machine
- `v` (--verbose)
enables verbose output

**Creating an Event By Using create_event**
Use the `create_event` command to manually create a SAS Environment Manager event. After it is created, the event appears in the SAS Environment Manager Event Center.

The syntax of the command is: `createEvent(.sh|.bat) [-vdh] [-f <file>] [-l <INFO|WARN|ERROR>] [-s <source>]`

Options are:
- `v` (--verbose)
enables verbose output
- `d` (--debug)
enables debug output
- `h` (--help)
displays help for the command
- `f` (--file) <file>
specifies the event file
- `l` (--level) <INFO|WARN|ERROR>
specifies the level of the event to create (INFO is the default value)
- `s` (--source)source
specifies the source of the event
Creating an HTTP Check By Using create_http_checks

Use the `create_http_checks` command to create an HTTP check service based on the definitions in the file httpChecks.json. This file contains all of the predefined HTTP check definitions, but not all of these definitions are created by default. To create one of the definitions:

1. After you have initialized the framework (part of the extended monitoring initialization), edit the file `[levelroot]/Web/SASEnvironmentManager/emi-framework/Conf/httpChecks.json` (UNIX) or `[Levelroot]\Web\SASEnvironmentManager\emi-framework\Conf\httpChecks.json` (Windows).

2. Locate the entry for the HTTP check that you want to create. This is an example entry:

   ```json
   {
   "name": "HTTP Check for SASTheme_default",
   "desc": "[Auto-Generate] HTTP Monitoring URL: /SASTheme_default",
   "enable": "false",
   "method": "GET",
   "port": "7980",
   "sotimeout": "30",
   "platform": "ptnode19.ptest.sas.com",
   "path": "/SASTheme_default",
   "follow": "true",
   "pattern": "SASTheme_default"
   },
   ``

3. Change the value of the enable parameter from `false` to `true`. "enable": "false",

4. Save the httpChecks.json file.

5. Run the `create_http_checks` command.

To verify that the service has been created, sign on to SAS Environment Manager and select **Browse ⇒ Services**. The new HTTP check service is listed.

The syntax of the command is: `create_http_checks (.sh | .bat) [-fxvdh] [-t <taskfile>]`

Options are:

- **-t ( --taskfile ) <taskfile>**
  - specifies that the HTTP checks should not be generated, but should be based on the specified JSON task file

- **-f ( --force )**
  - re-initializes the HTTP checks and overwrites settings

- **-x ( --noexit )**
  - specifies that the Java virtual machine should not exit after the command is completed

- **-v ( --verbose )**
  - enables verbose output

- **-d ( --debug )**
  - enables debug output

- **-h ( --help )**
  - displays help for the command
**Installing a Solution Kit By Using ev_kit_installer**

Solution kits provide customized metrics and reports to support specific SAS solutions and applications. Use the `ev_kit_installer` command to install new solution kits.

The syntax of the command is: `ev_kit_installer(.sh|.bat) [-fvdh] [-k <kitname|ALL>]

Options are:

- `-f (--force)` replaces the existing kit configurations
- `-v (--verbose)` enables verbose output
- `-d (--debug)` enables debug output
- `-h (--help)` displays help for the command
- `-k (--kitName) <kitname|ALL>` specifies the name of the kit to install, or that all kits should be installed.

**Exporting Data Mart Contents By Using exportDataMart**

You can set up a federated data mart, which merges data from the data marts of several contributor deployments into the data mart of a host deployment. See “Creating a Federated Data Mart” on page 76 for complete information. Although you can set up an automatic nightly process to export the changes in a contributor’s data mart, there might be instances when you might want to export the entire contents of the data mart. For example, when you first set up the federated data mart, you can run a complete export to ensure that the federated data mart is complete.

The syntax of the command is: `exportDataMart(.sh|.bat) --deploymentID (altDeployment_ID) --runID (altRun_ID)

Options are:

- `--deploymentID altDeployment_ID` specifies an alternate deployment identifier. This option is useful in cases where multiple deployments use the same deployment identifier.
- `--runID altRun_ID` specifies an alternate identifier for the export job. The identifier is used in the filename of the TAR file that contains the exported data mart data.

**Initializing a Federated Data Mart By Using fedInit**

Use the `fed_init` command to create and initialize a federated data mart. Run this script on the machine that will host the federated data mart directories. After you run this script, you must perform additional steps in order to implement the federated data mart. See “Creating a Federated Data Mart” on page 76 for instructions.

The syntax of the command is: `fed_init(.sh|.bat) [-vdh] [--resetDB]

Options are as follows:

- `-v (--verbose)` enables verbose output.
- `-d (--debug)` enables debug output.
-h (--help)
  displays help for the command.

  --resetDB
  resets the federated data mart by purging all of the existing data.

  **CAUTION:**
  If you use the --resetDB option, the deleted data cannot be recovered.

### Accessing SAS Environment Manager with a SAS Job By Using runSASJob

Use the `runSASJob` command to run a SAS program with the SAS autoexec and environment necessary for the program to access the data mart and the EMI framework.

**CAUTION:**
Do not run this command unless directed to by SAS Technical Support. Running this command incorrectly could corrupt the data mart and cause loss of data.

The syntax of the command is:
```
```

Options are:

- **-b (--batch)**
  specifies that the SAS program runs in batch mode (with the SAS options -batch -noterminal)

- **-d (--debug)**
  enables debug output

- **-h (--help)**
  displays help for the command

- **-v (--verbose)**
  enables verbose output

- **--args <args>**
  specifies any SAS command line arguments to be appended to the SAS invocation command

- **--autocall <autocall_dir>**
  specifies the autocall directory to use

- **--autoexec <(BATCH|STP) | <autoexec_file>**
  specifies whether to use a defined autoexec file (such as BATCH or STP) or a specified autoexec file

- **--config <config_file>**
  specifies a custom configuration file to use

- **--evdebug <0-3>**
  specifies the debug level for the SAS session

- **--log <log_results_file>**
  specifies the file to contain the log results

- **-nodms**
  specifies that SAS should run in line mode with the framework enabled
importing contributing data mart contents by using updatefeddatamart

you can set up a federated data mart, which merges data from the data marts of several contributor deployments into the data mart of a host deployment. see “creating a federated data mart” on page 76 for complete information. the contributor deployments export data from their data marts (contained in a TAR file) through automatic or manual processes. after the data is exported, you must copy it to the emi-framework/LandingZone/FedDataMart directory on the host deployment. after the files are in this directory, you can run the updateDataMart script to load the data from the contributor deployments into the federated data mart. by default, the script imports all files that are in the LandingZone directory that follow the naming convention SASEVDM_EXPORT#deployID#runID.tar.

the syntax of the command is: updateFedDataMart(.sh|.bat) --inputfile (filename) --altDeployID (override_ID) --altDeployLabel(override_label)

options are:

--inputfile filename
   specifies a filename to import, rather than having the script search the directory.

--altDeployID override_ID
   specifies an alternate deployment identifier for the file specified by the --inputfile option.

--altDeployLabel override_label
   specifies an alternate deployment label for the file specified by the --inputfile option.

updating a modified data mart by using ugipInit

if you modified your service architecture and updated to SAS Environment Manager 2.5, you must make manual changes to the service architecture, then run the ugipInit command. see “updating the service architecture in SAS Environment Manager 2.5” on page 89 for complete information.

the syntax of the command is ugipInit.(sh | .bat).

CAUTION:

this command is normally run automatically as part of the upgrade process. do not run this command unless directed to by SAS Technical Support.
Part 3

Appendixes

Appendix 1
Installing SAS Environment Manager in a Shared Directory Environment .................................................. 117

Appendix 2
Troubleshooting .................................................................................. 123

Appendix 3
Manual Setup Examples ........................................................................ 135

Appendix 4
Data Mart Table Reference ................................................................. 147

Appendix 5
Service Architecture Alerts ................................................................. 161

Appendix 6
Disabling the ACM and APM ETL Processes ................................. 173
Appendix 1

Installing SAS Environment Manager in a Shared Directory Environment

Overview

If you have an environment where more than one machine shares the configuration directories (such as using a SAS grid or load-balanced compute servers), you must perform special steps in order for SAS Environment Manager to monitor all of the machines in the environment. The SAS Environment Manager agent is installed on only the machine on which you run SAS Deployment Wizard, so SAS Environment Manager monitors only that machine. The SAS Environment Manager agent cannot be launched on multiple hosts from the original machine’s directory because the agent is registered under the original machine’s host name. In order to monitor all machines in this type of configuration, a directory structure must be provided for each agent. SAS 9.4M6 provides a “smart agent,” which uses the `hq-agent.bat/.sh` command described in this appendix to automate this process, rather than performing manual configuration steps.

An alternative approach is provided at Installing and Configuring SAS Environment Manager in a SAS Grid Environment with a Shared Configuration Directory. You cannot use the `hq-agent` command to manage agents that were configured using this procedure or any other manual procedure.

Assumptions

The procedures described in this appendix assume the following:

- You have already used the SAS Deployment Wizard to deploy SAS into shared installation and configuration directories.
- All SAS compute nodes have access to the shared configuration directory through the same fully qualified path.
- On Windows, because the smart agent cannot be started as a service, the user ID that you use to run the agent must remain logged on to the server. Otherwise, the agent process terminates.

UNIX

Procedure for UNIX

Follow these steps to configure the SAS Environment Manager agents to use a shared configuration directory in a UNIX environment:
1. On a machine in your environment that should access the shared directory and on which the SAS Deployment Wizard has not been run, navigate to the directory $SASConfig/LevN/Web/SASEnvironmentManager/smart-agent.

2. Run the command `hq-agent.sh start` to start the smart agent. See “UNIX Command Syntax” on page 118 for the complete syntax for the command.

3. If you receive a `Permission denied` error when running the command, use this command to give execute permissions to the script `chmod +x hq-agent.sh`.

4. Repeat steps 1 through 3 for all other machines in your environment that share the same configuration directory and on which the SAS Deployment Wizard has not been run.

**Note:** You cannot use the `sas.servers` script to start or stop the smart agent script. Use this script only to run the SAS Environment Manager agent on the machine on which you ran the SAS Deployment Wizard.

### UNIX Command Syntax

This is the syntax for the smart agent command on UNIX:

`hq-agent.sh parameter <value>`

These are the valid parameters and associated values for the smart agent:

- (no parameter) displays usage information for the `hq-agent.sh` command
- `start <alias>`
  - If an agent is present for the host or specified `alias` (optional), starts the agent. If an agent is not present, creates a directory (using the host name or `alias`) under the `cloned_agents` directory, copies the agent into the new directory, and starts the agent.
- `stop <alias>`
  - stops the agent on the host or specified `alias` (optional).
- `restart <alias>`
  - If an agent is present for the host or specified `alias` (optional), restarts the agent. If an agent is not present, creates a directory (using the host name or `alias`) under the `cloned_agents` directory, copies the agent into the new directory, and starts the agent.
- `delete <alias>`
  - stops the agent on the host or specified `alias` (optional) and deletes the directory for the agent.
- `status <alias>`
  - checks the status of the agent on the host or specified `alias` (optional).
- `change old_name <alias>`
  - verifies that an agent is present that uses the specified `old_name`, stops and removes the `old_name` agent, creates a new agent using the host name or `alias`, and starts the agent.

### Windows

**Procedure for Windows**

Follow these steps to configure the SAS Environment Manager smart agent to use a shared configuration directory in a Windows environment:
Important: Because the agent cannot be started as a service, the user ID that you use to run `hq-agent-nowrapper.bat` must remain logged on to the server. Otherwise, the agent process will terminate.

1. On the machine on which you installed the agent (referred to as the shared agent machine in this procedure), set the values of the system environment variables JAVA_HOME and HQ_JAVA_HOME to this value:
   ```
   SASHome\SASPrivateJavaRuntimeEnvironment\9.4\jre
   ```

2. On the shared agent machine, open a command window and issue this command to start the SAS Environment Manager agent:
   ```
   SASConfig\Lev\SASEnvironmentManager\agent-5.8.0-EE\bundles\agent-5.8.0\bin\hq-agent-nowrapper.bat start
   ```

3. On a node machine (a machine in your environment that should access the shared directory and on which the SAS Deployment Wizard has not been run), map the shared folder as a mapped network drive with the same fully qualified path as it on the shared agent machine.

4. On this same machine, open a command window and issue this command to clone and start a new SAS Environment Manager agent:
   ```
   SASConfig\Lev\Web\SASEnvironmentManager\smart-agent\hq-agent.bat start
   ```

5. If you receive the message `the symbolic link cannot be followed because its type is disabled`, open a command window and issue this command to verify the symbolic link policy:
   ```
   fsutil behavior query SymlinkEvaluation
   ```
   If you receive the message `Remote to remote symbolic links are disabled`, issue this command to enable remote symbolic links:
   ```
   fsutil behavior set SymlinkEvaluation R2R:1
   ```
   After enabling remote symbolic links, issue this command to start the SAS Environment Manager agent:
   ```
   SASConfig\Lev\Web\SASEnvironmentManager\smart-agent\hq-agent.bat start
   ```

6. Repeat steps 3–5 for all other machines in your environment that share the same configuration directory and on which the SAS Deployment Wizard has not been run.

### Windows Command Syntax

This the syntax for the smart agent command on Windows:

```
hq-agent.bat parameter <value>
```

These are the valid parameters and associated values:

- (no parameter)  
  displays usage information for the `hq-agent.bat` command

- `start <alias>`  
  If an agent is present for the host or specified `alias` (optional), starts the agent. If an agent is not present, creates a directory (using the host name or `alias`) under the `cloned_agents` directory, copies the agent into the new directory, and starts the agent.

  Note: Specify `alias` if you do not want to use the default host name.

- `stop <alias>`  
  stops the agent on the host or specified `alias`.  

---

*Installing and Configuring SAS Environment Manager in an Environment with Shared Configuration Directories*  
119
**restart <alias>**

If an agent is present for the host or specified alias (optional), restarts the agent. If an agent is not present, creates a directory (using the host name or alias) under the cloned_agents directory, copies the agent into the new directory, and starts the agent.

**delete <alias>**

stops the agent on the host or specified alias (optional) and deletes the directory for the agent.

**ping <alias>**

checks the communication port for the agent on the host or specified alias (optional).

**change old_name <alias>**

verifies that an agent is present that uses the specified old_name, stops and removes the old_name agent, creates a new agent using the host name or alias, and starts the agent.

**SSL Support**

The smart agent can create self-signed SSL certificates for the cloned agents. If you need to use a custom certificate for the agent, you must manually configure the certificate.

If you are using SSL with JKS format keystore, follow these steps:

1. Make these changes in the file `SASConfig/Levn/Web/SASEnvironmentManager/cloned_agents/$NODE_NAME/agent-5.8.0-EE/conf/agent.properties`:
   • `agent.keystore.path=keystore_file_location`
   • `agent.keystore.password=keystore_password`

   The `keystore_password` must be in plain text.

2. Remove the directory `SASConfig/Levn/Web/SASEnvironmentManager/cloned_agents/$NODE_NAME/agent-5.8.0-EE/data`

3. Restart the agent using the command `hq-agent.bat/sh start`.

If you are using SSL with a certificate that uses the crt+key format, you must use an alias of `hq`. Run these commands on the machine where the SAS Web Server is configured (the machine where you can run the openssl and keytool commands):

```bash
openssl pkcs12 -export -inkey "customercertificate.key" -in "customercertificate.crt" -name hq -password pass=password -out hyperic.p12
keytool -importkeystore -deststorepass hyperic -destkeypass hyperic -destkeystore keystore -srckeystore hyperic.p12 -srcstoretype PKCS12 -srcstorepass password -alias hq
```

**Performing Maintenance Tasks with a Shared SAS Environment Manager Agent**

When you apply a hot fix to your environment, stop the agent on all machines in your environment, apply the hot fix to the shared agent machine, and restart the agent on all machines.

When you perform an upgrade in place to update your SAS software to a new version, update the shared agent machine (the machine on which you configured the agent using...
the SAS Deployment Wizard) and restart the agent on all other machines in your environment.

If you change the host name on the shared agent machine, the SAS Deployment Wizard makes the necessary change in the agent. If you change the host name of a cloned agent machine, use the `hq-agent.bat/sh delete old_hostname` command to stop and delete the agent, then use the `hq-agent.bat/sh start` to re-create and start the agent.

Unconfiguring your SAS software removes the shared agent and all stopped cloned agents. You must stop all cloned agents before you unconfigure the SAS Environment Manager agent on the shared agent machine.
Resolving Problems with SAS Environment Manager

When you add auto-discovered resources into the inventory, you might see the following error message:

Unable to import platform:
org.hyperic.hq.common.SystemException:
org.hibernate.ObjectNotFoundException: No row the the given identifier exists: [org.hyperic.hq.autoinventory.Allp#10001]

Purge the AIQ data in the SAS Environment Monitor database. Follow these steps:

1. Select Manage ⇒ HQ Health ⇒ Database tab
2. Select Purge AIQ Data from the Action menu.
   
   These messages appear:
   
   • DELETE FROM EAM_AIQ_IP: 0 rows
   • DELETE FROM EAM_AIQ_SERVICE: 0 rows
   • DELETE FROM EAM_AIQ_SERVER: 0 rows
   • DELETE FROM EAM_AIQ_PLATFORM: 0 rows
3. Restart the agents.

If you add a resource that has been discovered but does not have any availability information to an Availability Summary portlet, the portlet will never display any information for the resource. The server log contains this information:

1. On the Resources tab, delete the platform that contains the resource.
2. Stop the agent.
3. Delete the tokendata, keystore, and keyvals files from the directory `<SAS-configuration-directory>/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/data`.

4. Issue the command `hq-agent.bat/sh restart` from the command console.

**Connections for gathering metrics and performing health checks might cause problems with SAS IOM servers.**

The direct connections that SAS Environment Manager makes with some SAS IOM servers (such as SAS workspace servers, SAS stored process servers, and SAS object spawners) might cause problems with server operations. Examples of these problems include the following:

- SAS Environment Manager starting jobs that never complete on SAS pooled workspace servers and SAS stored process servers
- SAS stored process servers attempting to start every minute and failing each time

To prevent these problems, follow these steps to disable the metric collection processes that might cause problems.

1. Select `Manage` ⇒ `Monitoring Defaults`.


3. Select the `Availability` check box, and then select `Disable Collection`. Select `OK` when you are asked to confirm the change.


5. Select the `Availability` check box and the `Utilization` check box (which also selects the check boxes under the `Utilization` heading), and then select `Disable Collection`. Select `OK` when you are asked to confirm the change.


7. Select the `Availability` check box, and then select `Disable Collection`. Select `OK` when you are asked to confirm the change.

If you are using Microsoft Internet Explorer, newly created folders might not show up in the folder tree.

To ensure that new folders appear, from the Internet Explorer menu, select `Tools` ⇒ `F12 Developer Tools`. From the Internet Explorer `Developer Tools` menu, select `Cache` ⇒ `Always refresh from server`.

If you cause an error when you rename a folder (because, for example, you used invalid characters in the name or specified a blank name), the folder is not saved and the `Validate Result` dialog box appears.

To view details about the error, click the text `Basic Properties page failed` in the dialog box.

When you configure the SAS Environment Manager Server, SSL 3.0 is enabled by default. SSL 3.0 is vulnerable to the POODLE security attack.

To disable SSL 3.0 in the SAS Environment Manager Server, follow these steps:

1. Open the server.xml file that is in the directory `server-5.0.0-EE/hq-engine/hq-server/conf` under the SAS Environment Manager directory.
2. Locate the `<Connector>` element that specifies SSLEnabled=”true”

3. Specify the sslProtocols parameter in the `<Connector>` element.
   
   `<Connector ... sslProtocols="TLSv1,TLSv1.1,TLSv1.2"/>
   
4. Save the file and restart the SAS Environment Manager Server.

   Note: Depending on your release of SAS Environment Manager, the sslProtocols parameter might already be specified. If this is the case, SSL 3.0 is already disabled and you do not need to take any further action.

   The User Manager might not appear when you are using SAS Environment Manager with Microsoft Internet Explorer version 9 or version 11.

   If you are using Microsoft Internet Explorer version 9, follow these steps:
   
   1. From the Internet Explorer menu bar, select Tools Æ F12 developer tools. The developer tools area appears at the bottom of the window.
   
   2. In the menu bar of the developer tools area, locate the Developer Tools entry.
   
   3. If the entry appears as Developer Tools: Quirks, click on the entry and select Internet Explorer 9 standards from the pop-up menu.
   
   4. From the developer tools menu bar, select File Æ Exit.

   If you are using Microsoft Internet Explorer version 11, follow these steps:
   
   1. Select the Tools icon in the upper right corner of the Internet Explorer window to display the Tools menu.
   
   2. Select Compatibility View settings from the Tools menu.
   
   3. In the Compatibility View Settings window, clear the check box Display intranet sites in Compatibility View.
   
   4. Close the Compatibility View Settings window.

   Some auto-discovered server types might not appear in the Resources table

   Some servers in your environment that are auto-discovered might not be auto-approved, so they will not appear in the Resources table.

   Follow these steps:
   
   1. Open the SAS Environment Manager Dashboard page.
   
   2. The Auto-discovery portlet lists the servers that have been discovered but not added. Select the check boxes beside the servers that you want to add.
   
   3. Click Add to Inventory.

---

**Resolving Problems with SAS Environment Manager Agents**

When you try to configure the SAS Environment Manager Agent, it does not start and you receive the error message *No token file found, waiting for Agent to initialize*
1. Stop the SAS Environment Manager agent.

2. Verify that the agent wrapper processes and the agent Java processes have stopped.

3. On the W6X platform, verify that the directory %SystemRoot%/TEMP exists. Remove the file %SystemRoot%/TEMP/agent.encrypt.lock.

   On all other UNIX platforms, search for the java.io.tmpdir environment variable in the agent wrapper process and the agent Java process. By default, the value of the variable is set to the /tmp or /var/tmp directory. If the variable exists, remove the file agent_encrypt.lock under the specified directory.

   The agent.log file contains the message java.lang.OutOfMemoryError: GC overhead limit exceeded

   Include these JVM options in the start-up script for each agent:

```
-XX:NewRatio=8
-XX:+CMSClassUnloadingEnabled
-XX:+UseTLAB
-XX:+UseCompressedOops
```

Modify the file SAS-configuration_directory/LevX/Web/SASEnvironmentManager/agent-5.8.0-EE/bundles/agent-5.8.0/bin/hq-agent.sh or hq-agent.bat and add these JVM options to the CLIENT_CMD variable:

```
CLIENT_CMD="${HQ_JAVA} \n   -D${AGENT_INSTALL_HOME_PROP}=${AGENT_INSTALL_HOME} \n   -D${AGENT_BUNDLE_HOME_PROP}=${AGENT_BUNDLE_HOME} \n   -XX:NewRatio=8 \n   -XX:+CMSClassUnloadingEnabled \n   -XX:+UseTLAB \n   -XX:+UseCompressedOops \n   -cp ${CLIENT_CLASSPATH} ${CLIENT_CLASS}"
```

After the agent successfully starts, some agent properties might get encrypted. If the agent cannot read the agent.scu file (which contains the encryption keys), it cannot decrypt the properties. The agent will not start and the agent.log or the wrapper.log file contains the error org.jasypt.exceptions.EncryptionOperationNotPossibleException.

1. Stop the SAS Environment Manager agent.

2. In the directory SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE, delete the /data directory.

3. In the directory SAS-configuration/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/conf, delete the agent.scu file.

4. Modify the encrypted property to a plain text value. In the file SAS-configuration/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/agent.properties, set the property agent.setup.camPword to a plain text value (if it is encrypted, it appears as ENC(XXXXXXXXXX)).

5. In the file SAS-configuration/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/auto-approve.properties, change all values to True.

6. Restart the agent.
On Windows, if you use Windows Services to stop the Hyperic Agent service, you receive the error message Windows could not stop the SAS [SAS94-Lev1] SAS Environment Manager Agent on Local Computer. Clicking OK in the error message dialog box seems to stop the service, but the System Event Log contains the error The SAS [SAS94-Lev1] SAS Environment Manager Agent service terminated with service-specific error Incorrect function.

Use the command line, rather than Windows Services, to stop the agent. The command to stop the agent is `<sas_configuration_directory>/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/bin/hq-agent.bat stop`.

You are not receiving metric data for a machine on which the SAS Environment Manager Agent is running. The agent.log file for the machine contains the error Agent does not have valid SRNs, but has metric data to send, removing measurements.

1. Stop the SAS Environment Manager agent.
2. In the directory `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE`, delete the `/data` directory.
3. In the directory `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/conf`, delete the `agent.scu` file.
4. Modify the encrypted property to a plain text value. In the file `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/agent.properties`, set the property `agent.setup.camPword` to a plain text value (if it is encrypted, it appears as ENC(XXXXXXXXXX)).
5. In the file `SAS-configuration/Lev2/Web/SASEnvironmentManager/agent-5.8.0-EE/auto-approve.properties`, change all values to True.
6. Restart the agent.

You receive log messages indicating that the SAS Environment Manager agent is sending data faster than it can be processed.

If the agent is sending data faster than it can be processed, you might see these messages in the server.log and agent.log files:

- Unable to insert data
- No space left in the DataInserter queue. Try again later, or increase your queue size

To resolve this issue, you can either increase the time value or reduce the number of processes for the agent to collect the metrics.

Follow these steps:

1. Select Resources ⇒ Platforms. In the Platforms table, select the entry for the SAS Environment Manager agent.
2. On the details page for the agent resource, select Inventory.
3. In the Configuration Properties area, click Edit.
4. To increase the time value, increase the value of the `top.processes.interval` field. Start with a value of 5, and increase the value as needed.
5. To reduce the number of processes, change the value of the `top.processes.number` field. Start by changing the value from the default of 10 to 5, and decrease the value as needed.

You can also increase the value of `BATCH_AGGREGATE_QUEUE`. This change is useful if the queue is full and you need to change the size immediately. It is also useful if increasing the top.processes values does not resolve the problem, or if you do not want to change the top.processes values.

Follow these steps:

1. Issue these commands:

   ```
   export LD_LIBRARY_PATH=<SAS_HOME>/SASWebInfrastructurePlatformDataServer/9.4/lib:$LD_LIBRARY_PATH
   <SAS_HOME>/SASWebInfrastructurePlatformDataServer/9.4/bin/psql -h wipdscomputetier.domain.com -U dbmsowner -p 9432 -d EVManager update eam_config_props set propvalue='1000000' where propkey='BATCH_AGGREGATE_QUEUE';
   ```

2. Restart the SAS Environment Manager server. Use this command:

   ```
   <SAS_HOME>/Lev1/Web/SASEnvironmentManager/server-5.8.0-EE/bin/hq-server.sh restart
   ```

3. If the problem persists, repeat this procedure with a larger value for `BATCH_AGGREGATE_QUEUE`.

You receive the message "A remote host refused an attempted connect operation" while attempting to start SAS Environment Manager.

When starting SAS Environment Manager, you might see this message:

Error contacting agent: Error sending argument: Unable to connect to 127.0.0.1:2144: A remote host refused an attempted connect operation., retried 5 times, cmd=agent:ping

If you check the status of the SAS Environment Manager agent, you might see this message:

HQ Agent is running (PID:42).
Unable to contact agent: Error sending argument: Unable to connect to 127.0.0.1:2144: Connection refused, retried 5 times, cmd=agent:getCurrentAgentBundle

To resolve this issue, follow these steps:

1. Ensure that no other process is running on port 2144 (or on the port on which the SAS Environment Manager Agent is configured).

2. Enter this command:

   ```
   sas-config-dir/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/bin/hq-agent.sh start
   ```

All resources are shown as unavailable and the agent.log contains the message "java.lang.OutOfMemoryError: Java heap space"

When you select Resources ⇒ Browse you might see that all resources are listed as unavailable. If you then check the SAS Environment Manager agent log file, located at `SAS-configuration-directory/LevN/SASEnvironmentManager/Web/SAS/agent-5.x.0-EE/log/agent.log`, you might see Java heap space errors similar to the following entries:

```
08-02-2016 01:18:27,427 CST ERROR [AgentDiagnostics] [AgentDiagnostics@61] java.lang.OutOfMemoryError: Java heap space java.lang.OutOfMemoryError:
```
Java heap space 08-02-2016 01:19:48,200 CST ERROR [SenderThread] [SenderThread@633]
Java heap space java.lang.OutOfMemoryError: Java heap space

To resolve this issue, follow these steps:

1. Open the file `SAS-configuration-directory/LevN/Web/SASEnvironmentManager/agent-5.8.0-EE/bundles/agent-5.x.0/conf/wrapper.conf`.
2. Change the line `wrapper.java.additional.2=-Xmx128m` to `wrapper.java.additional.2=-Xmx512m`
3. Change the line `wrapper.java.maxmemory=256` to `#wrapper.java.maxmemory=256`
4. Save and close the file.
5. Use this command to restart the SAS Environment Manager Agent.
   `SAS-config-dir/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/bin/hq-agent.sh restart`

The SAS Environment Manager agent starts, but does not send data.

The SAS Environment Manager agent might not successfully connect to the SAS Environment Manager service, even though the service started successfully. You might receive these error messages when the SAServer services start up:

- [AutoinventoryCommand] [AutoinventoryCommand] [AutoinventoryCommand] [AutoinventoryCommand]
  server, sleeping for NNN secs before retrying.
- [PluginStatusSender] [AgentDaemon@NNN] could not send plugin status to server, will retry: java.lang.NullPointerException

If this problem occurs, you can start SAS Environment Manager, but you cannot view any resources.

To resolve this issue, follow these steps:

1. Submit this command to stop the SAS Environment Manager agent:
   `SAS-config-dir/Lev1/Web/SASEnvironmentManager/agent-5.0.0-EE/bin/hq-agent.ext stop`
   The value of `.ext` is either `.bat` (Windows) or `.sh` (UNIX).
2. Delete or rename the directory `SAS-configuration-directory/Lev1/Web/SASEnvironmentManager/agent-5.0.0-EE/data`.
3. If it exists, delete the agent.encrypt.lock file from the system temporary directory.
   - Windows temporary directory: `C:\Users\user-name\AppData\Local\Temp`.
   - UNIX temporary directory: `/tmp`.
4. Use this command to restart the SAS Environment agent:
   `SAS-configuration-directory/Lev1/Web/SASEnvironmentManager/agent-5.0.0-EE/bin hq-agent.ext start`
Note: If you are using Windows, you must restart the agent using the command from the Windows command prompt. Do not use the Windows Service Manager.

The SAS Environment Manager agent does not start and returns the error "Unable to register agent: Permission denied"

When starting or restarting the SAS Environment Manager agent, you might receive this error message:

Unable to register agent: Permission denied

This error is caused by a permissions problem with the account sasevs@saspw.

To resolve this issue, complete all of the steps listed in the document SAS-configuration-directory/Lev1/Documents/Instructions.html for SAS Environment Manager configuration.

Verify that the SAS App Tier Role is created in SAS Environment Manager and that the sasevs@saspw account is assigned to the SAS App Tier Role. See “SAS Environment Manager and SAS Metadata Users” on page 62.

Resolving Problems with SAS Environment Manager Plugins

After a PostgreSQL server is added into inventory, the Dashboard page indicates that the resource is not configured properly

In order to monitor this resource, you must provide PostgreSQL credentials in the resource definition. If you choose to not provide these credentials, the resource will not be monitored, but SAS Environment Manager will otherwise operate normally. The information that you specify depends on the type of PostgreSQL server that was added. If you choose to provide credentials, go to the Configuration Properties page for the server and specify this information:

postgresql.user
   specify the user name for the PostgreSQL server. The user name that you specify differs, depending on the type of PostgreSQL server. Specify one of the following:
   
   Web Infrastructure Platform Data Server
   specify the Web Infrastructure Platform Data Server database user name. This user was created during installation. The default value is dbmsowner.

   Job Monitor Data Server
   specify the Job Monitor Data Server database user name. This user was created during installation. The default value is jmdbuser.

   Data Remediation Data Server
   specify the Data Remediation Data Server database user name. This user was created during installation. The default value is rmdbuser.

   Data Management Data Server
   specify the Data Management Data Server database user name. This user was created during installation. The default value is dmbdnadmin.

postgresql.pass
   specify the password for the user name
postgresql.program
specify the path to the postgres.bat or postgres.sh file (on UNIX); or the postgres.exe
or postgres.bat file (on Windows). The path that you specify depends on the type of
PostgreSQL server. Specify one of the following values:

Web Infrastructure Platform Data Server
/opt/sas/Lev1/SASWebInfrastructurePlatformDataServer/
webinfsvrc.sh (UNIX) or <SAS_Configuration_Directory>/
Lev1/SASWebInfrastructurePlatformDataServer
webinfsvrc.bat (Windows)

Job Monitor Data Server
/opt/sas/Lev1/JobMonitorDataServer/jobmntrdsvrc.sh (UNIX)
or <SAS_Configuration_Directory>/Lev1/JobMonitorDataServer
jobmntrdsvrc.bat (Windows)

Data Remediation Data Server
/opt/sas/Lev1/DataRemediationDataServer/dmrmdtdsvrc.sh
(UNIX) or <SAS_Configuration_Directory>/
Lev1/DataRemediationDataServer/dmrmdtdsvrc.bat (Windows)

Data Management Data Server
/opt/sas/Lev1/DataManagementDataServer/dmdsvrc.sh (UNIX) or
<SAS_Configuration_Directory>/
Lev1/DataManagementDataServer/dmdsvrc.bat (Windows)

On the AIX platform, the Apache Tomcat 6.0 server Resource page displays the error
This resource is turned off or has not been configured properly. The problem is: Invalid configuration: Error
contacting resource: Can't connect to MBeanServer url.
1. Open the file $SAS_configuration_directory/Lev1/Web/
   SASEnvironmentManager/server-5.8.0-EE/hq-engine/hq-server/
   conf/hq-catalina.properties and find the jmx.url port number. The default
   value is 1099.
2. On the Configuration Properties page for the server, specify the following property:

   jmx.url
   service:jmx.rmi://jndi/rmi://localhost:port_number

On the H6I platform, no tcServer instances can be discovered.

HPUX has a limit of 1020 characters on command line queries. The parameters that the
tcServer plugin uses to identify the tcServer process are not seen by the agent because
they fall after the 1020 character limit has been reached. Edit the start-up script so that
the parameters that the plugin needs are seen before the 1020 character limit.

Edit the catalina.sh script. Change this section of the script:

```
eval \"$_RUNJAVA\" "\"$LOGGING_CONFIG\" $JAVA_OPTS $SCATALINA_OPTS \n-Djava.endorsed.dirs="\$JAVA_ENDORSED_DIRS\" -classpath "\$CLASSPATH\" \n-Dcatalina.base="\$SCATALINA_BASE\" \n-Dcatalina.home="\$SCATALINA_HOME\" \n-Djava.io.tmpdir="\$SCATALINA_TMPDIR\" \norg.apache.catalina.startup.Bootstrap "$@" start \n>> "\$CATALINA_OUT" 2>&1 "$"
```

Change the script to this:

```
eval \"$_RUNJAVA\" "\"$LOGGING_CONFIG\" \n-Dcatalina.base="\$SCATALINA_BASE\" 
```
Cannot start the SAS Environment Manager Agent by using the start script 
$SAS-configuration_directory/LevX/Web/SASEnvironmentManager/agent-5.8.0-EE/bin/hq-agent.sh start.

The console displays this message:

Starting HQ Agent......Removed stale pid file: /local/install/cfgsas1/config/Lev1/Web/SASEnvironmentManager/agent-5.8.0-EE/wrapper/sbin/../../wrapper/hq-agent.pid
WARNING: HQ Agent may have failed to start.

Use the unset command to remove the COLUMNS environment variable.

Resolving Problems with the Service Architecture

Unable to connect to the SAS Environment Manager Server

Confirm that the SAS Environment Manager server is running. Connect to the SAS Environment Manager web application using a URL in the format http://myserver:7080

[program] failed with return code [ rc]

Check the logs produced by the service architecture for detailed information about the error. The service architecture logs are stored in the /emi-framework/Logs directory.

SAS plugins were not found in SAS Environment Manager

Select Manage ⇒ Plug-in Manager. Use the Plug-in Manager table to verify that the sas - servers plugin is installed. If the plugin is not installed, contact SAS Technical Support.

SAS EMI Framework plugin is not loaded

Select Manage ⇒ Plug-in Manager. Use the Plug-in Manager table to verify that the emi-framework plugin is installed. If the plugin is not installed, contact SAS Technical Support.

[user] is not a member of the Super Users Role

Select Manage ⇒ List Roles and then select the Super User Role entry. Check to see whether the user entry is listed in the Assigned User table as a member of the Super User Role. If it is not, select Add to List to open the Assign Users to Role page, where you can add the user to the role.

Local SAS Environment Agent is not properly initialized

Confirm that the SAS Environment Manager agent is running properly on both the local and host machines. If an agent is not running properly, restart the agent. Go to <
levelroot > /Web/SASEnvironmentManager/agent - 5.8.8 - EE/bin
and issue the command hq - agent.(sh/bat) restart.

The script [scriptname] failed to compile
The local copy of the [scriptname] script has been changed, either because it has been edited or because it is corrupted. If the script was edited, remove the edits. If the script has been corrupted, contact SAS Contact Technical Support for a replacement script.

SAS Metadata server [servername] failed gyByName query
The SAS Metadata Server did not respond to a ping request to its IP address. To restart the server, run the command `sas.servers start` or `MetadataServers. (sh/bat)`.

Error: rc = [rc] running master_acm_etl .(sh/bat) or master_apm_etl.(sh/bat). Check log and return initialization with - f
An error was detected in one of the ETL processes (ACM or APM). Review the log messages in the emi-framework/Logs directory to determine the error and the specific ETL process that is reporting the error. Possible causes include inadequate storage, permissions errors, or the SAS Environment Manager server or SAS Metadata server not running. After you have fixed the error, run either `master_acm_etl .(sh/bat)` or `master_apm_etl.(sh/bat)` to verify that the error has been corrected.

Request to enable APM with APM Initialized = false
You attempted to enable APM ETL without having first initialized it. See “Enabling and Initializing the APM ETL” on page 84 for the complete procedure.

APM is not initialized / There was a problem validating external APM files
An error occurred when enabling the APM ARM. Run the command `bin/apm_i nit.(sh/bat) -f`.

APM has not been fully initialized. The file {...} /emi-framework/Conf/log_definitions.json needs to be updated (line nn)
For multi-machine deployments, you must edit the file `emi-framework/Conf/log_definitions_json` and specify the local paths to mount points for the SAS levelroot directories on the remote machines.

INFO: (logarmprocesslog) Partial arm log. Source [logfilename] does not appear to have been processed, ignoring log file.
This message appears if the processes for log collection and log processing encounter a partial log from a different SAS deployment that is missing header information. It also appears if you run the command `emi_init – resetDB – f` without stopping and restarting the SAS Application server. To re-create the rolling logs and the log headers, restart the SAS Application server.

When upgrading to a new version of SAS Environment Manager, the UpdateInstructions.html file contains the message “A problem was encountered while updating the SAS Environment Manager Service Architecture.”
If you have never previously enabled or initialized the service architecture in your deployment, you can ignore this message. Run the command `emi_init.sh --status` to check whether the service architecture has been enabled.
If you previously enabled the service architecture in the deployment that you are upgrading and the deployment contains multiple machines, an upgrade-in-place of the service architecture will fail. To resolve this error, first complete the upgrade process on all machines in your deployment. After you have upgraded all the machines, use the `ugipInit` command to upgrade the service architecture. See “Updating a Modified Data Mart By Using ugipInit” on page 114.

If neither of these conditions apply, review the log files identified in the `UpdateInstructions.html` message to determine the cause of the error. Also review the files `ugipInit_{TimeStamp}.log` and `ugipInit_{TimeStamp}.sas.log`, which are located in the `emi-framework/Logs` directory.

**Validate.sh fails with the message “unable to resolve class org.apache.http.conn.HttpHostConnectException”**

The SAS Environment Manager Agent must be configured because validate.sh relies on class `org.apache.http.conn.HttpHostConnectException`, which is provided by the SAS Environment Manager Agent. Verify that the Environment Manager Agent is configured and `<levelroot>/Web/SASEnvironmentManager/agent-5.8.8-EE` exists.

**Emi-init -i fails with the message “Multiple resources of type [SAS Environment Manager Data Mart] found”**

You might receive the error message “Multiple resources of type [SAS Environment Manager Data Mart] found” when you run the `emi-init -i` command. You also might receive the message

```
java.lang.NullPointerException: Cannot get property 'resourceProperty' on null object
```

To resolve this issue, follow these steps:

1. In SAS Environment Manager, select **Resources ⇒ Browse ⇒ Servers**.
2. Verify that there is only one **SAS Environment Manager Data Mart 9.4** server listed.
3. If there are multiple **SAS Environment Manager Data Mart 9.4** servers listed, delete all but one entry.

**You receive the message “Sync failed” for the alerts.xml file**

While running the `emi_init` command, you might receive a message stating that synchronization failed for the alerts.xml file.

To resolve this issue, enter this command:

```
<Lev_Root>/Web/SASEnvironmentManager/emi-framework/bin/ev_kit_installer --fv --k SASGrid
```
Alert Definition Examples

Example: Defining an Alert for SAS Work Directory

This example provides information for setting up an alert to be triggered whenever the volume on which the SAS Work directory resides reaches 90% of its capacity. The alert should be issued once every two hours until the condition is cleared. When the alert is triggered, users with the Operations role should be notified.

1. Locate the service **SAS Home Directory 9.4 SAS work directory**. The service is under the **SAS Home Directory 9.4** server.

2. Navigate to the Resource Detail page for the service. On the Detail page, select Alert ➔ **Configure** to display the Alert Configuration page. Click **New** to display the New Alert Configuration page.

3. Name the alert, select the priority, and specify that the alert should be active.
4. In the If Condition area, select the Metric radio button, then select Use Percent in the Metric field.

5. To specify 90% capacity, enter .9 in the absolute value field. To specify that the alert is triggered whenever the used capacity exceeds 90%, specify and select > (Greater than) from the comparison menu.

![If Condition: Metric: Use Percent](image)

6. In the Enable Action(s) field, specify 1 for the number of times the alert is issued, 2 for the timer period, and select hours for the time period units. These values specify that the alert is issued one time every two hours while the alert conditions are met.

![Enable Action(s): Each time conditions are met](image)

7. Click OK to define the alert and display the Configuration page for the new alert.

8. Select Notify Roles, and then select Add to List.

9. Select the check box beside Operations in the Roles list and use the arrow control to move the role to the Add Role Notification list.

10. Click OK to close the Role Selection page and then Return to Alert Definitions to complete the process of defining the alert.

**Example: Defining an Alert for a SAS Server Log File**

This example provides information for setting up an alert to be triggered whenever a warning message for the I/O Subsystem appears in the log of the SAS Metadata Server. The alert should be issued every time an error appears in the log.

1. Follow the procedure in “Creating Events Based on SAS Server Logs” on page 50 to create an event from the SAS Metadata Server log file. Add the entry

   `level.warn.2=*I/O Subsystem.*`

   to the sev_logtracker_plugin.properties file for the SAS Metadata Server.


4. Name the alert, select the priority, and specify that the alert should be active.

5. In the If Condition area, select the Event/Logs Level radio button, then select Warn in the Event/Logs Level field.
In the **match substring** field, enter **I/O Subsystem**. These values specify that an alert is issued whenever an event is found for a Warn message from the log containing the string “I/O Subsystem.”

6. In the **Enable Action(s)** area, select the **Each time conditions are met** radio button. This specifies that the alert is triggered each time an I/O Subsystem warning appears in the log.

7. Click **OK** to define the alert.

**Example: Defining an SNMP Alert Notification**

Creating a SAS Management Console alert that results in an SNMP trap notification is a process that can be difficult to troubleshoot. There are many potential problem areas, such as routing and filtering, that can mask any configuration errors. If you are using SAS Environment Manager with an enterprise monitoring application, SNMP alerts enable you to receive real-time notifications for critical alerts, while using event exporting for the audit tracking of all alerts.

In order to eliminate external issues with SNMP alerts, the best practice is to configure a local SNMP trap receiver on the SAS Environment Manager server, test everything locally by sending a trap from SAS Environment Manager to a trap receiver that is also configured on the SAS Environment Manager server. After testing is complete, you can then change the configuration to use the production settings. The following steps provide an example of this testing process:

1. Configure a local SNMP trap receiver for testing.
2. Verify that the trap receiver works correctly by using an operating system-based trap sender.
3. In SAS Environment Manager, enable SNMP trap sending and specify the SNMP configuration parameters.
4. Create a sample SAS Environment Manager alert that causes an SNMP trap notification to be sent.
5. Verify that the alert caused an SNMP trap notification to be sent.
6. Change the settings to point to the production trap receiver instead of the local test trap receiver.

To configure the alert, follow these steps:

**Step1: Configure a Local SNMP Trap Receiver for Testing**

Perform these steps as the root user ID.

1. Set the Security Enhanced Linux to permissive so that the trap messages can be redirected. To change the state only for the currently session, issue the command `setenforce 0`.

   To change the state permanently, modify the file `/etc/selinux/config` as root, change the value for the `SELINUX=` parameter to `permissive`, save the file, and reboot the machine.

2. Edit the `snmptrapd.conf` file, located in the `/etc` directory.
3. Add these two lines to the file:

   authCommunity log,execute,net public
   logOption f /tmp/snmptraps.log

   The logOption line specifies that snmptrapd should write trap messages to the external file /tmp/snmptraps.log.

4. Create a file named UCD-TRAP-TEST-MIB.txt in the directory /usr/share/snmp/mibs. Enter the following as the contents of the file:

   UCD-TRAP-TEST-MIB DEFINITIONS ::= BEGIN
      IMPORTS ucdExperimental FROM UCD-SNMP-MIB;

   demotraps OBJECT IDENTIFIER ::= { ucdExperimental 990 }

   demoTrap TRAP-TYPE
   ENTERPRISE demotraps
   VARIABLES { sysLocation }
   DESCRIPTION "An example of an SMIv1 trap"
   ::= 17

   END

5. Restart the snmptrapd server by issuing this command:

   # service snmptrapd restart

   Verify that you receive a response of OK from the server restart command.

6. Restart the SNMP server by issuing this command:

   # service snmpd restart

   Verify that you receive a response of OK from the server restart command.

   **Step 2: Verify the SNMP Trap Receiver**

   After you configure the test configuration, verify that the trap is working as expected. If you are using Windows, you can verify the operation using an snmptrap receiver tool.

7. Verify that the snmpd server is operating correctly by issuing these commands:

   snmptest -v 2c -c public <host>
   Variable: system.sysDescr.0
   Variable:\blank

   The value for host is the FQDN name or IP address of the SAS Environment Manager server.

   Verify that the system responds by returning the MIB system description, for example:

   SNMPv2-MIB::sysDescr.0 = STRING: Linux <host> 2.6.32-220.17.1.el6.x86_64 #1 SMP Thu Apr 26 13:37:13 EDT 2012 x86_64

8. Issue a simple and local snmptrap command. For example:

   snmptrap -v 1 -c public <host> UCD-TRAP-TEST-MIB::demotraps "" 6 17 "" \
   SNMPv2-MIB::sysLocation.0 = "snmp test string"

   The value of host is the FQDN name or IP address of the SAS Environment Manager server. Use a value of localhost if you execute the command on the SAS Environment Manager server.

9. Verify that the following log entry has been written to your /tmp/snmptraps.log:
Step 3: Enable SNMP Trap Sending in SAS Environment Manager

Before you can create an alert in SAS Environment Manager that uses SNMP, you must enable SNMP trap sending. At this point in the process, you are configuring SAS Environment Manager to send SNMP traps to the local test receiver.

10. In SAS Environment Manager, select **Manage** → **Server Settings** to display the **Edit Server Settings** page.

11. In the **Edit Server Settings** page, locate the **SNMP Server Configuration Properties** area and select 1 in the **SNMP Protocol Version** field.

12. Specify these values for the **SNMP Server Configuration Properties**:

   **SNMP Trap OID**
   - The selected OID value for the test (for example, 1.3.6.1.2.1.11.0.6). This value is the OID of the local test trap receiver.
   - Community
     - public (the default value).
   - **Generic ID**
     - 0
   - **Enterprise OID**
     - The selected OID value for the test (for example, 1.3.6.1.2.1.11.0.6). This value is the OID of the local test trap receiver.
   - **Default Notification Mechanism**
     - v1 Trap
   - **Specific ID**
     - leave blank
   - **Agent Address**
     - Specify the IP address of the SAS Environment Manager server.

Step 4: Create a Test Alert in SAS Environment Manager

After you have verified that the SNMP trap works as expected, use SAS Environment Manager to create a test alert that causes an SNMP trap to be sent. This example creates an alert that will trigger when the File System Reads/Writes per Minute metric is greater than 10. Because this alert will be triggered every time SAS Environment Manager scans for new alerts, it will test the SNMP trap configuration relatively quickly.

13. In SAS Environment Manager, select **Resources** → **Browse** → **Platform**. Locate the entry in the platform table for the SAS Environment Manager platform and select the **Alert** icon to the left of the platform entry to display the **Alerts** page.

14. On the **Alerts** page, select **New** to display the **New Alert Definition** page.

15. In the **New Alert Definition** page, specify the following information to define the alert:

   **If Condition Metric**
   - Select **File System Reads/Writes per Minute**

   **If Condition** comparison
   - Select **Greater than** and specify **10** for the comparison value.
Enable Action
Select Each time conditions are met.

16. Click OK to define the alert and display the Alert Definition page. Select SNMP Notification.

17. Specify these values:

   IP Address
   Specify the IP address of the SAS Environment Manager server, followed by a slash and the SNMP trap port (typically 162). An example entry might be 10.122.32.74/162.

   Notification Mechanism
   Select v1 Trap.

   OID
   Specify the OID value for the local test trap receiver (for example, 1.3.6.1.2.1.11.0.6). This value should match the value of the SNMP Trap OID field on the SNMP Server Configuration Properties page.

   Click Save Changes to save the alert.

**Step 5: Verify That the Alert Sent an SNMP Trap**

After you define the alert, verify that an occurrence of the alert writes a record to the SNMP trap log, which verifies that the SNMP trap was successfully sent from SAS Environment Manager to the local test trap receiver.

18. Wait until the alert triggers. By default, alerts are scanned every five minutes, and the alert should be triggered whenever the alerts are scanned. When the alert triggers, a trap should be written to the location specified in step 2 (in this example, /tmp/snmptrap.log). Because the trap is sent to the local test receiver, this location is on the SAS Environment Manager Server machine.

19. Verify that snmptrapd on the recipient received the trap. The trap should be similar to the following:

   2015-03-13 11:00:23 ptnode24.ptest.sas.com [10.122.32.74] (via UDP: [10.122.32.74]:60162->[10.122.32.74]) TRAP, SNMP v1, community public
   SNMPv2-MIB::snmp.0.6 Cold Start Trap (0) Uptime: 0:00:00.00
   SNMPv2-MIB::snmp.0.6 = STRING: "SNMP trap example:SNMP trap example <host> File System Reads/Writes per Minute (433.0)

**Step 6: Change the Alert Settings to Send Traps to the Production Receiver**

20. After you verify that the alert works properly with the local trap receiver, you must change the settings in SAS Environment Manager to send traps to the production trap receiver. Contact your IT staff to determine the values for your organization’s production SNMP trap receiver. You will need to know the IP address and port for the receiver, as well as the OID value.

21. In SAS Environment Manager, select Manage ➔ Server Settings to edit the SNMP server configuration properties. Replace the test OID values with your production OID values.

22. Edit the alert definition in SAS Environment Manager. Change the alert conditions to specify the alert that you want to cause an SNMP notification. Specify your organization’s values for IP Address and OID and save the alert.

23. If you want to create more alerts with SNMP notification, create the alert normally and specify the values for the production SNMP trap receiver.
Manually Configuring HTTP Components and Applications

Creating Platform Services for Monitoring SAS Web Applications

You must create several platform services in order to monitor access to SAS web applications. This is the basic procedure for creating and configuring a platform service. If you enable SAS Environment Manager Extended Editing, these services are created automatically.

1. Select Resources ➔ Browse
2. Select Platforms.
3. Select the entry in the Platform table for your server.
5. Specify a name for the service and select HTTP in the Service Type field. Click OK.

6. The Details page for the new service page appears. A message is displayed that the resource has not been configured. Click the Configuration Properties link to configure the service.

7. On the Configuration Properties page, specify the information required for the service. Values for each service are provided in the following sections.
8. Click OK to complete the configuration process.

**Configuring a Platform Service for SAS Stored Process Web Application**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.

- **port**
  - specify 7980

- **path**
  - specify /SASStoredProcess

- **user**
  - specify a user name (such as sasdemo)

- **pass**
  - specify the password for the specified user

- **method**
  - select GET

- **follow**
  - select this check box

- **pattern**
  - specify SASStoredProcess

- **service.log.track.enable**
  - select this check box

- **service.log.track.level**
  - select Info

- **service.log.track.include**
  - specify Stored

**Configuring a Platform Service for SAS Content Server**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.
port
   specify 7980

path
   specify /SASContentServer

user
   specify sasadm@saspw

pass
   specify the password for the user

method
   select GET

follow
   select this check box

pattern
   specify SASContentServer

service.log.track.enable
   select this check box

service.log.track.level
   select Info

service.log.track.include
   specify Content

---

**Configuring a Platform Service for SAS Web Report Studio**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.

port
   specify 7980

path
   specify /SASWebReportStudio

user
   specify a user name (such as sasdemo)

pass
   specify the password for the user

method
   select GET

follow
   select this check box

pattern
   specify SASWebReportStudio

service.log.track.enable
   select this check box

service.log.track.level
   select Info
service.log.track.include
    specify Report

**Configuring a Platform Service for SAS BI Dashboard**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.

- **port**
  - specify 7980

- **path**
  - specify /SASBIDashboard

- **user**
  - specify a user name (such as sasdemo)

- **pass**
  - specify the password for the user

- **method**
  - select GET

- **follow**
  - select this check box

- **pattern**
  - specify SASBIDashboard

- **service.log.track.enable**
  - select this check box

- **service.log.track.level**
  - select Info

- **service.log.track.include**
  - specify Dashboard

**Configuring a Platform Service for SAS Help Viewer for Middle-Tier Applications**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.

- **port**
  - specify 7980

- **path**
  - specify /SASWebDoc

- **method**
  - select GET

- **follow**
  - select this check box

- **pattern**
  - specify SASWebDoc
service.log.track.enable
    select this check box

service.log.track.level
    select Info

service.log.track.include
    specify Documentation

**Configuring a Platform Service for SAS Information Delivery Portal**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.

**port**
    specify 7980

**path**
    specify /SASPortal

**user**
    specify a user name (such as sasdemo)

**pass**
    specify the password for the user

**method**
    select GET

**follow**
    select this check box

**pattern**
    specify SASPortal

**Configuring a Platform Service for SAS Web Administration Console**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.

**port**
    specify 7980

**path**
    specify /SASAdmin

**user**
    specify sasadm@saspw
pass
  specify the password for the user

method
  select GET

follow
  select this check box

pattern
  specify SASAdmin

service.log.track.enable
  select this check box

service.log.track.level
  select Info

service.log.track.include
  specify Administration

---

**Configuring a Platform Service for SAS Logon Manager**

Follow the steps in “Creating Platform Services for Monitoring SAS Web Applications” on page 141 to create the service. Specify the following information on the Configuration Properties page.

port
  specify 7980

path
  specify /SASLogon

user
  specify sasadm@saspw

pass
  specify the password for the user

method
  select GET

follow
  select this check box

pattern
  specify SASLogon

service.log.track.enable
  select this check box

service.log.track.level
  select Info

service.log.track.include
  specify Logon
Appendix 4

Data Mart Table Reference

About SAS Environment Manager Data Mart Tables .......................... 148

ACM Tables .................................................................................. 148
ACM.AVAILABILITY Table .............................................................. 148
ACM.FILEMOUNTS Table ................................................................. 148
ACM.GROUPINVENTORY Table ......................................................... 148
ACM.EVENTS Table ....................................................................... 149
ACM.HOSTPLATFORMS Table ........................................................... 149
ACM.HTTPCHECKS Table ................................................................. 150
ACM.IOMSERVERS Table ................................................................. 150
ACM.MEASUREINVENTORY Table ...................................................... 150
ACM.METADATASVR Table ............................................................... 150
ACM.NETWORKINTERFACE Table ..................................................... 151
ACM.RESOURCEINVENTORY Table ................................................. 151
ACM.SASAPPSERVERS Table ............................................................ 151
ACM.SASLOGICALSERVERS Table .................................................. 152
ACM.TCSSLERVERMGRS Table ......................................................... 152
ACM.WEBAPPSERVER Table ........................................................... 153
ACM.WIPDATADB Table ................................................................. 153

APM Tables .................................................................................. 153
ARTIFACT.ARTIFACTRELATIONSHIPS Table ................................... 153
ARTIFACT.ARTIFACTS Table ............................................................ 153
ARTIFACT.ARTIFACTSPHYSICALLOCATION Table ............................ 154
ARTIFACT.ARTIFACTUSAGEDETAILS Table ...................................... 154
ARTIFACT.ARTIFACTUSAGESESSIONS Table ..................................... 154
ARTIFACT.AUDIT_ACCESSC Table .................................................... 155
ARTIFACT.AUDIT_ADMUSER Table .................................................. 155
ARTIFACT.AUDIT_GROUP Table ....................................................... 155
ARTIFACT.AUDIT_TRANSACTIONS Table ......................................... 156
ARTIFACT.AUDITACCESSCONTROLDETAIL Table .......................... 156
ARTIFACT.AUDITIM Table ............................................................... 156
ARTIFACT.LIBRARIES Table ............................................................ 157
ARTIFACT.LOGSPROCESSED Table ................................................. 157
ARTIFACT.SERVERTYPEBYUSER Table .......................................... 157
ARTIFACT.SERVERUSAGEBYUSER Table ........................................ 157

Solution Kits Table ...................................................................... 158
KITS.EMI_INFO Table ................................................................. 158
KITS.HTTPACCESS ...................................................................... 158
KITS.SASJobs_INFO Table ............................................................. 159
KITS.VALASR_INFO ................................................................. 159
About SAS Environment Manager Data Mart Tables

The following topics contain an overview of the use and contents of the tables in the data mart. Although the topics list the columns in the tables that contain metric or inventory information, the tables also contain other columns that are not listed. Those columns provide information such as the date and time that a metric was recorded, the ID and name of the involved resource, and the time zone offset and shift for when the metric was recorded.

The columns listed for each table represent the metric and inventory data that is collected by default. If you use SAS Environment Manager to start collecting data for a metric that is not currently activated, a column for the new metric appears in the appropriate table. Even if you stop collecting data for a metric, the corresponding column remains in the data table to avoid losing the previously collected data.

ACM Tables

These tables are located in the directory [levelroot]/Web/SASEnvironmentManager/emi-framework/Datamart/acm.

**ACM.AVAILABILITY Table**

The ACM.AVAILABILITY table contains data about resource availability.

This table contains the following metric data columns:

- avail
- endtime
- starttime
- minutes

**ACM.FILEMOUNTS Table**

The ACM.FILEMOUNTS table contains usage data for the file mounts in your SAS environment. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

- diskWrites1m
- diskReads1m
- UsePercent
- TotFsFree
- Capacity
- DiskQueue
- DiskServiceTime
- DiskReadBytes1m
- DiskWriteBytes1m

**ACM.GROUPINVENTORY Table**

The ACM.GROUPINVENTORY table contains data about the resource groups that are defined in SAS Environment Manager.
This table contains the following inventory columns:

<table>
<thead>
<tr>
<th>id</th>
<th>desc</th>
<th>name</th>
</tr>
</thead>
</table>

**ACM.EVENTS Table**

The ACM.EVENTS table contains data about the events that are logged by SAS Environment Manager.

This table contains the following metric data columns:

<table>
<thead>
<tr>
<th>msg</th>
<th>resource_id</th>
</tr>
</thead>
<tbody>
<tr>
<td>fixdate</td>
<td>status</td>
</tr>
<tr>
<td>datetime</td>
<td>what</td>
</tr>
<tr>
<td>duration</td>
<td>who</td>
</tr>
<tr>
<td>eventType</td>
<td></td>
</tr>
</tbody>
</table>

**ACM.HOSTPLATFORMS Table**

The ACM.HOSTPLATFORMS table contains metrics for the platforms. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

<table>
<thead>
<tr>
<th>MemFree</th>
<th>PercentUsedSwap</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwapUsed</td>
<td>ZombieProcesses</td>
</tr>
<tr>
<td>CpuUsage</td>
<td>PercentFreeSwap</td>
</tr>
<tr>
<td>LoadAverage1</td>
<td>RunningProcesses</td>
</tr>
<tr>
<td>CpuSoftLrq</td>
<td>TcpInErrs1m</td>
</tr>
<tr>
<td>CpuStolen</td>
<td>SwapPagesOut1m</td>
</tr>
<tr>
<td>SwapFree</td>
<td>TcpPassiveOpens1m</td>
</tr>
<tr>
<td>TotalProcesses</td>
<td>TcpRetransSegs1m</td>
</tr>
<tr>
<td>CpuLrq</td>
<td>Commit1m</td>
</tr>
<tr>
<td>CpuSys</td>
<td>Write1m</td>
</tr>
<tr>
<td>CpuNice</td>
<td>TcpEstabResets1m</td>
</tr>
<tr>
<td>TcpOutboundConnections</td>
<td>Read1m</td>
</tr>
<tr>
<td>CpuIdle</td>
<td>TcpOutRsts1m</td>
</tr>
<tr>
<td>LoadAverage2</td>
<td>TcpAttemptFails1m</td>
</tr>
<tr>
<td>MemUsed</td>
<td>TcpActiveOpens1m</td>
</tr>
<tr>
<td>ActualMemUsed</td>
<td>SwapPagesIn1m</td>
</tr>
<tr>
<td>PercentFreeMemory</td>
<td>Access1m</td>
</tr>
<tr>
<td>PercentUsedMemory</td>
<td>FileSystemReadsWrites1m</td>
</tr>
<tr>
<td>CpuUser</td>
<td>SwapTotal</td>
</tr>
<tr>
<td>LoadAverage0</td>
<td>ActualMemFree</td>
</tr>
<tr>
<td>CpuWait</td>
<td>NumCPUs</td>
</tr>
<tr>
<td>TcpInboundConnections</td>
<td>MemTotal</td>
</tr>
</tbody>
</table>
**ACM.HTTPCHECKS Table**

The ACM.HTTPCHECKS table contains metric data for HTTP checks of web services. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

- AllInboundConnections
- ResponseTime
- InboundConnections
- OutboundConnections
- AllOutboundConnections
- ResponseCode
- StateTIME_WAIT
- LastModified

**ACM.IOMSERVERS Table**

This table is deprecated, beginning with SAS 9.4M3. The following reports, which are created from data from this table, are also deprecated:

- IOM Server Call Activity
- IOM Server Client Activity
- IOM Server Summary Reports
- IOM Total Calls and Time in Calls
- IOM Total Calls vs. Time in Calls

These reports should be deleted.

**ACM.MEASUREINVENTORY Table**

The ACM.MEASUREINVENTORY table contains data about the measurements that are being performed.

This table contains the following inventory columns:

- measurement_id
- UNITS
- resource_id
- type
- enabled
- MONITORABLE_TYPE_ID
- NAME
- category
- PLUGIN
- resource_desc
- ALIAS
- deleted

**ACM.METADATASVRS Table**

The ACM.METADATASVRS table contains metric data for the SAS Metadata Servers in the environment. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

- serverState
- ProcessShare
- ProcessEnd_Last_Time
- SystemTime
- HighestThreadCount
- health
ACM.NETWORKINTERFACE Table

The ACM.NETWORKINTERFACE table contains metric data for the network performance in your environment. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

- BitsIn1s
- PacketsOut1m
- BitsOut1m
- PacketsOut1m
- RxErrors1m
- TxErrors1m

ACM.RESOURCEINVENTORY Table

The ACM.RESOURCEINVENTORY table contains information about the resources in the SAS Environment Manager inventory.

This table contains the following inventory columns:

- ID
- desc
- platformResource
- serverResource
- serviceResource
- name
- type
- prototype
- invLevel
- shortname
- deleted

ACM.SASAPPSERVERS Table

The ACM.SASAPPSERVERS table contains metric data for SAS Application Server resources. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:
ServerState  NumProcesses
UnauthorizedAccesses  TotalClients1m
LastAccessState  CurrentClients
CurrentRunningServers_Local  Usage
ActivePeers  ResidentMemSize
CurrentPendingClients  MemSize
TotalWaitingTime  TotalTime1m
CurrentWaitingClients  UserTime1m
CurrentConnectedClients  SystemTime1m
TotalTimedOutClients  TimeInCalls1m
CurrentWaitingClients_Local  TotalCalls1m
CurrentRunningServers

**ACM.SASLOGICALSERVERS Table**

The ACM.SASLOGICALSERVERS table contains metric data for SAS logical server resources. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

ServerState  NumProcesses
UnauthorizedAccesses  TotalClients1m
LastAccessState  CurrentClients
CurrentRunningServers_Local  Usage
ActivePeers  ResidentMemSize
CurrentPendingClients  MemSize
TotalWaitingTime  TotalTime1m
CurrentWaitingClients  UserTime1m
CurrentConnectedClients  SystemTime1m
TotalTimedOutClients  TimeInCalls1m
CurrentWaitingClients_Local  TotalCalls1m
CurrentRunningServers

**ACM.TCSSERVERMGRS Table**

The ACM.TCSSERVERMGRS table contains metric data for tcServers in the system. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

rejectedSessions1m  activeSessions
sessionCreateRate  sessionExpireRate
sessionAverageAliveTime  processingTime
**ACM.WEBAPPSERVER Table**

The ACM.WEBAPPSERVER table contains metric data for SAS web applications. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

- HeapMemoryMax
- HeapMemoryUsed
- HeapMemoryFree
- DeadlocksDetected
- PercentUpTimeInGarbageCollection
- OpenFileDescriptionCount
- Uptime
- ThreadCount1m
- HeapMemoryCommitted

**ACM.WIPDATADB Table**

The ACM.WIPDATADB table contains metric data for the SAS Web Infrastructure Platform. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

- DataSpaceUsed
- seq_scan1m
- idx_tup_read1m
- idx_blks_read1m
- tup_fetched1s
- xact_rollbacks1s
- numbackends
- xact_commit1s
- blks_hit_p
- blks_read1s
- granted_locks
- tup_altered1s

---

**APM Tables**

These tables are located in the directory [levelroot]/Web/SASEnvironmentManager/emi-framework/Datamart/artifacts.

**ARTIFACT.ARTIFACTRELATIONSHIPS Table**

The ARTIFACT.ARTIFACTRELATIONSHIPS table contains information about the relationships between artifacts that are defined in other tables.

By default, this table contains the following metric data columns:

- artifact1
- relationshipSubType
- artifact2
- distance
- relationshipType
- _loadtm

**ARTIFACT.ARTIFACTS Table**

The ARTIFACT.ARTIFACTS table contains information about the artifacts (such as libraries, directories, and stored processes) in your environment.
By default, this table contains the following metric data columns:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>type</td>
</tr>
<tr>
<td>Name</td>
<td>_loadtm</td>
</tr>
<tr>
<td>Desc</td>
<td>path</td>
</tr>
<tr>
<td>Created</td>
<td>physicalPath</td>
</tr>
<tr>
<td>Updated</td>
<td>directoryName</td>
</tr>
</tbody>
</table>

**ARTIFACT.ARTIFACTSPHYSICALLOCATION Table**

The ARTIFACT.ARTIFACTSPHYSICALLOCATION table contains information about the physical location of artifacts.

By default, this table contains the following metric data columns:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>type</td>
</tr>
<tr>
<td>Name</td>
<td>_loadtm</td>
</tr>
<tr>
<td>Desc</td>
<td>path</td>
</tr>
<tr>
<td>Created</td>
<td>physicalPath</td>
</tr>
<tr>
<td>Updated</td>
<td>directoryName</td>
</tr>
</tbody>
</table>

**ARTIFACT.ARTIFACTUSAGEdetails Table**

The ARTIFACT.ARTIFACTUSAGEdetails table contains usage information about artifacts.

By default, this table contains the following metric data columns:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>HostName</td>
<td>endTimeUserCPUTime</td>
</tr>
<tr>
<td>TotalIOCount</td>
<td>hour</td>
</tr>
<tr>
<td>TotalMemoryUsage</td>
<td>level</td>
</tr>
<tr>
<td>_loadtm</td>
<td>measurementSubType</td>
</tr>
<tr>
<td>artifact</td>
<td>measurementType</td>
</tr>
<tr>
<td>artifactType</td>
<td>minute</td>
</tr>
<tr>
<td>client_context</td>
<td>parentUsage</td>
</tr>
<tr>
<td>currentUsage</td>
<td>sourceId</td>
</tr>
<tr>
<td>datetime</td>
<td>startSystemCPUTime</td>
</tr>
<tr>
<td>datetimeMinute</td>
<td>startUserCPUTime</td>
</tr>
<tr>
<td>dayOfMonth</td>
<td>stopSystemCPUTime</td>
</tr>
<tr>
<td>dayOfWeek</td>
<td>stopUserCPUTime</td>
</tr>
<tr>
<td>elapsedSystemCPUTime</td>
<td>subType</td>
</tr>
<tr>
<td>elapsedTime</td>
<td>type</td>
</tr>
<tr>
<td>elapsedTotalCPUTime</td>
<td>usageId</td>
</tr>
</tbody>
</table>

**ARTIFACT.ARTIFACTUSAGESESSIONS Table**

The ARTIFACT.ARTIFACTUSAGESESSIONS table contains usage information about artifacts in a session.

By default, this table contains the following metric data columns:
ARTIFACT.AUDIT_ACCESSC Table

The ARTIFACT.AUDIT_ACCESSC table contains audit records for object access events.

By default, this table contains the following metric data columns:

- A_ACT_Message
- A_ObjType
- A_ActiveUserid
- A_RecordEvent
- A_IdentityName
- A_RecordT
- A_Level
- A_Thread
- A_ObjID
- Log_Line
- A_IdentityTargetName
- A_ObjType
- A_IdentityTargetObjID
- A_IdentityTargetType
- A_Thread
- A_IdentityType
- Log_Line
- A_Level
- elapsedTime
- datetime
- datetimeMinute
- dayOfMonth
- type
- currentUsage
- sourceId
- parentUsage
- client_context
- subType
- dayOfWeek
- usageId
- stopdt
- minute
- level
- hour
- HostName

ARTIFACT.AUDIT_ADMUSER Table

The ARTIFACT.AUDIT_ADMUSER table contains audit information for the administrative user activities.

By default, this table contains the following metric data columns:

- A_ActiveUserid
- A_Thread
- A_Level
- Log_Line
- A_RecordT

ARTIFACT.AUDIT_GROUP Table

The ARTIFACT.AUDIT_GROUP table contains audit information for identity groups.

By default, this table contains the following metric data columns:

- A_ActiveUserid
- A_ObjID
- A_IdentityName
- A_ObjType
- A_IdentityTargetName
- A_RecordEvent
- A_IdentityTargetObjID
- A_IdentityTargetType
- A_Thread
- A_IdentityType
- Log_Line
- A_Level

ARTIFACT.AUDIT_ADMUSER Table

The ARTIFACT.AUDIT_ADMUSER table contains audit information for the administrative user activities.

By default, this table contains the following metric data columns:

- A_ActiveUserid
- A_Thread
- A_Level
- Log_Line
- A_RecordT
**ARTIFACT.AUDIT_TRANSACTIONS Table**

The ARTIFACT.AUDIT_TRANSACTIONS table contains audit information for transactions.

By default, this table contains the following metric data columns:

- A_ACT_Message
- A_MetaUserid
- A_ActiveUserid
- A_AuthDomain
- A_ClientID
- A_ClientIPAddr
- A_ClientPort
- A_IdentityName
- A_IdentityTargetName
- A_IdentityTargetObjID
- A_IdentityTargetType
- A_Thread
- A_IdentityType
- A_Log_File
- A_Log_Line

**ARTIFACT.AUDITACCESSCONTROLDETAIL Table**

The ARTIFACT.AUDITACCESSCONTROLDETAIL table contains detailed audit information about access requests.

By default, this table contains the following metric data columns:

- A_ActiveUserid
- A_ClientID
- A_ObjID
- A_Read
- A_ReadMetadata
- A_Administer
- A_References
- A_Alter_Table
- A_Select
- A_CheckInMetadata
- A_Update
- A_Create
- A_User_Group
- A_Create_Table
- A_Write
- A_Delete
- A_WriteMemberMetadata
- A_Drop_Table
- A_WriteMetadata
- A_Execute

**ARTIFACT.AUDITIM Table**

The ARTIFACT.AUDITIM table contains audit information recorded by time.

By default, this table contains the following metric data columns:

- A_ActiveUserid
- A_ObjID
- A_ActionID
- A_Path
- A_Action
- A_Map
- A_ActionType
- resourceType
SessionID webApp

**ARTIFACT.LIBRARIES Table**

The ARTIFACT.LIBRARIES table contains information about the SAS libraries in the environment.

By default, this table contains the following metric data columns:

- libname
- orapath
- ServerContext
- AuthDomain
- port
- AuthDomain
- tag
- hpath
- opt
- sqldatasrc

**ARTIFACT.LOGSPROCESSED Table**

The ARTIFACT.LOGSPROCESSED table contains the date and time when the APM ETL process last ran. The information in this table is used only for internal recordkeeping.

**ARTIFACT.SERVERTYPEBYUSER Table**

The ARTIFACT.SERVERTYPEBYUSER table contains information about server access.

By default, this table contains the following metric data columns:

- ServerType
- description
- ServerUser
- sourceId
- dayOfMonth
- user
- dayOfWeek

**ARTIFACT.SERVERUSAGEBYUSER Table**

The ARTIFACT.SERVERUSAGEBYUSER table contains usage information about SAS servers recorded by user.

By default, this table contains the following metric data columns:

- ServerType
- description
- ServerUser
- sourceId
- dayOfMonth
- user
- dayOfWeek
Solution Kits Table

These tables are located in the directory [levelroot]/Web/SASEnvironmentManager/emi-framework/Datamart/kits.

**KITS.EMI_INFO Table**

The KITS.EMI_INFO table contains metrics for SAS Environment Manager ETL processes. If the feed to SAS Visual Analytics is enabled, this table is copied to the drop zone.

By default, this table contains the following metric data columns:

- logfile
- blkinput
- stepname
- blkoutput
- step
- obsin
- hostname
- obsout
- portdate
- varsout
- platform
- memused
- scp
- osmem
- realtime
- sumsize
- usertime
- sortsize
- systime
- memsize
- pageflt
- jobname
- pagercl
- stepcnt
- pageswp
- pid
- osvconsw
- parm
- osiconsw

**KITS.HTTPACCESS**

The KITS.HTTPACCESS table contains metrics for the SAS Web Server.

By default, this table contains the following metric data columns:

- bytesreturned
- referer
- clientAddress
- rfc1413
- clientSoftware
- shift
- clientMethod
- statuscode
- clientsrc
- tzoneoff
- clientsubsric
- username
- datetime

*Note:* The SAS Environment Manager Service Architecture does not support monitoring of SAS Web Server access logs when HTTPS/TLS is enabled.
**KITS.SASJobs_INFO Table**

The KITS.SASJobs_INFO table contains metrics for SAS jobs.

By default, this table contains the following metric data columns:

- logfile
- stepname
- step
- hostname
- portdate
- platform
- scp
- realtime
- usertime
- systime
- pageflt
- pagercl
- pageswp
- osvconsw

**KITS.VALASR_INFO**

The KITS.VALASR_INFO table contains metrics for the SAS LASR Analytic Server.

By default, this table contains the following metric data columns:

- A_Date
- Action
- Client_Context
- LASRServer
- LASRTable
- StatusMsg
- UserName
- a_datetime

- datetime
- host
- id
- pid
- port
- runtime
- shift
- tzoneoff
Appendix 5

Service Architecture Alerts

The following alerts are defined when you initialize the SAS Environment Manager Service Architecture.

*Note:* Alerts that are triggered by comparison to a baseline value require that the metric for the alert be monitored long enough to first establish a baseline value.

### Table A5.1  Platform Alerts

<table>
<thead>
<tr>
<th>Resource</th>
<th>Alert name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>CPU Count</td>
<td>Triggered if the number of CPUs on the platform changes. This alert indicates a possible hardware problem.</td>
</tr>
<tr>
<td></td>
<td>CPU Usage &gt;70</td>
<td>Triggered if the overall CPU usage in the system exceeds 70%.</td>
</tr>
<tr>
<td></td>
<td>CPU Usage &gt;95</td>
<td>Triggered if the overall CPU usage in the system exceeds 95%.</td>
</tr>
<tr>
<td></td>
<td>Pct Free Memory</td>
<td>Triggered if the percentage of free memory falls below 20% of the maximum free memory.</td>
</tr>
<tr>
<td></td>
<td>Pct Free Swap</td>
<td>Triggered if the percentage of free swap memory falls below 20% of the maximum free swap memory.</td>
</tr>
</tbody>
</table>
|               | Swap Out Rate   | Triggered if the number of pages swapped out of memory exceeds 20% of the baseline value of page swaps.  
This alert indicates that your system is memory constrained. Swapping occurs when the system requires more memory than is physically available. |
<p>|               | TCP Attempt Fails | Triggered if the number of failed attempts to connect to the TCP service exceeds 20% of the baseline value of attempted connections. The number of failed attempts should normally be close to zero. |</p>
<table>
<thead>
<tr>
<th>Resource</th>
<th>Alert name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TCP In Errors</td>
<td>Triggered if the number of TCP interface errors exceeds 20% of the baseline value of TCP interface requests. The number of TCP interface errors should normally be close to zero.</td>
</tr>
<tr>
<td></td>
<td>Zombie Processes</td>
<td>Triggered if the number of zombie processes exceeds 20% of the baseline value of total processes. Zombie processes are processes that have completed execution but still have entries in the process table. This alert indicates an application problem.</td>
</tr>
<tr>
<td>Win32</td>
<td>CPU Count</td>
<td>Triggered if the number of CPUs on the platform changes. This alert indicates a possible hardware problem.</td>
</tr>
<tr>
<td></td>
<td>CPU Usage &gt;70</td>
<td>Triggered if the overall CPU usage in the system exceeds 70%.</td>
</tr>
<tr>
<td></td>
<td>CPU Usage &gt;95</td>
<td>Triggered if the overall CPU usage in the system exceeds 95%.</td>
</tr>
<tr>
<td></td>
<td>Pct Free Memory</td>
<td>Triggered if the percentage of free memory falls below 20% of the maximum free memory.</td>
</tr>
<tr>
<td></td>
<td>Pct Free Swap</td>
<td>Triggered if the percentage of free swap memory falls below 20% of the maximum free swap memory.</td>
</tr>
<tr>
<td></td>
<td>Swap Out Rate</td>
<td>Triggered if the number of pages swapped out of memory exceeds 20% of the baseline value of page swaps. This alert indicates that your system is memory constrained. Swapping occurs when the system requires more memory than is physically available.</td>
</tr>
<tr>
<td></td>
<td>TCP Attempt Fails</td>
<td>Triggered if the number of failed attempts to connect to the TCP service exceeds 20% of the baseline value of attempted connections. The number of failed attempts should normally be close to zero.</td>
</tr>
<tr>
<td></td>
<td>TCP In Errors</td>
<td>Triggered if the number of TCP interface errors exceeds 20% of the baseline value of TCP interface requests. The number of TCP interface errors should normally be close to zero.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Zombie Processes</td>
<td>Triggered if the number of zombie processes exceeds 20% of the baseline value of total processes. Zombie processes are processes that have completed execution but still have entries in the process table. This alert indicates an application problem.</td>
<td></td>
</tr>
<tr>
<td>AIX</td>
<td>CPU Count</td>
<td>Triggered if the number of CPUs on the platform changes. This alert indicates a possible hardware problem.</td>
</tr>
<tr>
<td></td>
<td>CPU Usage &gt;70</td>
<td>Triggered if the overall CPU usage in the system exceeds 70%.</td>
</tr>
<tr>
<td></td>
<td>CPU Usage &gt;95</td>
<td>Triggered if the overall CPU usage in the system exceeds 95%.</td>
</tr>
<tr>
<td></td>
<td>Pct Free Memory</td>
<td>Triggered if the percentage of free memory falls below 20% of the maximum free memory.</td>
</tr>
<tr>
<td></td>
<td>Pct Free Swap</td>
<td>Triggered if the percentage of free swap memory falls below 20% of the maximum free swap memory.</td>
</tr>
<tr>
<td></td>
<td>Swap Out Rate</td>
<td>Triggered if the number of pages swapped out of memory exceeds 20% of the baseline value of page swaps. This alert indicates that your system is memory constrained. Swapping occurs when the system requires more memory than is physically available.</td>
</tr>
<tr>
<td></td>
<td>TCP Attempt Fails</td>
<td>Triggered if the number of failed attempts to connect to the TCP service exceeds 20% of the baseline value of attempted connections. The number of failed attempts should normally be close to zero.</td>
</tr>
<tr>
<td></td>
<td>TCP In Errors</td>
<td>Triggered if the number of TCP interface errors exceeds 20% of the baseline value of TCP interface requests. The number of TCP interface errors should normally be close to zero.</td>
</tr>
<tr>
<td></td>
<td>Zombie Processes</td>
<td>Triggered if the number of zombie processes exceeds 20% of the baseline value of total processes. Zombie processes are processes that have completed execution but still have entries in the process table. This alert indicates an application problem.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAS Application Server Tier</td>
<td>Metadata Cluster Avail</td>
<td>Triggered if the availability of the SAS Metadata Server cluster falls below 100%.</td>
</tr>
<tr>
<td></td>
<td>Metadata Quorum Chg</td>
<td>Triggered if the SAS Metadata Server cluster is not in quorum.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table A5.2 Server Alerts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>HQ Agent</td>
<td>HQ Agent ERROR message in log</td>
<td>Triggered if an error message appears in the HQ agent log.</td>
</tr>
<tr>
<td></td>
<td>HQ Agent Memory</td>
<td>Triggered if the JVM free memory for the HQ agent falls below 14.3 MB.</td>
</tr>
<tr>
<td></td>
<td>HQ Time Agent Spends Fetching Metrics</td>
<td>Triggered if the time that the HQ agent spends collecting metric data exceeds five seconds per minute. This alert might indicate an overloaded agent or a problem with the scheduling thread. These problems might be present even with values for this metric greater than 3 or 4 seconds per minute.</td>
</tr>
<tr>
<td>PostgreSQL 9.x</td>
<td>PostgreSQL 9.x - Availability</td>
<td>Triggered if the availability of PostgreSQL falls below 100%.</td>
</tr>
<tr>
<td></td>
<td>pg: Buffer Hits % &lt;50% of Max</td>
<td>Triggered if the number of buffer hits is less than 50% of the total block read requests. A buffer hit is a block read request that is avoided because the block is in the buffer cache). This alert might indicate that more system memory is needed or that you need to adjust the shared buffers.</td>
</tr>
<tr>
<td></td>
<td>pg: Commits per Second &gt;20</td>
<td>Triggered if the number of commits to PostgreSQL is greater than 20 per second. This alert indicates that you might need to provide a durable write cache to prevent potential data loss.</td>
</tr>
<tr>
<td></td>
<td>pg: Connection Usage &gt;80% of Max</td>
<td>Triggered if the number of connections used is greater than 80% of the maximum number allowed. This alert indicates that you might need to increase the maximum number of available connections in order to prevent denial of service.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>pg: Memory Size</td>
<td>changed</td>
<td>Triggered if the memory used by PostgreSQL falls below 90% of the baseline value. If this condition is met, the alert is triggered once every 12 hours.</td>
</tr>
<tr>
<td>SAS Config Level Directory 9.4</td>
<td>SASConfig Disk Use % &gt; 95</td>
<td>Triggered if the volume that contains the SASConfig directory is more than 95% full.</td>
</tr>
<tr>
<td>SAS Connect Spawner 9.4</td>
<td>Connect Spawner Health % &lt; 100</td>
<td>Triggered if the health of the SAS Connect Spawner falls below 100%. This metric is the equivalent of the Validate command in SAS Management Console, and confirms that the server is responding.</td>
</tr>
<tr>
<td>SAS Home Directory 9.4</td>
<td>SASHome Disk Use % &gt; 95</td>
<td>Triggered if the volume that contains the SASHome directory is more than 95% full.</td>
</tr>
<tr>
<td>SAS Metadata Server 9.4</td>
<td>Metadata - Availability</td>
<td>Triggered if the availability of the SAS Metadata Server falls below 100%.</td>
</tr>
<tr>
<td></td>
<td>Metadata Major (page) Faults</td>
<td>Triggered if the number of page faults that require disk activity is above 10% of the baseline value of total page faults. This alert might indicate a memory constraint that is causing slow performance.</td>
</tr>
<tr>
<td></td>
<td>Metadata Server ERROR message in log</td>
<td>Triggered if an error message appears in the SAS Metadata Server log.</td>
</tr>
<tr>
<td></td>
<td>Metadata Server Health % &lt; 100</td>
<td>Triggered if the health of the SAS Metadata Server falls below 100%. This metric is the equivalent of the Validate command in SAS Management Console, and confirms that the server is responding.</td>
</tr>
<tr>
<td></td>
<td>Metadata Time in Calls per Minute</td>
<td>Triggered if the time taken by calls to the SAS Metadata Server exceeds 300% of the baseline value of calls to the server. This alert might be an indication of slow performance.</td>
</tr>
<tr>
<td></td>
<td>Metadata User Lockout</td>
<td>Triggered if the message “locked out due to excessive log on failures” appears in the SAS Metadata Server log.</td>
</tr>
<tr>
<td>SAS OLAP Server 9.4</td>
<td>OLAP - Availability</td>
<td>Triggered if the availability of the OLAP server falls below 100%.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>OLAP Server</td>
<td>ERROR message in log</td>
<td>Triggered if an error message appears in the OLAP server log.</td>
</tr>
<tr>
<td>OLAP Server Health % &lt; 100</td>
<td>Triggered if the health of the OLAP server falls below 100%. This metric is the equivalent of the <strong>Validate</strong> command in SAS Management Console, and confirms that the server is responding.</td>
<td></td>
</tr>
<tr>
<td>OLAP Server User Lockout</td>
<td>Triggered if the message “locked out due to excessive log on failures” appears in the OLAP server log.</td>
<td></td>
</tr>
<tr>
<td>SAS Object Spawner 9.4</td>
<td>Object Spawner ERROR message in log</td>
<td>Triggered if an error message appears in the SAS Object Spawner log.</td>
</tr>
<tr>
<td>Object Spawner User Lockout</td>
<td>Triggered if the message “locked out due to excessive log on failures” appears in the SAS Object Spawner log.</td>
<td></td>
</tr>
<tr>
<td>Object Spawner - Availability</td>
<td>Triggered if the availability of the SAS Object Spawner falls below 100%.</td>
<td></td>
</tr>
<tr>
<td>Object Spawner Failed Connections</td>
<td>Triggered if the SAS Object Spawner fails to spawn a server.</td>
<td></td>
</tr>
<tr>
<td>Object Spawner Major (page) Faults</td>
<td>Triggered if the number of page faults that require disk activity is above 10% of the baseline value of total page faults. This alert might indicate a memory constraint that is causing slow performance.</td>
<td></td>
</tr>
<tr>
<td>Object Spawner Server Health % &lt; 100</td>
<td>Triggered if the health of the SAS Object Spawner falls below 100%. This metric is the equivalent of the <strong>Validate</strong> command in SAS Management Console, and confirms that the server is responding.</td>
<td></td>
</tr>
<tr>
<td>SAS SMP LASR Server</td>
<td>LASR SMP Major (page) Faults</td>
<td>Triggered if the number of page faults that require disk activity is above 10% of the baseline value of total page faults. This alert might indicate a memory constraint that is causing slow performance.</td>
</tr>
<tr>
<td>SMP LASR - Availability</td>
<td>Triggered if the availability of the SAS LASR Analytic Server falls below 100%.</td>
<td></td>
</tr>
</tbody>
</table>
### Resource Alert Definitions

<table>
<thead>
<tr>
<th>Resource</th>
<th>Alert name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS System Info</td>
<td>EMI Event Log Alert</td>
<td>This alert is a template for detecting a string in the EMI Events log (sasev.events). This log contains messages generated by the SAS Environment Manager application. Through the use of macros, you can also write log messages from SAS applications to this log. To have the alert trigger when a specific string appears in the log, edit the alert and replace the string “match this text” with the string that you want to use.</td>
</tr>
<tr>
<td>SpringSource tc</td>
<td>Deadlocks Detected</td>
<td>Triggered if a deadlock is detected. A deadlock occurs when multiple actions are waiting for the other to complete, so none of the actions ever finish.</td>
</tr>
<tr>
<td>Runtime 6.0</td>
<td>Excessive Time Spent in Garbage Collection</td>
<td>Triggered if the amount of time spent in garbage collection exceeds 40% of the total process time.</td>
</tr>
<tr>
<td>SpringSource tc</td>
<td>Deadlocks Detected</td>
<td>Triggered if a deadlock is detected. A deadlock occurs when multiple actions are waiting for the other to complete, so none of the actions ever finish.</td>
</tr>
<tr>
<td>Runtime 7.0</td>
<td>Excessive Time Spent in Garbage Collection</td>
<td>Triggered if the amount of time spent in garbage collection exceeds 40% of the total process time.</td>
</tr>
<tr>
<td></td>
<td>Webapp CPU Time in Garbage Collection &gt; 30%</td>
<td>Triggered if the amount of time spent in garbage collection exceeds 30% of the total process time.</td>
</tr>
<tr>
<td></td>
<td>Webapp Heap Free Memory &lt; 5% of Max</td>
<td>Triggered if the free JVM heap memory falls below 5% of the total memory. It is recommended that you have a minimum of 400MB of free heap space (calculated after garbage collection).</td>
</tr>
<tr>
<td>vFabric Web Server 5.2</td>
<td>Web Server: Apache Idle Workers &lt;20</td>
<td>Triggered if the number of available idle workers falls below 20% of the maximum number of workers. If no idle workers are available, a service interrupt occurs.</td>
</tr>
</tbody>
</table>

#### Table A5.3 Service Alerts

<table>
<thead>
<tr>
<th>Resource</th>
<th>Alert name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileServer Mount</td>
<td>File Mount Use Pct</td>
<td>Triggered if the percentage of space used on the file mount exceeds 95%.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HTTP</td>
<td>HTTP Response Server Error Code =&gt; 500</td>
<td>Triggered if the response code for an HTTP service ping is greater than 500, indicating an error. Possible response codes are: 500 Unexpected Error, 501 Does Not Support, 502 Overload, 503 Gateway Timeout</td>
</tr>
<tr>
<td>Network Server Interface</td>
<td>NetIF Rcv Dropped</td>
<td>Triggered if the number of dropped network receive packets exceeds 20% of the baseline value of total network receive packets. This alert requires that the metrics be monitored long enough to establish a baseline value of network packets for your system.</td>
</tr>
<tr>
<td></td>
<td>NetIF Rcv Errors</td>
<td>Triggered if the number of network receive errors exceeds 20% of the baseline value of total network attempts. This alert requires that the metrics be monitored long enough to establish a baseline value of network traffic for your system.</td>
</tr>
<tr>
<td></td>
<td>NetIF Tx Collisions</td>
<td>Triggered if the number of network interface transmit collisions exceeds 20% of the baseline value of total network attempts. This alert requires that the metrics be monitored long enough to establish a baseline value of network traffic for your system.</td>
</tr>
<tr>
<td>HQ Agent</td>
<td>HQ Agent ERROR message in log</td>
<td>Triggered if an error message appears in the HQ agent log.</td>
</tr>
<tr>
<td></td>
<td>HQ Agent Memory</td>
<td>Triggered if the JVM free memory for the HQ agent falls below 14.3 MB.</td>
</tr>
<tr>
<td></td>
<td>HQ Time Agent Spends Fetching Metrics</td>
<td>Triggered if the time that the HQ agent spends collecting metric data exceeds five seconds per minute. This alert might indicate an overloaded agent or a problem with the scheduling thread. These problems might be present even with values for this metric greater than 3 or 4 seconds per minute.</td>
</tr>
<tr>
<td>PostgreSQL 9.x</td>
<td>PostgreSQL 9.x - Availability</td>
<td>Triggered if the availability of PostgreSQL falls below 100%.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>pg: Buffer Hits % &lt;50% of Max</td>
<td>Triggered if the number of buffer hits is less than 50% of the total block read requests. (A buffer hit is a block read request that is avoided because the block is in the buffer cache). This alert might indicate that more system memory is needed or that you need to adjust the shared buffers.</td>
<td></td>
</tr>
<tr>
<td>pg: Commits per Second &gt;20</td>
<td>Triggered if the number of commits to PostgreSQL is greater than 20 per second. This alert indicates that you might need to provide a durable write cache to prevent potential data loss.</td>
<td></td>
</tr>
<tr>
<td>pg: Connection Usage &gt;80% of Max</td>
<td>Triggered if the number of connections used is greater than 80% of the maximum number allowed. This alert indicates that you might need to increase the maximum number of available connections in order to prevent denial of service.</td>
<td></td>
</tr>
<tr>
<td>pg: Memory Size changed</td>
<td>Triggered if the memory used by PostgreSQL falls below 90% of the baseline value. If this condition is met, the alert is triggered once every 12 hours.</td>
<td></td>
</tr>
<tr>
<td>SAS Environment Manager Data Mart 9.4 ACM ETL Processing</td>
<td>Data Mart ACM ETL</td>
<td>Triggered if the availability of the ACM ETL process falls below 100%.</td>
</tr>
<tr>
<td>SAS Environment Manager Data Mart 9.4 APM ETL Processing</td>
<td>Data Mart APM ETL</td>
<td>Triggered if the availability of the APM ETL process falls below 100%.</td>
</tr>
<tr>
<td>SAS Environment Manager Data Mart 9.4 Kits ETL Processing</td>
<td>Data Mart Kits ETL</td>
<td>Triggered if the availability of the kits ETL process falls below 100%.</td>
</tr>
<tr>
<td>SAS Home Directory 9.4 SAS Directory</td>
<td>SASWork Disk Use % &gt; 70</td>
<td>Triggered if the volume that contains the SASWork directory is more than 70% full.</td>
</tr>
<tr>
<td>SAS Home Directory 9.4 SAS Directory</td>
<td>SASWork Disk Use % &gt; 95</td>
<td>Triggered if the volume that contains the SASWork directory is more than 95% full.</td>
</tr>
<tr>
<td>SAS Object Spawner 9.4 SAS Logical Pooled Workspace Server</td>
<td>Logical Pooled Workspace Server Timed Out Clients</td>
<td>Triggered if there are any failed connections between the logical pooled workspace server and applications that are trying to connect to the server.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Logical Pooled Workspace Server Unauthorized Accesses</td>
<td>Triggered if there are any unauthorized accesses to the logical pooled workspace server.</td>
<td></td>
</tr>
<tr>
<td>SAS Object Spawner 9.4 SAS Logical Stored Process Server Logical Stored Process Server Timed Out Clients</td>
<td>Triggered if there are any failed connections between the logical stored process server and applications that are trying to connect to the server.</td>
<td></td>
</tr>
<tr>
<td>Logical Stored Process Server Unauthorized Accesses</td>
<td>Triggered if there are any unauthorized accesses to the logical stored process server.</td>
<td></td>
</tr>
<tr>
<td>SAS Object Spawner 9.4 SAS Logical Workspace Server Logical Workspace Server Unauthorized Accesses</td>
<td>Triggered if there are any unauthorized accesses to the logical workspace server.</td>
<td></td>
</tr>
<tr>
<td>SAS Object Spawner 9.4 SAS Pooled Workspace Server Pooled Workspace Server ERROR message in log</td>
<td>Triggered if an error message appears in the pooled workspace server log.</td>
<td></td>
</tr>
<tr>
<td>SAS Object Spawner 9.4 SAS Workspace Server Workspace Server ERROR message in log</td>
<td>Triggered if an error message appears in the workspace server log.</td>
<td></td>
</tr>
<tr>
<td>Spring Insight Application Application error rate is high</td>
<td>Triggered if the application error rate for the past five minutes exceeds 10%.</td>
<td></td>
</tr>
<tr>
<td>SpringSource tc Runtime 6.0 Thread Diagnostics Context Slow or Failed Request</td>
<td>Triggered if a record is written to the log for the service. This alert indicates that a request is taking too long or has failed.</td>
<td></td>
</tr>
<tr>
<td>SpringSource tc Runtime 6.0 Thread Diagnostics Engine Slow or Failed Request</td>
<td>Triggered if a request is taking too long or has failed, which is indicated by an entry appearing in the service’s log.</td>
<td></td>
</tr>
<tr>
<td>SpringSource tc Runtime 6.0 Thread Diagnostics Host Slow or Failed Request</td>
<td>Triggered if a record is written to the log for the service. This alert indicates that a request is taking too long or has failed.</td>
<td></td>
</tr>
<tr>
<td>SpringSource tc Runtime 6.0 Tomcat JDBC Connection Pool Context JDBC Connection Abandoned</td>
<td>Triggered if a JDBC connection was abandoned, identified by a “CONNECTION ABANDONED” entry in the log.</td>
<td></td>
</tr>
<tr>
<td>JDBC Connection Failed</td>
<td>Triggered if a JDBC connection failed, identified by a “CONNECTION FAILED” entry in the log.</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>JDBC Query Failed</td>
<td>Triggered if a JDBC query failed, identified by a “FAILED QUERY” entry in the log.</td>
</tr>
<tr>
<td></td>
<td>Slow JDBC Query</td>
<td>Triggered if some JDBC queries are taking a long time to execute, identified by a “SLOW QUERY” entry in the log.</td>
</tr>
<tr>
<td>SpringSource tc Runtime 6.0 Tomcat JDBC Connection Pool Global</td>
<td>JDBC Connection Abandoned</td>
<td>Triggered if a JDBC connection was abandoned, identified by a “CONNECTION ABANDONED” entry in the log.</td>
</tr>
<tr>
<td></td>
<td>JDBC Connection Failed</td>
<td>Triggered if a JDBC query failed, identified by a “FAILED QUERY” entry in the log.</td>
</tr>
<tr>
<td></td>
<td>JDBC Query Failed</td>
<td>Triggered if a JDBC query failed, identified by a “FAILED QUERY” entry in the log.</td>
</tr>
<tr>
<td></td>
<td>Slow JDBC Query</td>
<td>Triggered if some JDBC queries are taking a long time to execute, identified by a “SLOW QUERY” entry in the log.</td>
</tr>
<tr>
<td>SpringSource tc Runtime 7.0 Executor</td>
<td>Webapp Active Thread Count &gt;250</td>
<td>Triggered if the number of active threads exceeds 250, which indicates heavy use. You can add additional servers to provide load balancing. The maximum number of threads allowed is 300, and the minimum is 50. If the number of active threads exceeds 300, the thread queue resets to 100, and then additional threads are refused.</td>
</tr>
<tr>
<td>SpringSource tc Runtime 7.0 Manager</td>
<td>Webapp Manager Rejected Sessions</td>
<td>Triggered if the number of rejected sessions exceeds 10% of the baseline number of sessions.</td>
</tr>
<tr>
<td>SpringSource tc Runtime 7.0 Thread Diagnostics Context</td>
<td>Slow or Failed Request</td>
<td>Triggered if a record is written to the log for the service. This alert indicates that a request is taking too long or has failed.</td>
</tr>
<tr>
<td>SpringSource tc Runtime 7.0 Thread Diagnostics Engine</td>
<td>Slow or Failed Request</td>
<td>Triggered if a record is written to the log for the service. This alert indicates that a request is taking too long or has failed.</td>
</tr>
<tr>
<td>SpringSource tc Runtime 7.0 Thread Diagnostics Host</td>
<td>Slow or Failed Request</td>
<td>Triggered if a record is written to the log for the service. This alert indicates that a request is taking too long or has failed.</td>
</tr>
<tr>
<td>Resource</td>
<td>Alert name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SpringSource tc</td>
<td>JDBC Connection</td>
<td>Triggered if a JDBC connection was abandoned, identified by a “CONNECTION</td>
</tr>
<tr>
<td>Runtime 7.0 Tomcat</td>
<td>Abandoned</td>
<td>ABANDONED” entry in the log.</td>
</tr>
<tr>
<td>JDBC Connection Pool</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Context</td>
<td>JDBC Connection</td>
<td>Triggered if a JDBC connection failed, identified by a “CONNECTION FAILED”</td>
</tr>
<tr>
<td></td>
<td>Failed</td>
<td>entry in the log.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>JDBC Query Failed</td>
<td>Triggered if a JDBC query failed, identified by a “FAILED QUERY” entry in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the log.</td>
</tr>
<tr>
<td></td>
<td>Slow JDBC Query</td>
<td>Triggered if some JDBC queries are taking a long time to execute, identified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>by a “SLOW QUERY” entry in the log.</td>
</tr>
<tr>
<td>SpringSource tc</td>
<td>JDBC Connection</td>
<td>Triggered if a JDBC connection was abandoned, identified by a “CONNECTION</td>
</tr>
<tr>
<td>Runtime 7.0 Tomcat</td>
<td>Abandoned</td>
<td>ABANDONED” entry in the log.</td>
</tr>
<tr>
<td>JDBC Connection Pool</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global</td>
<td>JDBC Connection</td>
<td>Triggered if a JDBC connection failed, identified by a “CONNECTION FAILED”</td>
</tr>
<tr>
<td></td>
<td>Failed</td>
<td>entry in the log.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>JDBC Query Failed</td>
<td>Triggered if a JDBC query failed, identified by a “FAILED QUERY” entry in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the log.</td>
</tr>
<tr>
<td></td>
<td>Slow JDBC Query</td>
<td>Triggered if some JDBC queries are taking a long time to execute, identified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>by a “SLOW QUERY” entry in the log.</td>
</tr>
<tr>
<td></td>
<td>Application health</td>
<td>Triggered if the application health metric (measured over the past five</td>
</tr>
<tr>
<td></td>
<td>is degrading</td>
<td>minutes) falls below 85%.</td>
</tr>
</tbody>
</table>
Appendix 6
Disabling the ACM and APM ETL Processes

Disabling the ACM ETL Process ........................................ 173
Disabling the APM ETL Process ........................................ 174
Disabling Both the ACM and APM ETL Processes ................. 176

Disabling the ACM ETL Process

Follow these steps to completely disable the ACM ETL processes. These steps disable ACM data collection and processing.

1. Turn off execution of the ETL processes in SAS Environment Manager.
   a. In SAS Environment Manager, select Resources ➜ Browse.
   b. Select Services.
   c. Select the ACM ETL Processing service.
   d. Select Tools Menu ➜ Configure Service
   e. In the run.enable menu, select false.
   f. Click OK.

2. Turn off the ACM-enabled flag for Service Architecture Extended Monitoring. On the Enablement Kit Server machine, run the appropriate command for your operating system to turn off the flags.

   UNIX command:
   `<SAS_Config>/Lev/n/Web/SASEnvironmentManager/emi-framework/bin/emi_init.sh --disable ACM`

   Windows command
   `<SAS_Config>\Lev\n\Web\SASEnvironmentManager\emi-framework\bin\emi_init.bat --disable ACM`
Disabling the APM ETL Process

Follow these steps to completely disable all APM ETL processes. These steps disable APM data collection and processing and remove the metadata changes that are required in order for data to be collected.

1. Turn off execution of the ETL processes in SAS Environment Manager. Follow these steps:
   a. In SAS Environment Manager, select Resources ⇒ Browse.
   b. Select Services.
   c. Select the APM ETL Processing service.
   d. Select Tools Menu ⇒ Configure Service
   e. In the run.enable menu, select false.
   f. Click OK.
   g. Repeat steps c through f for the Log Centralization service.
   h. Repeat steps c through f for each <host_name> Log Collection service. There is a separate service for each host that has a unique log configuration directory.

2. Turn off the APM-enabled flag for the Service Architecture Extended Monitoring. On the Enablement Kit Server machine, run the appropriate command for your operating system to turn off the flags.
   UNIX command:
   `<SAS_Config>/Lev/In/Web/SASEnvironmentManager/emi-framework/bin/emi_init.sh --disable APM`
   Windows command
   `<SAS_Config>\Lev\In\Web\SASEnvironmentManager\emi-framework\bin\emi_init.bat --disable APM`

3. Undo the changes made to the metadata configuration of the application servers when APM ETL was installed and configured. Follow these steps:
   a. Log on to SAS Management Console as sasadm@saspw.
   b. Expand the Server Manager plug-in.
   c. Expand an application server context (for example, SASApp) and locate the Logical Stored Process Server and Logical Pooled Workspace Server listings for the server context.
   d. Right-click on the Logical Stored Process Server and select Properties from the context menu.
   e. On the Options tab, select Set Server Properties to open the Server Properties window.
   f. Select the Request tab.
   g. Delete the contents of the Initialization program and Termination program fields. Click OK.
   h. Click OK in the Properties window.
i. Repeat steps d through h (omitting step f) for every Logical Pooled Workspace Server and Logical Stored Process Server entry in every application server context.

4. Remove the call of macro %apm_armsetup from the application server context configuration.
   a. On the compute host, navigate to the SAS configuration directory for the compute tier.
   b. In the Lev directory (for example, Lev1), identify the application server context directories (such as SASApp).
   c. Navigate to the first application server context directory and make a backup copy of the file appserver_autoexec_usermods.sas.
   d. Edit the file appserver_autoexec_usermods.sas. Remove the lines /* EMI_BEGIN */ and /* EMI_END */ and everything between the two lines.
   e. Repeat steps c and d for every application server context.

5. Remove the custom log configuration setup for each server process.
   a. On the SAS Metadata Server host machine, navigate to the SAS configuration directory for the metadata tier for the host.
   b. Navigate to the directory .../Lev/SASMeta/MetadataServer.
   c. Make a backup copy of the file sasv9_usermods.cfg.
   d. Edit the file sasv9_usermods.cfg.
   e. Remove the lines /* EMI_BEGIN */ and /* EMI_END */ and everything between the two lines.
   f. Restart the SAS Metadata Server instance.
      For UNIX, run these commands:
      
      `<SAS_Config>/Lev/SASMeta/Metadataserver.sh stop`
      `<SAS_Config>/Lev/SASMeta/Metadataserver.sh start`
      
      For Windows, run these commands:
      
      `<SAS_Config>\Lev\SASMeta\MetadataServer.bat stop`
      `<SAS_Config>\Lev\SASMeta\MetadataServer.bat start`
   g. If you are using a metadata cluster, perform steps c through f for each SAS Metadata Server configuration directory.
   h. On your compute host, repeat steps c through e for each server directory in each application server context directory (for example, SASApp/BatchServer).

6. Undo the changes made to the object spawner configuration when APM ETL was installed and configured. Follow these steps:
   a. On your compute host, navigate to the SAS configuration directory for the compute tier.
   b. In the Lev directory (for example, Lev1), identify the object spawner directories (for example, /ObjectSpawner).
   c. Locate the existing backup of the logconfig.xml file, which is named logconfig.xml_<date>_<time>.
   d. Rename the current logconfig.xml file to a backup name.
e. Rename the previous backup file to `logconfig.xml`.

f. Rename the `emi_configured.txt` file to a backup name.

7. Restart the object spawner. On each compute host that runs an object spawner, restart the spawner using the commands below. If multiple object spawner directories exist, run these commands for each directory.

For UNIX, run these commands:
```bash
<SAS_Config>/Lev/ObjectSpawner/ObjectSpawner.sh stop
<SAS_Config>/Lev/ObjectSpawner/ObjectSpawner.sh start
```

For Windows, run these commands:
```bash
<SAS_Config>\Lev\ObjectSpawner\ObjectSpawner.bat stop
<SAS_Config>\Lev\ObjectSpawner\ObjectSpawner.bat start
```

---

**Disabling Both the ACM and APM ETL Processes**

If you want to completely disable both the APM and ACM ETL processes, first follow all of the steps to disable the ACM ETL and the APM ETL.

- “Disabling the ACM ETL Process” on page 173
- “Disabling the APM ETL Process” on page 174

After you have completed all of the steps in those topics, follow these additional steps:

1. Reset all Service Architecture Extended Monitoring flags. On the Enablement Kit Server machine, run the appropriate command to reset the initialization flags, returning them all to false.
   
   On UNIX, run this command:
   ```bash
   <SAS_Config>/Lev/Web/SASEnvironmentManager/emi-framework/bin/emi_init.sh --resetFlags
   ```
   
   On Windows, run this command:
   ```bash
   <SAS_Config>\Lev\Web\SASEnvironmentManager\emi-framework\bin\emi_init.bat --resetFlags
   ```
   
2. Remove the ACT and the reports from metadata. This is an optional step.
   
   a. Log on to SAS Management Console as an administrator.
   
   b. Select the **Folders** tab and locate the **SAS Environment Manager** folder.
   
   c. Right-click the **SAS Environment Manager** folder and select **Delete**.
   
   d. Select the **Plug-Ins** tab and expand the **Authorization Manager** plug-in.
   
   e. Right-click on the **SAS Environment Manager Data Mart ACT** and select **Delete**.

3. Remove the SAS Environment Manager Data Mart. This is an optional step.

   On the Enablement Kit Server machine, delete the contents of each subdirectory in the directory `<SAS_Config>/Lev/Web/SASEnvironmentManager/emi-framework/Datamart`.

   Do not delete the contents of the `/Datamart` directory.

   Do not delete the `/Datamart` directory or any of the `/Datamart` subdirectories.
4. Remove the logs. This is an optional step.
   a. On the Enablement Kit Server machine, delete the files in the directory 
      \(<\text{SAS\_Config}/\text{Levn/Web/SASEnvironmentManager/emi-f}\text{ramework/Logs}\>.
   b. On the Enablement Kit Server machine, delete the contents of the directory 
      \(<\text{SAS\_Config}/\text{Levn/Web/SASEnvironmentManager/emi-f}\text{ramework/Logs/metrics}\>\), but do not delete the directory.
   c. On the Enablement Kit Server machine, delete the files in the directory 
      \(<\text{SAS\_Config}/\text{Levn/Web/SASEnvironmentManager/emi-f}\text{ramework/Archive}\>.
   d. In the compute tier configuration directory, delete the files in the directory 
      \(<\text{SAS\_Config}/\text{Levn/ObjectSpawner/AuditLogs}\>.
   e. In the compute tier configuration directory, delete the files in the \(/\text{PerfLogs}\) directory for each application server directory in each application server context directory (for example, \(<\text{SAS\_Config}/\text{Levn/SASApp/WorkspaceServer/PerfLogs}\>\).
   f. In the metadata tier configuration directory, delete the files in the 
      \(<\text{SAS\_Config}/\text{Levn/SASMeta/MetadataServer/AuditLogs}\>\) directory.

   If you are using a metadata cluster, you must delete the files in each metadata tier 
   configuration directory in the cluster.
Recommended Reading

Here is the recommended reading list for this title:

- The online Help for SAS Environment Manager 2.4.
- *SAS Intelligence Platform: Middle-Tier Administration Guide*.
- *SAS Logging: Configuration and Programming Reference*

For a complete list of SAS publications, go to [sas.com/store/books](http://sas.com/store/books). If you have questions about which titles you need, please contact a SAS Representative:

SAS Books  
SAS Campus Drive  
Cary, NC 27513-2414  
Phone: 1-800-727-0025  
Fax: 1-919-677-4444  
Email: sasbook@sas.com  
Web address: [sas.com/store/books](http://sas.com/store/books)
Index

A
access permissions 63
See also roles
creating middle-tier administrator IDs 65
Active MQ 44
administrative tasks 18
administrator IDs, SAS middle tier 65
agents 4
Alert Center 14, 54
alerts
default definitions for 20
defining 55
elements of defining 135
monitoring with Alert Center 14, 54
responding with control actions 48
Analyze pages 14
Apache Tomcat 43
applications 46
authentication 19, 63
authorization 19, 63
Auto-Discovery portlet 22
using 37
automatic discovery of resources 37
rediscovering resources 38
running an auto-discovery scan 38
availability of resources 42
Availability Summary portlet 22

C
Cisco IOS 7
clearing the auto-discovery queue 38
clusters
monitoring with Resources pages 13
compatible groups 45
components of SAS Environment Manager 4
configuration 19
escalation schemes 20, 57
manually configuring a service 39
of resources for data collection 38
plugins 20
control actions 47
in response to an alert 48
scheduling 47
Control Actions portlet 22
customizing a Dashboard 23

d
Dashboard 12, 21
customizing 23
for native roles 61
database, SAS Environment Manager 4
discovering resources automatically
See automatic discovery of resources

e
escalation schemes, configuring 20, 57
events
monitoring with Event Center 16, 49

f
Favorite Resources portlet 22

G
GemFire Distributed System 7
Groovy Console 20
Group Alerts Summary portlet 23
groups
creating 46
monitoring with Resources pages 13
types 45

h
HQ Agent 43
HQ Health 20
HQ Web Services API 20
Hyperic 5, 43

I
interface, SAS Environment Manager 11
Administration page 18
Alert Center 14
Analyze pages 14
Dashboard 12, 21
Event Center 16
Manage page 19
Operations Center 16
Resources pages 13

on Dashboard 21
PostgreSQL 44
    controlling with control actions 47
Problem Resources portlet 23

M
Manage page 19
management server 4
Map control 44
metadata
    viewing in Administration page 18
Metric Viewer portlet 23
middle-tier administrator IDs 65
mixed groups 46
monitoring
    availability of resources 42
    default definitions for 20
platforms, servers, and services 13
resource events and alerts 14, 49
using portlets on Dashboard 22
using Resources pages 41
using the Map control for servers and services 44

N
native roles
    See roles
Network and Host Dependency Manager 20
Network Device 7
Network Host 7
network platforms 6

O
operating system platforms 6
Operations Center 16

P
permissions
    See access permissions
Pivotal Web Server 43
platforms 6
    monitoring with Resources pages 13
    supported 7
plugins 5
    configuring 20
portlets
    adding to Dashboard 23
    managing with Manage page 19
    native 61
SAS Application Server 6
SAS Application Server Tier platform 6
SAS Environment Manager
    access permissions 63
    components 4
    configuring 19
    interface 11
    overview 3
SAS Environment Manager Agent server 43
SAS Environment Manager database 4
SAS Environment Manager server 43
SAS JMS Broker 44
SAS Logon Manager 63
SAS Metadata Server 6, 18
resources
    automatically discovering 37
    availability 42
    configuring for data collection 38
    controlling with control actions 47
    manually adding to inventory 39
    monitoring alerts 14, 54
    monitoring events 16, 49
    monitoring with Dashboard portlets 22
    monitoring with Operations Center 16
    monitoring with Resources pages 13, 41
    organizing into groups 45
    platforms 6
    rediscovering 38
    running an auto-discovery scan 38
    servers 7
    services 7
Resources pages 13, 38, 41
roles
    creating native roles 64
    Dashboard pages 61
    managing with Manage page 19
    native 61
controlling with control actions 47
SAS Object Spawner
controlling with control actions 47
SAS OLAP Server 6
controlling with control actions 47
SAS Stored Process Server 6
SAS Web Application Server 44
controlling with control actions 47
SAS Web Infrastructure Platform Data Server 44
controlling with control actions 47
SAS Web Server 43
SAS Workspace Server 6
Saved Charts portlet 22
scanning for resources 38
scheduling control actions 47
Search Resources portlet 23
servers 7
Active MQ 44
Apache Tomcat 43
controlling with control actions 47
determining server names 43
HQ Agent 43
management server 4
managing settings with Manage page 20
manually adding to inventory 39
monitoring with Map control 44
monitoring with Resources pages 13
Pivotal Web Server 43
PostgreSQL 44, 47
SAS Application Server 6
SAS Environment Manager 43
SAS Environment Manager Agent 43
SAS JMS Broker 44
SAS Metadata Server 6, 18, 47
SAS OLAP Server 6, 47
SAS Stored Process Server 6
SAS Web Application Server 44, 47
SAS Web Infrastructure Platform Data Server 44, 47
SAS Web Server 43
SAS Workspace Server 6
SpringSource tc Runtime 44, 47
services 7
controlling with control actions 47
manually adding to inventory 39
monitoring with Map control 44
monitoring with Resources pages 13
SpringSource tc Runtime 44
controlling with control actions 47
Summary Counts portlet 23
supported platforms 7

t
tc Server Command-line Interface 20

U
users
access permissions 63
creating middle-tier administrator IDs 65
managing with Manage page 19

V
virtual platforms 6
VMware Hyperic 5
VMWare Hyperic 43
VMware vSphere Host 7
VMware vSphere VM 7
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.